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Safety Instructions!

Before beginning installation work

Disconnect the device from the power supply

Ensure against accidental restart

Verify isolation from the supply

Earth and short-circuit the supply

Cover or close off neighbouring units that are live.

The assembly instructions provided for the device are to be complied with.

Only suitably qualified personnel according to EN 50 110-1/-2 (VDE 0105 part 100) are
authorised to carry out work on this device/system.

When conducting installation work ensure that you are free of electrostatic charge before
touching the device.

The functional earth (FE) must be connected to the protective earth (PE) or the
equipotential bonding. The system installer is responsible for establishing this connection.

Connection and signal cables are to be installed so that any inductive or capacitive
interference does not impair the automation functions.

The installation of automation devices and their operating elements is to be carried out in
such a way as to prevent unintentional operation.

In order to prevent cable or wire breakage on the signal side generating undefined states
in the automation devices, appropriate safety measures are to be taken for the I/O
coupling on the hardware and software side.

Ensure a reliable isolation of the extra-low voltage for the 24 volt supply. Only those power
supply units that comply with IEC 60 364-4-41, i.e. HD 384.4.41 S2 (VDE 0100 part 410)
are to be deployed.

Fluctuations or deviations of the mains voltage from the nominal value should not exceed
the tolerance limits specified in the technical data, otherwise malfunctions and dangerous
states may occur.

Emergency stop devices complying with IEC/EN 60 204-1 must remain effective in all
operating modes of the automation installation. Releasing the emergency stop devices
must not cause a restart.

Devices for mounting in housings or cabinets, desktop or portable units, are only to be
operated and controlled with the housing closed.

Measures are to be taken to ensure the correct restarting of a program following
interruption due to a voltage drop or failure. Dangerous operating conditions, even short
term, should not occur as a result. If required an emergency stop should be carried out.

External measures are to be implemented at those locations where faults in the automation
installation could lead to injury to persons or damage to property. These measures must
guarantee safe operating conditions even in the event of a fault or malfunction (e.g. by
means of independent limit switches or mechanical locking devices etc.).

The electrical installation must be carried out in accordance with the relevant regulations
(e.g. in respect of the cable cross sections, uses and protective earth connections).

All work involving transport, installation, commissioning and maintenance is to be carried
out exclusively by qualified personnel. (in accordance with IEC 60 364 i.e. HD 384 or
DIN VDE 0100 and national accident prevention regulations).

All covers and doors must be kept closed during operation..
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About this manual

Concept of documentation

In the first chapter of this manual you are provided with an overview of the TURCK BL ident ®
system.

In the second chapter "mounting and installation" the correct connections of the BL ident ®-
system with suitable connection cables is explained.

The third chapter contains instructions for commissioning of a BL ident ® systems. The
standard function block "Proxy Ident Function Block" is used for the start-up of systems with
BLxx-2RFID-A modules. Systems with BLxx-2RFID-S modules have 12 bytes process data
with 8 bytes user data for read/write commands. The basic commands are part of the process
data. The commissioning example is realized using a programmable Ethernet gateway. The
61131-3 compliant programming system CoDeSys is used.

In the fourth chapter the setup of a control interface to a Modbus TCP-, PROFIBUS-DP- and
a EtherNet/IP master is explained.

The fifth chapter contains an excerpt from the specification "Proxy Ident Function Block".

Explanations of used symbols

0-2

Warning

This symbol appears next to an alert which points to a source of danger. This may
refer to injury of persons and damage to systems (hard- and software).
For the user this symbol means: Please, proceed with extreme causion.

This symbol appears next to an alert which points to a potential source of danger.
This may refer to possible injury of persons and damage to systems (hard- and
software) and installations.

. Attention

Note

This symbol appears next to general instructions which point out important
information concerning the procedure for one or more operational steps.

The relevant instructions may faciliate the work and may help prevent redundancy
caused by incorrect operational steps, for example.

g
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General information

Attention
Please, consider it mandatory to read this chapter because safe handling of
electrical devices should not be left to chance.

This manual contains the required information for the start-up of the TURCK BL ident ®-
system.

The concept was specifically created for qualified staff with the necessary technical know-
how.

Intended use

Warning

The devices described in this manual must be used only in the intended applications
found in this manual and the respective technical description, and only together with
certifed external devices and -components.

The correct and safe operation of the devices is based on the prerequisite of proper
transport, storage, assembly and mounting, as well as carefuly operation and maintenance.

Instructions for project planning / installation of product

Warning
It is imperative that the instructions be followed for the safety and accident
prevention for the respective application.

D101640 0109 - BL ident® CoDeSys 0-3
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The TURCK BL ident®system

Schematic diagram of the identification system BL ident®

The TURCK BL ident ®-system has multiple levels. Each level offers opportunities for
variation. An application that is adjusted to the complete system is possible.

Figure 1: ' I [ | ) [
System ' D‘ SPS/PC for startup
overview 8 . J y -

Interface module for integration
in fieldbus systems

Read/write device

- ..
= Alir interface

. Mobile data carrier

Support for BL ident ®projects

The following software and documents will provide additional support for project planning,
installation and startup:

For simulation and optimization of an application, please access the internet and go to
http://www.turck.com...for a free "BL ident ®-simulator".

D101583 - "Installation of the BL ident ®-system“ - This manual contains the technical
details of the available TURCK-data carriers and the TURCK read/write devices.

D101581 - "Interface module for fieldbus connection". This manual describes the
professional connection of the BL ident ®-interface modules.

D101607 - This manual contains a software description of a so-called "handheld"
(programming device) which allows Read and Write access of data independent of
location.

D101585 - This manual contains a hardware description of a so-called "handheld"
(programming device) which allows Read and Write access of data independent of
location.

D301033 - "User Manual for BL67-PG-EN“ - This manual provides detailed information
about the gateway BL67-PG-EN

D101642 - "Set-up with DeviceNet™*
D101644 - "Set-up with EtherNet/IP™
D101648 - "Set-up in PROFINET with the Proxy Ident Function Block”
D101579 - "Set-up in PROFIBUS-DP*
The list of manuals may be downloaded from the internet.

1-2 D101640 0109 - BL ident® CoDeSys
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Networking with BL ident ®systems

Based on the possibility to integrate BL ident ®-systems in (existing) bus-systems, the
opportunity exists to network together multiple BL ident ®-systems.

Valid are the guidelines for the maximum extension of the respective, active bus system.

Identification systems with radio frequency technology (RFID)

RFID is an abbreviation for radio frequency identification.

A RFID-system consists of a data carrier, a device for Read and Write access to the data
carrier, as well as other devices used for data transfer and processing.

The transfer of data from the data carrier to the read/write head occurs contact-free with the
help of electromagnetic waves. The type of transmission is insensitive to dirt and temperature
fluctuations.

The data carriers may be directly affixed to a product. This is why the term "mobile data
memory" is used as well. Other terms for the data carrier are TAG or transponder. The data
content may consist of production and manufacturing data. The data that identifies the
product is important here. This is where the description "identification system" comes from.

Further reaching possibilities are a result of the fact that the data content can be changed by
writing to the data carrier. Because of this production-/manufacturing processes can be
retraced. Logistics/distribution may be optimized.

The "identification systems" may be integrated into (existing) fieldbus automation systems
(for example Modbus TCP). The connection to the respective fieldbus system is done with
suitable interface modules.

Standardized software modules (e.g. the Proxy Ident Function Block for PROFIBUS) enable
simple system integration and commissioning.

D101640 0109 - BL ident® CoDeSys 1-3



The TURCK BL ident®system

Performance characteristics and applications of the BL ident®-system

1-4

To meet the requirements of a variety of applications, the TURCK BL ident ®-system offers
multiple possibilities for combining data carriers and read/write heads, as well as interface
modules to connect automation systems (for example Modbus TCP, EtherNet/IP™). Software
modules enable simple integration and commissioning.

Performance characteristics of the TURCK BL ident ®-system are as follows:

Protection class

Some data carriers, as well as the applicable read/write heads have a high mechanical
protection class (for example,IP67) and therefore may be used in the toughest industrial
applications.

The read/write heads are also available in IP69K (wash-down design).

Connection to the fieldbus-system is realized with suitable TURCK interface modules. The
interface-modules for CANopen are available in the protection class IP20. TURCK connection
cables with the suitable protection class complement the identification system.

Temperature-resistant data carriers up to 210°C are available for the high temperature range.

Life cycle
The life cycle is a result of the possible read/write operations to the data carrier.

FRAM data carriers can provide for an unlimited number of Read operations and 10'° Write
operations.

EEPROM data carriers can provide for an unlimited number of Read operations and 10* or
10° Writer operations.

The data carriers do not require batteries.

Transfer frequency

The TURCK BL ident ®-system operates with a transfer frequency of 13.56 MHz in the HF-
band or with a country-specific transfer frequency in the UHF-range (860-960 MHz) between
the data carriers and the read/write heads.

HF: Systems that operate with this transfer frequency are to a large extent insensitive to
electromagnetic interferences. Therefore the 13.56 MHz transfer frequency has developed
into the standard in many RFID applications.

UHF: Systems in this frequency band gain higher read/write ranges compared to HF, typically
several meters. The carrier frequencies are country-specific, and in Europe, for example, they
are between 865 and 868 MHz.

D101640 0109 - BL ident® CoDeSys
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Models
Data carriers

HF: For the HF-operating frequency, TURCK supplies round, flat data carriers, for example,
with 16, 20, 30 and 50 mm diameters.

The high temperature data carriers have a cylindric design (for example, 22 x 125 mm).
Inlays and adhesive labels have a foil thickness (size, for example, 43 x 43 mm).

Special designs are suitable for installation in and mounting on metal. Other designs are data
carriers in a glass cylinder housing or as a flat bank card format. Some data carriers have
holes so that they may be affixed with screws.

UHF: Data carriers for UHF have different designs and mounting possibilities and are
optimized for either small housing dimensions or large data transfer ranges. Data carriers with
high protection class, also for the application in the field, are available, as well as data carriers
for direct mounting on metal or imprinted tags.

TURCK supplies customer-specific data carrier solutions upon request.
Read/write heads

HF: Read/write heads are available in different designs, from the standard unified threads
M18 and M30 to cuboid designs Q14, CK40, Q80, S32XL including Q80L400 and Q350 for
long distances of up to 500 mm.

UHF: Different cuboid designs are available, for example as compact read/write head in a
housing with approx. 100 mm x 80 mm x 35 mm edge length (L x W x D) or in dimensions
approx. 240 mm x 240 mm x 40 mm for high data transfer ranges of several meters. The read/
write heads have protection class IP67 and are suitable for the application in the field. The
quality of the air-data transfer between data carrier and read/write head is continuously
checked, also when in operation. Each disturbance of the air interface is immediately
diagnosed and signalled per LED-chain.

Memory slot

The memory capacity of the data carrier for the HF-range is 64 or 128 bytes (48 or 112 bytes
user data) with an EEPROM-memory and 2 or 8 kbytes (2000 or 8000 bytes user data) with a
FRAM-memory. For the UHF-range there is an EEPROM-data carrier with 110 bytes (94 bytes
user data).

FRAM: (Ferroelectric Random Access Memory), non-volatile, longer life cycle because of a
greater number of read/write operations and faster Write operations compared to EEPROM.

EEPROM: (Electrically eraseable programmable read only memory), non-volatile.

The data carrier for the HF-operating frequency meet the communication standard
ISO 15693.

The data carriers in the UHF-frequency band meet the communication standard
ISO 18000-6C and EPCglobal Class 1 Gen 2.

D101640 0109 - BL ident® CoDeSys 1-5
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Relative speed of data carrier to read/write head

i

Note

The speed with which the data carrier can pass by the read/write head is influenced
by the data volume to be processed and varies according to the respective
combination of read/write head and data carrier that is being used.

This is why numerical data for max. speed and data volumes can only be seen as
examples!

The speed with which the data carrier can pass by the read/write head may be increased, for
example, with the data carrier TW-R50-K2 and the read/write head

TN-CK40-H1147 to up to 2.5 m/s for 8 bytes at a distance of 36 mm. With the help of the
"BL ident ®-simulator" (see below) the application parameters "speed", "data volume" and
"range" can be changed. The optimum combination read/write head and data carrier for the
respective application is apparent in the simulator.

The simulator is online at http://www.turck.com.. In any case, please follow the instructions
including limits in this chapter.

i

jod. @

Note

Next to the data processing time in the read/write head, the processing time within
the complete installation of the identification system must also be taken under
consideration.(,,System overview” page 1-2). Depending on the application, the time
for data transfer and processing within the complete installation may vary!

If your application requires a fast sequence of data carriers, it may be necessary to
decrease the speed with which the data carrier passes by the read/write head.
When in doubt, we recommend to empirically determine the possible speed!

Note

The transfer curves (max. read/write distance, length of transfer zone) only
represent typical values and test lab conditions.

Because of component tolerances, installation situation of the application, ambient
conditions and interferences caused by materials (especially metals) the distances
that can be reached may differ up to 30 %.

This is why it is absolutely necessary to test the application (especially during Read
and Write when movement occurs) under real conditions!

In addition, the recommended distance from data carrier to read/write head should
be complied with if possible in order to gain errorless read/write operations despite
of possible discrepancies.

Depending on the actual transfer curve of the respective application, the parameters
of reachable pass over speeds (Read and Write on the Fly) and the max. transferable
data volume also change.
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Read range / Write range

The reachable read/write distances depend on the respective combination of data carrier and
read/write head. The possible read/write distance is influenced by the data volume to be
written and to be read, and by the speed with which the data carrier passes by the read/write
head. The read/write heads that use UHF-operating frequencies will reach a distance of
several meters. Read/write heads that operate with 13.56 MHz (HF) transfer frequencies will
reach shorter distances. Here the longest distance (approx. 500 mm) will be reached with the
model TNLR-Q350-H1147 if a round data carrier with a 50 mm diameter is used.

With the help of the software "BL ident ®-simulator” the application parameters "speed",
"range" and "data volume" may be changed. Therefore an optimum combination read/write
head and data carrier may be selected for the appropriate application.

You may find the simulator online at http://www.turck.com..

Figure 2: B
BL ident ®- h t Know what s coming! Industrial
. ustna
simulator ﬁ@ﬂﬂ@ Modular RFID System e Automation
° - & [IMe 10’ 257 Bytes 28 BEmeEe 128,68 mm

Tag:
1542329 TW-R50-HT-

RW-Head:
TN-S32XL-H1147

Features “

Type: TH-S32)L
Mavsiting condit
wrilfraad distar
TO3000E

Accept
selection

data quantity (byte) —

@ Read mode I Write mode =} 128
speed (m/s) E 100
distance (mm) 3 g

Compatibility

All technical data refer to the BL ident ®-system, this means to the combination of BL ident ®-
data carriers, read/write heads and interface modules. Entirely different values may be valid

for data carriers of other manufacturers. This is why external products may only be used after
they have been released by TURCK.
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The TURCK BL ident®system

Applications (examples):

The performance characteristics described in the prior chapter support the application of a
TURCK BL ident ®-system in the following industries:

Automobile

Transport and handling

Machine building

Food and beverages

Chemical industry

Pharmaceutical and petrochemical industries
The application in all areas is possible here, like:

Assembly lines

Materials handling

Industrial manufacturing

Inventory and storage

Logistics

Distribution

Consignment

Transport logistics
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Interfaces with Protection Class IP20

Diagrams and designs of the interface modules
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The BL ident ®-Ethernet-interface is available with 2, 4, 6, 8 ports. The gateways are
programmable (PG) and may be used in Modbus TCP (EN) or EtherNet/IP (EIP) depending on

the design version.

Interface-modules with the add-on "-S" (Simple) stand for a user-friendly startup opportunity.
With a Write or Read command 8 bytes may be transferred. Interface modules without the
add-on "S" offer a higher number of possible commands and a large data transfer volume per

command.

Figure 3:

BL ident®-
Interface
module with
Protection Class
IP20 (2- and 8-
port version)

ED

28,9

ok

Table 1:

BL ident ®-
Interface
module with
Protection
Class IP20

Product description Ident-No.
TI-BL20-PG-EN-2 1545053
TI-BL20-PG-EN-4 1545054
TI-BL20-PG-EN-6 1545055
TI-BL20-PG-EN-8 1545056
TI-BL20-PG-EN-S-2 1545086
TI-BL20-PG-EN-S-4 1545087
TI-BL20-PG-EN-S-6 1545088
TI-BL20-PG-EN-S-8 1545089
TI-BL20-PG-EIP-2 1545020
TI-BL20-PG-EIP-4 1545021
TI-BL20-PG-EIP-6 1545022

D101640 0109 - BL ident® CoDeSys
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Table 1: Product description Ident-No.
BL ident ®-
Interface
module with
Protection
Class IP20
TI-BL20-PG-EIP-8 1545023
TI-BL20-PG-EIP-S-2 1545090
TI-BL20-PG-EIP-S-4 1545091
TI-BL20-PG-EIP-S-6 1545092
TI-BL20-PG-EIP-S-8 1545093
The integration of BL ident® in Modbus TCP and EtherNet/IP makes programmable Ethernet-
gateways possible:
Modbus TCP
EtherNet/IP
Figure 4:
Modbus TCP | La il )
=
EtherNet/IP A C/P 4 =
N\

2-4

A 'Service-interface" page 2-8
B "SET-scanner" page 2-8

C Rotary switch - "Addressing" page 2-6

D CPU/Module Bus LEDs ("LEDs of the fieldbus side" page 2-13)
E RUN/STOP LED ("LEDs of the fieldbus side" page 2-13)

F Ethernet LEDs ("LEDs of the fieldbus side" page 2-13)

G Ethernet ("Ethernet-connection" page 2-5)

H Power supply ("Power supply voltage" page 2-5)
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Power supply voltage

The BL20-station is supplied via the two connection terminals Ugy,gand U, (system supply and
field supply). A voltage within the range of 18 to 30 VDC (nominal value 24 VDC) is connected
to each of the 2-pole screw terminals.

The system supply voltage is transformed 5 VDC (from 24 VDC) and may supply max. 0.5 A.
This voltage is internally led over a wire pair of the 7-wire module bus and serves to supply
the module electronics on the module bus side.

The field supply voltage is 24 VDC and may supply max. 10 A. This voltage is led through
the BL20-station via a conductor line. The module electronics on the fieldbus side and the
connected read/write devices are fed by the field supply voltage ("Read/write head
connections" page 2-10).

Table 2: Signal Description
Pin assignment
of the screw Ugys + System supply (gateway, module bus)
terminal strips.
sys ~
U+ Field supply (max. 10 A)
UL_
Ethernet-connection

The BL20-gateway is connected to Ethernet via a female RJ45-connector.

Figure 5:

Female RJ45-
connector W

87654321

ONOOAWN =
L1 L 1 I 1 | I T e
>>p223dd
00 X0 o XXX

| + |+

Attention
No equalizing current must flow across the shield. For this purpose a safe system
must be created for potential equalization!
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Addressing
The three decimal rotary switches are used for Ethernet-addressing of the programmable
gateways.
Figure 6: Adr. x 100
Decimal rotary o
switches for 8 N s
setting the 7
Ethernet- 6 5 4
address O set
9 01 9 04
2 8 2
7 3 7 3
6 5 4 6 5 4
Adr. x 10 Adr. x 1
000  :192.168.1.254
1-254 : Static rotary
300 : BootP
400  :DHCP
500 :PGM
600  :PGM-DHCP
™ Note
1 A voltage reset must be completed when the addressing mode is changed!
Table 3: Switch Addressing mode
Switch setting
settings for
different
modes for
assigning
addresses
000 The gateway has the default IP-address:
192.168.1.254 and the default subnet mask 255.255.255.0
The newly set digit sequence "000" is accepted after a voltage reset!
1 to 254 Rotary mode
This mode allows the manual setting of the last three digits of the 12-digit IP-
address. Acceptance of the newly set 3-digit sequence occurs after a voltage
reset!
The last three digits of an IP-address stored in the EEPROM are ignored in
this mode, but the first 9 digits and the subnet mask are relevant!
The IP-address stored in the EEPROM and the subnet mask can be changed
with the modes 300, 400, 500, and 600.
The 3-digit setting done here is not stored in the EEPROM of the gateway.
300 BootP_Mode
The IP-address of the gateway and the subnet mask ("Network mask" page
6-2) are assigned with the help of a BootP-server. Both network settings are
permanently stored in the EEPROM of the gateway.
2-6 D101640 0109 - BL ident® CoDeSys
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Table 3: Switch Addressing mode
(cont.) setting

Switch

settings for

different

modes for

assigning

400 DHCP_Mode
The IP-address of the gateway and the subnet mask ("Network mask" page
6-2) are assigned with the help of a DHCP-server. Both network settings are
permanently stored in the EEPROM of the gateway.

500 PGM_Mode
The PGM-mode allows access of the I/O-ASSISTANT to the network settings
of the gateway. The IP-address of the gateway and the subnet mask
("Network mask" page 6-2) are permanently stored in the EEPROM of the
gateway.

600 PGM_DHCP_Mode
like DHCP_Mode

Attention
The protection cover on top of the rotary switch should be firmly locked after
addressing. It serves to protect from dirt!
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SET-scanner

You will only require the functions of the SET-scanner if you change the interface module
configuration after the first switch-on. A modification may occur when modules are added or
when one or more modules are pulled.

When the BL ident ®-interface module is connected for the first time, the current configuration
is automatically read. The continuously illuminated green LED "lIOs" page 2-14 signals in
sequence that the process was successfully executed.

Press the SET-button for approx. 10 seconds if you changed the interface module
configuration. The current station configuration is stored as Actual-configuration and is
transferred to both the Temp-Should-be configuration buffer and the Should-be configuration
buffer.

During the operation, the "GW"-LED remains blinking.

Service-interface

The service-interface connects the Ethernet gateway to a PC. Projecting is possible with the
software
I/0-ASSISTANT, and diagnostic messages can be displayed.

A special standard cable must be used for the service-interface/PC connection.
BL20-connection cable (/0O-ASSISTANT-ADAPTERCABLE-BL20/BL67)
Connection with the BL20-cable

The BL20-cable has a PS/2-connector (connection of female connector to gateway) and a
SUB-D female connector (connection of connector to PC).

Figure 7:
PS/2-connector
on the
connection
cable to the
gateway (top
view)

43

Figure 8:
9-pole SUB-D
female
connector on
the connection
cable to the PC
(top view)

2-8

54 3 2 1

9 8 7 6
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Table 4: Pin BL20-gateway female PS/2 Sub-D-interface on PC Pin
Pin connector
assignment
PS/2- and 1 CLK DTR, DSR 4,6
SUB-D-
3 DATA - -
4 n.c. (DATA2) RxD 2
5 +5V RTS 7
6 n.c. (CLK2) TxD 3
Figure 9:
Connection
between PC
and BL20-

gateway via the
BL20-
connection
cable

A Female SUB-
D-connector

B BL20-

connection

cable

C PS/2-

connector

Firmware-update

A firmware-download may be done on the gateway via the "Service-interface" page 2-8 or via
the "Ethernet-connection" page 2-5 with the help of the software I/O-ASSISTANT (please
refer to Online Help for more information).

Please go to the TURCK web site at www.turck.com to locate the current firmware for your
gateway and an instruction for executing the actualization.

Attention

During the download, the station should be disconnected from the fieldbus. The
firmware download may only be performed by authorized staff. The field side must
be switched free!
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Read/write head connections

Ready-made connection cables

The read/write heads are connected to the BL20-2RFID-A/S-modules via connection cables
on the connection terminals of the base modules (BL20-S4x-SBBS).

The following table displays ready-made connection cables with a coupling to connect the
read/write head and an open end to connect to the spring-type terminals of the interface
module. The connection to the spring-type terminals of the interface module is explained in
the paragraphs "Connection terminal when using the connection cables RK4.5T... and
WK4.5T..." page 2-11 and "Connection terminals when using the connection cables
FB4.5T..." page 2-12.

Table 5:
Ready-made
connection
cables (BL20)

2-10

Type description Coupling? 2m 5m 10m 25m 50m
(Ident number) straight = s
angled = a
RK4.5T-2/S2500 g X
(8035244)
RK4.5T-5/S2500 g X
(6699206)
RK4.5T-10/S2500 g X
(6699207)
RK4.5T-25/S2500 g X
(6699421)
RK4.5T-50/S2500 g X
(6699422)
WK4.5T-2/S2500 a X
(8035245)
WK4.5T-5/S2500 a X
(6699208)
WK4.5T-10/S2500 a X
(6699209)
WK4.5T-25/S2500 a X
(6699423)
WK4.5T-50/S2500 a X
(6699424)
For the food and beverage range (FB = Food and Beverage) - IP69K
FB-RK4.5T-5/S2502 g X
(8036404)
FB-RK4.5T-10/S2502 g X
(8036405)
FB-RK4.5T-25/S2502 X

(8037011)

A The "coupling" serves to connect the read/write head
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Characteristics of the connection cables of type RK... and WK...
Shielded
PUR outer jacket, PVC-, silicone- and halogen-free
Highly flexible
Crosslinked by irradiation, resistant to weld flash, oils
High mechanical durability
Approval

Characteristics of connection cables of type FB....
Shielded
PVC outer jacket
Approval @, &

Connection cables for installing a coupling

Self-assembly of "CABLE-BLIDENT-100M" suitable for BL ident ® is possible. For this please
install the M12-coupling "B8151-0/9" (6904604) to connect the read/write head.

Note

®
1 When installing the coupling, please pay attention to "Color Assignment RK4.5T...
and WK4.5T..." from "Pin assignment for the connection cables" page 2-39!

Note

Please connect the open end of the connection cable per the "Connection terminal
when using the connection cables RK4.5T... and WK4.5T..." page 2-11!

k. 0

Connection terminal when using the connection cables RK4.5T... and WK4.5T...

Figure 10:
Connection of
read/write head
(transceiver) for
connection
cablesRK4.5T...
and WK4.5T...
to BL20-S4x-
SBBS

D101640 0109

Data- 0 (BK)
| Data+ 0 (WH) :
[ N
Transceiver :
P L
[GND (BU) . GND (3 BU)
+24VDC (BN) ! | i {+24VDC (1 BN)
Lo ]
i A3n23 | i
L P
B Transceiver|
48 HE
. | Data- 1 (2 BK)|
i ; Data+ 1 (4 WH)
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Table 6: Signal Color assignment
Color
assignmentof Vi head Brown (BN)
connection
cables GND Blue (BU)
RK4.5T... and .
WK4.5T... Data+ White (WH)
Data- Black (BK)

Connection terminals when using the connection cables FB4.5T...

Figure 11:

. Data- 0 (BU) ..
Connection of )
the read/write | lData+ 0 (WH) -
head P
(transceiver) for Transceiver P
connection P =
cables FB4.5T... e T
to BL20-S4x- |GND (BK) . GND (3 BK)
+24 VDC (RD)' | | i 424VDC (1 RD)
I ]
P
L P
) Transceiver|
A8 Vo
. | Data- 1 (2 BU)
i | Data+ 1 (4 WH)
Table 7: Signal Color mapping
Color
mapping of Virw head Red (RD)
connection
cables GND Black (BK)
FB4.ST... Data+ White (WH)
Data- Blue (BU)
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Table 8: LED Status Meaning Remedy
LED-displays
GW OFF CPU is not supplied by — Please check the supply
voltage. voltage of the system
connected to the gateway.
green Firmware active, gateway =

ready for operation and
sending.

green blinking,
1Hz

Firmware inactive.

— When LED "l0s" is red,

firmware download is needed.

green blinking,
4 Hz

Firmware active, hardware
of gateway defective.

— Replace the gateway.

red

D101640 0109 - BL ident® CoDeSys

CPU not ready for

operation, V too low—

possible causes:

—too many modules on
gateway

—short circuit in connected
module

— gateway defective

— Please check the voltage
supply of the system

connected to the gateway and

the wiring.
— Pull surplus modules.

— Replace the gateway if need

be.
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Table 8: LED Status Meaning Remedy
(cont.)
LED-displays
10s OFF CPU is not supplied by — Please check the supply
voltage. voltage of the system

connected to the gateway.

green Configured constellation of -
the module bus
participants corresponds
to the real one;
communication is active.

green blinking,  Station is in the Force- - Please deactivate the Force-
1Hz mode of the I/O- mode of the I/O-ASSISTANT.
ASSISTANT.
green blinking,  The allowed max. humber — Please check the number of
4 Hz of modules connected to modules connected to the
the gateway has been gateway and pull surplus
exceeded. modules if needed.
red CPU not ready for — Please check the voltage
operation. Either V. is too supply of the system
low or Bootload is needed. connected to the gateway and
- the wiring.
possible causes: — Pull surplus modules.
—too many modules on — Replace the gateway if need
gateway be.
—short circuit in connected
module

— gateway defective

red blinking, Inadaptable modificationof =~ — Please compare the projection
1Hz the real constellation of the of your BL20-station to the real
module bus participants. constellation.

— Please check the configuration
of your BL20-station for
defective or wrongly plugged
electronic modules.

red blinking, No communication via the — At least 1 electronic module

4 Hz module bus. must be plugged in and able to
communicate with the
gateway.

red/green The current and the — Please check the BL67-station

blinking, projected module lists do for pulled or new modules that

1 Hz not match, but the data are not projected.

exchange continues.
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Table 8: LED Status Meaning Remedy
(cont.)
LED-displays
RUN/ OFF No program loaded into the
STP gateway.
green Application loaded into
gateway, program is
running.
green blinking Application loaded into — Please start the gateway/the
gateway, but PLC has not PLC-program.
started or rather has
stopped.
red PLC-test at start-up of the
gateway
LINK/ green Link established,
ACT 100 Mbit/s
green blinking Ethernet traffic 100 Mbit/s
orange Link established, 10 Mbit/s
orange blinking Ethernet traffic 10 Mbit/s
OFF No Ethernet link — Please check the Ethernet

connection

MS green Display of the logical
connection to the Master
(1. Modbus TCP-
connection)

green blinking  Gateway signals
operational readiness.

red Gateway signals errors.
red blinking DHCP/BootP-search of
setting
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LEDs for the RFID-connections

Table 9:
RFID-
connections

2-16

LED Status Meaning Remedy
DIA OFF Normal data exchange
red Module bus Please check whether more than
communication failure two adjacent electronic modules
were pulled.
Relevant are those modules which
are positioned between the
gateway and this particular module.
red blinking Diagnostic present
0.5 Hz
RWO OFF No Tag in received
RW 1 range
green Tag in received range

green blinking
2 Hz

Data transfer from / to
Tag

red Error in read/write head
red blinking Short circuit
2 Hz supply read/write head
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Diagnostic messages and parameterization of the gateway

A full description of the gateway diagnostic messages and the parameterization possibilities
can be found in the manuals:

"User Manual for BL20-PG-EN" D301048

"User Manual for BL20-PG-EN-IP" D301051

Parameterization of the BL20-2RFID-A/BL20-2RFID-S-modules
BL20-2RFID-A

At this time, parameterization is not possible.

BL20-2RFID-S

The only parameter "Bridging Time Kx[n*4ms]" must only be changed/adjusted when a
certain error message appears at startup. Please refer to Paragraph "Parameter" page 3-50
for more details.

Diagnostic messages of the BL ident ®ports
Possible software diagnostic messages (I/O-ASSISTANT):

Table 10:
Diagnostics of
the

BL ident ®-
modules

Diagnostic byte and Description I/0-ASSISTANT
bit

Diagnostic Port 1

0 0 reserved
1 reserved
2 "ldent Overcurrent" (the supply of the read/write head
(transceiver) is switched off).
3to7 reserved
1 0 “Transceiver hardware error"
1to2 reserved
3 "Transceiver voltage supply error"
4to7 reserved

Diagnostic Port 2

2 0 reserved
1 reserved
2 "ldent Overcurrent" (the supply of the read/write head

(transceiver) is switched off).

3to7 reserved

D101640 0109 - BL ident® CoDeSys 2-17



Mounting and installation

Table 10: Diagnostic byte and Description I/0-ASSISTANT
(cont.) bit
Diagnostics of
the
BL ident ®-
modules
3 0 "Transceiver hardware error"
1to 2 reserved
3 "Transceiver voltage supply error"
4t07 reserved
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Warning

This device may cause radio interference in living quarters and in small industry
(living-, business- and commercial areas, small business). In this case the user may
be asked to implement respective measures at his own expense.

Attention
The auxiliary supply must meet the requirements of the safety low voltage (SELV =
Safety extra low voltage) per IEC 364-4-41.

Approvals and tests of the interface module

Table 11: Description Value
Approvalsand
tests per
EN 61131-2
Approval
ce
@

cUs

Uy

Ambient temperature

Operating temperature

0to +55 °C /32 to 131 °F

Storage temperature

-25 to +85 °C /-13 to 85.00 °F

relative humidity

5 to 95 % (internal), Level RH-2,
no condensation (at 45 °C storage)

Vibration test

Per EN 61131

Shock test

Per IEC 68-2-27

Falling and tumbling

Per IEC 68-2-31 and free fall per
IEC 68-2-32

Electromagnetic compatibility

Per EN 61131-2

Protection Class IP 20
Reliability

Life cycle MTBF 120000 h

Pull-/Plug Cycle of Electronic 20

modules

D101640 0109 - BL ident® CoDeSys
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Note

jud. @

Additional technical specifications for the tests for the TURCK products of the BL20
product family can be found in the catalog "Modular I/0O systems and compact I/O

modules in IP20 and IP67" (D301053) and the Manual "BL20 - I/O Modules

Hardware and Engineering" (D300717).

Gateway connection level

Table 12: Description Value
Technical
data
Power supply
Field supply
U, nominal value (range) 24 VDC (18 to 30 VDC)
I, max. field current 10A
System supply
Usys nominal value (range) 24 VDC (18 to 30 VDC)
lsys Max. 500 mA
lyg (Supply of the module bus participants) 1.2 A
Physical interfaces
Fieldbus
Transfer rate 10/100 Mbit/s
Passive LWL-adaptors are connectable Current consumption max. 100 mA
Fieldbus connection technology Female RJ45-connector
Fieldbus shield connection Via Ethernet cable
Address setting 3 decimal rotary switches
Service-interface Female PS/2-connector
Isolation voltage
Ugs 500 V AC
(Ethernet/
Service-interface)
Uy 500 V AC
(Ethernet/ Module Bus)
Ugys 1000 VDC
(U contra U
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Table 12: Description Value
Technical
data
PLC-data

Programming

— Software CoDeSys V 2.3
—for RFID V2.3.6.4
— Programming languages IEC 61131-3

(AWL, KOP, FUP, AS, ST)

— Application tasks

1

— Number POUs (Program Organization

Units)

1024

— Programming interface

RS232-interface, Ethernet

Processor

RISC, 32 Bit

—Cycle time

< 1 ms for 1000 AWL-commands
(No I/O-cycle)

— Real-time clock yes
Memory

— Program memory 512 kByte

— Data memory 512 kByte

—Input data

4 kByte (physical inputs plus network
variables)

— Output data

4 kByte (physical outputs plus network
variables)

— Residual memory

D101640 0109 - BL ident® CoDeSys
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Connection level of read/write head

Table 13:
Technical

data

2-22

Description Value
Number of ports 2
Nominal voltage from supply terminal 24 VDC
Nominal current from field supply <100 mA
Nominal current from module bus <30 mA
Power loss, typical <1 W
Inputs/Outputs
Transfer rate 115.2 kBit/s
Cable length 50 m
Cable impedance 120 Q

Potential isolation

Isolation of electronics and field level via
optocoupler

Utilization factor

1

Supply of sensors

250 mA per port, short circuit protected

Sum current (via both ports)

500 mA

Number of diagnostic byte

BL20-2RFID-A, BL20-2RFID-S)

Number of parameter byte

4(
8 (BL20-2RFID-A, BL20-2RFID-S)

Number of input byte

4 (BL20-2RFID-A)
24 (BL20-2RFID-S)

Number of output byte

4 (BL20-2RFID-A)
24 (BL20-2RFID-S)

Transfer rate

Serial differential transfer to read/write head

Data buffer receive/send

8/8 kByte

Connection technology read/write heads

Spring-type terminals

Protection Class IP 20

Stripped isolation length 8 mm

max. terminal range 0.5to 2.5 mm?
Conductors suitable for clamping

"e" single-wire H 07V-U 0.5to 2.5 mm?
“f" fine-wire H 07V-K 0.5 to 1.5 mm?
"' with wire sleeve per DIN 46228/1 (wire 0.5 to 1.5 mm?

sleeve crimped on gastight)
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Table 13: Description Value
(cont.)
Technical
data
Plug gauge per IEC 947-1/1988 A1l

Measuring data per VDE 0611 Part 1/8.92/IEC 947-7-1/1989

Measuring voltage 250V
Measurement current 175 A
Measurement diameter 1.5 mm?
Measurement surge voltage 4 kV
Degree of pollution 2
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Interfaces with the Protection Class IP67

Diagrams and designs of the interface modules

The BL ident ®-Ethernet-interface is available with 2, 4, 6, 8 ports. The gateways are
programmable (PG) and may be used in Modbus TCP (EN), EtherNet/IP (EIP) or PROFIBUS-

DP (DP) depending on the design.

Interface-modules with the add-on "-S" (Simple) stand for a user-friendly startup opportunity.
With a Write or Read command 8 bytes may be transferred. Interface modules without the
add-on "S" offer a higher number of possible commands and a large data transfer volume per

command.

Figure 12:

BL ident ®-
Interface
module with the
Protection Class
IP67 (2- and 8-
port)

Table 14:
BL ident ®-
Interface
module with
Protection
Class IP67

2-24

Product description Ident-No.
TI-BL67-PG-EN-2 1545065
TI-BL67-PG-EN-4 1545066
TI-BL67-PG-EN-6 1545067
TI-BL67-PG-EN-8 1545068
TI-BL67-PG-EN-S-2 1545098
TI-BL67-PG-EN-S-4 1545099
TI-BL67-PG-EN-S-6 1545100
TI-BL67-PG-EN-S-8 1545101
TI-BL67-PG-EIP-2 1545069
TI-BL67-PG-EIP-4 1545070
TI-BL67-PG-EIP-6 1545071
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Table 14: Product description Ident-No.
(cont.)
BL ident ®-
Interface
module with
Protection
Class IP67
TI-BL67-PG-EIP-8 1545072
TI-BL67-PG-EIP-S-2 1545102
TI-BL67-PG-EIP-S-4 1545103
TI-BL67-PG-EIP-S-6 1545104
TI-BL67-PG-EIP-S-8 1545105
TI-BL67-PG-DP-2 1545061
TI-BL67-PG-DP-4 1545062
TI-BL67-PG-DP-6 1545063
TI-BL67-PG-DP-8 1545064
TI-BL67-PG-DP-S-2 1545094
TI-BL67-PG-DP-S-4 1545095
TI-BL67-PG-DP-S-6 1545096
TI-BL67-PG-DP-S-8 1545097
The integration of BL ident® in Modbus TCP, EtherNet/IP and PROFIBUS-DP make
programmable Ethernet-gateways possible:
Modbus TCP
EtherNet/IP
PROFIBUS-DPV1
D101640 0109 - BL ident® CoDeSys 2-25



Mounting and installation

The following diagram shows the connection level of the programmable gateway:
left: Gateway connection level TI-BL67-PG-EN-X (also TI-BL67-PG-EN-IP-X)
right: Gateway connection level TI-BL67-PG-DP-X

Figure 13:
Gateway
connection level

"Service-interface" page 2-34
"SET-scanner" page 2-35

Rotary switch - "Addressing" page 2-31

Status LED ("Diagnostics via LEDs" page 2-40)

RUN/STOP LED ("Diagnostics via LEDs" page 2-40)

LEDs for supply voltage check ("Diagnostics via LEDs" page 2-40)
left: not assigned, right: PROFIBUS-LED

Ethernet LEDs ("Diagnostics via LEDs" page 2-40)

Module Bus LED ("Diagnostics via LEDs" page 2-40)

left: currently not assigned, right: PROFIBUS "PROFIBUS-connection (only TI-BL67-PG-DP-X)"
page 2-29

"Ethernet-connection" page 2-29

"Power supply voltage" page 2-28

CTIOTMMOUOOW>

Ll
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Simplified switching diagram

The following diagrams show among other things how the voltages V,(Pin 4) and V (Pin 5)
from the programmable Ethernet-gateways are used and then transmitted:

Figure 14: I BL67-
Power supply I Systembus
and simplified N senvice L1 o R :
. . Qo0 interface
sywtchmg PS/2 I
d/agram I |communi-
N 1 cation
Modbus TCP Ethernet I bus
and interface |
12 module bu
for EtherNet/IP Yo o interface )
1
Ethernet |
: V,
1 5 5VDC L
2 4Ty, :
3 24 VDC | Power
| bus
short circuit : v
protection | r/whead
" PE
T GND
.
Figure 15: . F====-
| BL67-
Power supply | system bus
anq’ SIn"7,0/Ierd 650N e I
SWItChlng Coo interface uc memory !

! PS/2 !
d/agram I | communi-
PROFIBUS-DP - : czﬂzn

1
(DPVO) interface I
module bus
interface !
1
1
: V,
1 5 5VDC f °
2 4]y :
3 ! 24 VDC [ power
| bus
short circuit : v,
protection | r/whead
" PE
T GND
1

The read/write heads are fed via the voltage V,;, neaq (V). This connection is overload- and
short circuit protected.

The LED "V," page 2-42 indicates when this voltage is defective.

Note

®

1 Please refer to the appendix of this product catalog "Fieldbus Technology" for order
information for available cable types. The TURCK-catalog "Modular I/O systems
and compact I/O modules in IP20 and IP67" D301053 is located in the download
area of the web page http://www.turck.com.
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Power supply voltage

The BL67-system is supplied via the 7/8"-panel connector marked "Power".

Figure 16:
7/8"-connector

jod @

Note

Please refer to the appendix of the product catalog for order information for
available couplings and cable types. The TURCK-catalog "Modular I/0 systems and
compact I/0 modules in IP20 and IP67" D301058 is located on the website

http://www.turck.com.

Table 15:

Pin
assignment of
the 7/8"-
connector

2-28

Pin- Color 7/8" Description
No.
1 black GND
2 blue GND
3 green/ PE Protective earth
yellow
4 brown V, (Up) Feed in of nominal voltage for inputs (sensor supply
Vi /w head); from it the system is supplied as well.
5 white Vo (U) Feed in of nominal voltage for outputs

(in case of the BL67-2RFID-X module supplies the
microcontroller at the fieldbus side).
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Ethernet-connection

The BL67 Ethernet-gateway is connected to Ethernet via the 4-pole, M12 female panel
connector "Ethernet".

The M12 female connector on the gateway has a 4-pole and D-coded design per IAONA-
specifications.

Note

o

1 Please refer to the appendix of the product catalog for order information for
available bus cables for Ethernet. The TURCK-catalog "Modular I/0 systems and
compact I/O modules in IP20 and IP67" D301053 is located in the download area of
the website: http://www.turck.com.

PROFIBUS-connection (only TI-BL67-PG-DP-X)
The PROFIBUS-DP is connected via a 5-pole M12 x 1 female panel connector, inverse coded.

For integration into a PROFIBUS-DP-system, TURCK offers "Bus-Y-Parts". The two female
connectors of the Y-connector are either used as PROFIBUS-DP-input and PROFIBUS-DP-
output or as PROFIBUS-DP-input and "Bus termination" page 2-30.

Note

®

1 Please refer to the appendix of the product catalog for order information for
connectors and connection cables for PROFIBUS-DP. The TURCK-catalog
"Modular 1/0 systems and compact I/O modules in IP20 and IP67" D301053 is
located on the website: http://www.turck.com

Note

Please note that the specific connector should have 4 inductors (from 100 nHto 110
nH each) in the P- and N-feed lines (as recommended by the PROFIBUS user
organization).

jod @

Figure 17:
PBDP female
connector - "DP
ourt"

2

94¢
1(000)3
)

5 4

Table 16: Pin-No. M12 x 1 Description

Pin

assignmentof 1 5V Supply of external devices

M12 x 1-

female 2 A +)-Data cable; Received-/Send-Data-P; green

connector 3 GND Data reference potential
4 B (-)-Data cable; Received-/Send-Data-N; red
5 Shield Shield connection/function earth
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Attention
No equalizing current must flow across the shield. For this purpose a safe system
must be created for potential equalization!

Bus termination

If the BL67-PG-DP is used as first or last participant in the bus communication (at the end of
a bus segment), the fieldbus must be terminated. The gateway itself offers no opportunity to
terminate the fieldbus. The female connector of the Y-Part for connecting the PROFIBUS-DP-
output must be terminated with a integrated termination resistance (for example RSS4.5-
PDP-TR, Ident-No.: 6601590 as passive terminating resistance or PDP-TRA, Ident-No.:
6825346 as active terminating resistance).

® Note
1 The bus termination is done externally with a connector with integrated terminating
resistance.
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The three decimal rotary switches are used for Ethernet-addressing of the programmable

gateways.

In addition, PROFIBUS-DP-addressing can be done via the three rotary switches. For this the
gateway-parameter "DPSlaveAddrMode" must be set to the value "RotaryMode". In this case
the last three digits of the Ethernet-address and the PROFIBUS-DP-address are the same.

Figure 18:
Decimal rotary
switches for
setting the
Ethernet-
address

9 0 4
8 21y
. 3 00
65 4
9 0 4
8 21 10
7 3
65 4
9 0 14
8 2 X 1
7 3
65 4

Note
Generally the voltage is reset when the "Addressing Mode" is changed.

k. 0

D101640 0109 - BL ident® CoDeSys
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Table 17:
Switch
settings for
different
modes for
assigning
addresses

2-32

Switch
setting

Addressing mode

000

The gateway has the Default-IP address:
192.168.1.254 and the default subnet mask 255.255.255.0
The newly set digit sequence is accepted after the voltage reset!

1to 254

Rotary mode

This mode allows the manual setting of the last three digits of the 12-digit IP-
address. Acceptance of the newly set 3-digit sequence occurs after a voltage
reset!

The last three digits of an IP-address stored in the EEPROM are ignored in
this mode, but the first 9 digits and the subnet mask are relevant!

The IP-address stored in the EEPROM and the subnet mask can be changed
with the modes 300, 400, 500, and 600.

The 3-digit setting done here is not stored in the EEPROM of the gateway.
TI-BL67-PG-DP-X:

The address set here may be jointly used for the Ethernet-communication
and the PROFIBUS-DP-communication.

When jointly used, a value between 1 and 125 must be set and the gateway-
parameter "DPSlaveAddrMode" must be set to the value "RotaryMode".

300

BootP_Mode

The IP-address of the gateway and the subnet mask ("Network mask" page
6-2) are assigned with the help of a BootP-server. Both network settings are
permanently stored in the EEPROM of the gateway.

400

DHCP_Mode

The IP-address of the gateway and the subnet mask ("Network mask" page
6-2) are assigned with the help of a DHCP-server. Both network settings are
permanently stored in the EEPROM of the gateway.

500

PGM_Mode

The PGM-mode allows access of the I/O-ASSISTANT to the network settings
of the gateway. The IP-address of the gateway and the subnet mask
("Network mask" page 6-2) are permanently stored in the EEPROM of the
gateway.

600

jod @

PGM_DHCP_Mode
like DHCP_Mode

Note

You may also set the PROFIBUS-DP-address of the TI-BL67-PG-DP-X in the
program software (for example CoDeSys). For this the parameter
"DPSlaveAddrMode" must be set to the value "NormalMode". In this case the
switch setting of the rotary switches has no effect on the PROFIBUS-DP-address.
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Attention
After addressing, the protective cover must be tightly affixed with screws on top of
the rotary switches.

Please ensure that the seal of the protective cover is not damaged or moved.
Protection Class IP67 can only be guaranteed when the cover is correctly locked.
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Service-interface

The service-interface connects the BL ident ®-interface module to the PC. With the software
I/O-ASSISTANT the interface module can be projected and diagnostic messages can be
displayed.

A special, standard cable is used for the service-interface/PC connection.

TURCK connection cable (I/O-ASSISTANT-ADAPTERCABLE-BL20/BL67; Ident No.:
6827133)

The cable has a PS/2 connector (connection for female connector to gateway) and a SUB-D
female connector (for connector/PC connection).

Figure 19:
PS/2-connector
on connection
cable of the
gateway (top
view)

Figure 20:
9-pole SUB-D
female
connector on
the connection
cable to the PC
(top view)

Figure 21:
Connection
between PC
and BL67-
interface
module via the
TURCK-
connection
cable.

2-34
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Pin assignment
The table shows the pin assignment when using the PS/2-cable:
Table 18: PS/2 9-pole serial interface on
Pin PC
assignment
with PS/2- Pin- Standard BL67 Gateway: PS/2 Pin- Connector
cable No. PS/2-connector female connector No.
1 CLK +5 V (from Gateway) 4,6 DTR, DSR
2 GND GND 5 GND
3 DATA Not used - -
4 n.c. (DATA2) TxD 2 RxD
5 +5V /CtriMode 7 RTS
6 n.c. (CLK2) RxD 3 TxD

Firmware-update

A firmware-download may be done on the gateway via the "Service-interface" page 2-34 or
via the "Ethernet-connection" page 2-29 with the help of the software I/O-ASSISTANT (please
refer to Online Help for more information).

Please go to the TURCK web site at www.turck.com to locate the current firmware for your
gateway and an instruction for executing the actualization.

Attention

During the download, the station should be disconnected from the fieldbus. The
firmware download may only be performed by authorized staff. The field side must
be switched free.

SET-scanner

You will only require the functions of the SET-scanner if you change the interface module
configuration after the first switch-on. A modification may occur when modules are added or
when one or more modules are pulled.

When the BL ident ®-interface module is connected for the first time, the current configuration
is automatically read. The continuously illuminated green LED "lIO" page 2-40 signals in
sequence that the process was successfully executed.

Press the SET-button for approx. 10 seconds if you changed the interface module
configuration. The current station configuration is stored as Actual-configuration and is
transferred to both the Temp-Should-be configuration buffer and the Should-be configuration
buffer.

During the operation, the "GW"-LED remains blinking.
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Read/write head connections

Ready-made connection cables with coupling and connector

Table 19:
Ready-made
connection
cables (BL67)

2-36

Type description Coupling® Connector® 2m 5m 10m
(Ident number) straight = s straight=s
angled = a
RK4.5T-2-RS4.5T/S2500 g g x
(6699200)
RK4.5T-5-RS4.5T/S2500 g g X
(6699201)
RK4.5T-10-RS4.5T/S2500 o] o] X
(6699202)
WK4.5T-2-RS4.5T/S2500 a g X
(6699203)
WK4.5T-5-RS4.5T/S2500 a (o] X
(6699204)
WK4.5T-10-RS4.5T/ a o] X
S2500
(6699205)
Type description Coupling® Connector® 0.3m 25m 50m
(Ident_Number) straight = s straight = s
angled = a
RK4.5T-0.3-RS4.5T/ g g x
S2500
(6699210)
RK4.5T-25-RS4.5T/S2500 g g X
(6699211)
RK4.5T-50-RS4.5T/S2500 g g X
(8035246)
WK4.5T-25-RS4.5T/ a o] X
S2500
(6638425)
WK4.5T-50-RS4.5T/ a o] X

S2500
(6638426)

A The "coupling" serves to connect the read/write head
B The "Connector" is connected to the interface module
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Ready-made connection cables with coupling

The "coupling" serves to connect the read/write head M12-connectors BS8151-0/9
(6904613) are used to connect the interface module.

® Note

1 When installing the connector, please note the "Pin assignment for the connection
cables" page 2-39!

Table 20:
Ready-made
connection
cables (BL67)

Type description Coupling? 2m 5m 10m 25m 50m
(Ident number) straight = s
angled = a
RK4.5T-2/S2500 g X
(8035244)
RK4.5T-5/S2500 g X
(6699206)
RK4.5T-10/S2500 g X
(6699207)
RK4.5T-25/S2500 g X
(6638421)
RK4.5T-50/S2500 g X
(6638422)
WK4.5T-2/S2500 a X
(8035245)
WK4.5T-5/S2500 a X
(6699208)
WK4.5T-10/S2500 a X
(6699209)
WK4.5T-25/S2500 a X
(6699423)
WK4.5T-50/S2500 a X
(6638424)

For the food and beverage range (FB = Food and Beverage) - IP69K

FB-RK4.5T-5/S2502 g X

(8036404)

FB-RK4.5T-10/52502 g X
(8036405)

FB-RK4.5T-25/52502 g X
(8037011)

A The "coupling" serves to connect the read/write head
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Connection cables for installing a connector and a coupling

Self-assembly of "CABLE-BLIDENT-100M" suitable for BL ident ® is possible. For this
purpose install the M12-connector "BS8151-0/9" (6904613) to connect the interface module,
and the M12-coupling "B8151-0/9" (6904604) to connect the read/write head.

® Note

1 When installing the connector and the coupling, please note the "Pin assignment for
the connection cables" page 2-39.

Connection level - base module BL67-B-2M12

Figure 22:
Connection
level
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Figure 23: 2 2
Pin assignment 22 (o)
connector (left) 3 & 1 1 3
and coupling
tight 4 5 5 4
Table 21: Port Pin Pin Signal® Color mapping” Color mapping®
Pin. assignment of assignm RK4.5T... and FB4.5T..
assignment to the ent of WK4.5T..
BL67-2RFID BL67-B-2M12 the
connect
or
1 0.1 1 Viwhead®  Brown (BN) Red (RD)
0.3 3 GND Blue (BU) Black (BK)
0.2 2 Data- Black (BK) Blue (BU)
0.4 4 Data+ White (WH) White (WH)
2 1.1 1 Vo nead®  Brown (BN) Red (RD)
1.3 3 GND Blue (BU) Black (BK)
1.2 2 Data- Black (BK) Blue (BU)
1.4 4 Data+ White (WH) White (WH)

A This specification refers to the standard TURCK-connectors for BL ident ®.

B "Power supply voltage" page 2-28
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Diagnostics via LEDs
LEDs of the fieldbus side

Table 22:
LED-displays

2-40

LED Status Meaning Remedy
GWwW OFF CPU is not supplied by Please check the supply voltage
voltage. of the system connected to the
gateway.
green Firmware active, gateway
ready for operation and
sending.
green blinking, Firmware inactive. When LED "10s" is red,
1Hz firmware download is needed.
green blinking, Firmware active, hardware  Replace the gateway.
4 Hz of gateway
defective.
red and CPU not ready for — Please check the voltage
LED "I0s" OFF operation, Vs too low— supply of the system
possible causes: connected to the gateway and
—too many modules on the wiring.
gateway — Pull surplus modules.
—short circuit in connected - Replace the gateway if need
module be.
— gateway defective
10 OFF CPU is not supplied by Please check the supply voltage
voltage. of the system connected to the
gateway.
green Configured constellation of

the module bus
participants corresponds
to the real one;
communication is active.

green blinking,
1Hz

Station is in the Force-
mode of the I/O-
ASSISTANT.

Please deactivate the Force-
mode of the
I/O-ASSISTANT.

green blinking,
4 Hz

The allowed max. number
of modules connected to
the gateway has been
exceeded.

Please check the number of
modules connected to the
gateway and pull surplus
modules if needed.
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Table 22: LED Status Meaning Remedy
(cont.)
LED-displays
10 red CPU not ready for - Please check the voltage
operation. Either V. is too supply of the system
low or Bootload is needed. connected to the gateway and
- the wiring.
possible causes: — Pull surplus modules.
—too many modules on — Replace the gateway if need
gateway be.
- short circuit in connected
module
— gateway defective
red blinking, Inadaptable modificationof = — Please compare the projection
1 Hz the real constellation of the of your BL67-station to the
module bus participants. real constellation.

— Please check the
configuration of your BL67-
station for defective or
wrongly plugged electronic
modules.

red blinking, No communication via the — At least 1 electronic module
4 Hz module bus. must be plugged in and able to
communicate with the
gateway.
red/green The current and the — Please check the BL67-station
blinking, projected module lists do for pulled or new modules that
1Hz not match, but the data are not projected.
exchange continues.
RUN/ OFF No program
STOP loaded into gateway.
green Application loaded into
gateway, program is
running.
green blinking  Application loaded into — Please start the gateway/the
gateway, but PLC has not PLC-program.
started or rather has
stopped.
red PLC-test at start-up of the
gateway
Vee green Module bus and CPU o.k.
OFF CPU is not supplied or — Please check the system

D101640 0109 - BL ident® CoDeSys
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Table 22:
(cont.)
LED-displays

LED Status Meaning Remedy
V, green Supply of outputs o.k.
green blinking, Low voltage V; system — Please check the supply
1Hz running. voltage of the system
— - connected to the gateway.
green blinking, High voltage V; system
4 Hz running.
OFF Voltage supply missing
V, green V, o.k.
red Short circuit or overload on  — An automatic restart occurs as

sensor supply V., head —

switching off sensor supply

soon as the error no longer
exists.

green blinking,
1Hz

Low voltage V,; system
running

green blinking,
4 Hz

High voltage V,; system
running

— Please check the supply
voltage of the system
connected to the gateway.

OFF

Voltage supply missing

— Please check the supply
voltage of the system
connected to the gateway.

Only the BL67-PG-DP has a DP-LED:

DP green PROFIBUS-DP =
communication
established
red PROFIBUS-DP — Please check the PROFIBUS-
communication interrupted DP wiring as well as the
setting of the Slave-address
and the baud rate.
LINK/ green Link established, 100 Mbit/
ACT s

green blinking  Ethernet traffic, 100 Mbit/s

orange Link established, 10 Mbit/s

orange Ethernet traffic, 10 Mbit/s

blinking

OFF No Ethernet link — Please check the Ethernet

connection
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Table 22: LED Status Meaning Remedy
(cont.)
LED-displays
MS green Display of the logical
connection to the Master
(1. Modbus TCP-
connection)
green blinking Gateway signals
operational readiness.
red Gateway signals errors.
red blinking DHCP/BootP-search of
setting
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LEDs for the RFID-connections

The LEDs are positioned on the modules above the connection plane.

Table 23:
RFID-
connections

2-44

LED Status Meaning Remedy
D OFF Normal data exchange
red Module bus Please check whether more than
communication failure two neighboring electronic modules
were pulled.
Relevant are those modules which
are positioned between the
gateway and this particular module.
red blinking Diagnosis present
0.5 Hz
RWO OFF No Tag in received range
RW 1
green Tag in received range

green blinking
2 Hz

Data transfer from / to
Tag

red Error in read/write head
red blinking Short circuit
2 Hz supply read/write head
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Diagnostic messages and parameterization of the programmable gateways

A full description of the gateway diagnostic messages and the parameterization possibilities
can be found in the manuals:

"BL67 User Manual BL67-PG-EN" D301032

"BL67 User Manual BL67-PG-EN-IP" D301044

"BL67 User Manual BL67-PG-DP" D301046

Parameterization of the BL67-2RFID-A/BL67-2RFID-S-modules
BL67-2RFID-A

At this time, parameterization is not possible.

BL67-2RFID-S

The only parameter "Bridging Time Kx[n*4ms]" must only be changed/adjusted when a
certain error message appears at startup. Please refer to the respective Chapter "Startup..”
for details.

Diagnostic messages of the BL67-2RFID-A/BL67-2RFID-S-module with BL67-PG-
EN / BL67-PG-EN-IP / BL67-PG-DP

Possible software diagnostic messages (for example "Modbus Server Tester") may be
obtained via Registers 0xA000 to 0xA400. Here, 32 registers are available to each module.
The diagnoses for the first module of the station can be located in Register 0XAQ00  the
diagnoses for the second module starting at 0xA020, for the third starting at 0xA040, etc. The
diagnostic messages are the last byte of the Modbus TCP-telegram. For the BL67-2RFID-A-
module, it is 2 Byte (4 hexadecimal digits).

The error messages for the first port are represented by the last two hexadecimal digits. The
error messages for the second port by the digit pair before last.

Please change the hexadecimal values to binary values and evaluate per the following table
("1" means error):

Table 24: Diagnosis byte and Description I/0-ASSISTANT
Diagnoses of bit

the Ident-

ports

Diagnoses Port 1

0 0 reserved
1 reserved
2 "ldent Overcurrent" (the supply of the read/write head
(transceiver) is switched off).
3to7 reserved
1 0 "Transceiver hardware fault"
1to2 reserved
3 "Transceiver supply voltage error"
4to7 reserved
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Table 24: Diagnosis byte and Description I/0-ASSISTANT
(cont.) bit

Diagnoses of

the Ident-

Diagnoses Port 2

2 0 reserved
1 reserved
2 "ldent Overcurrent" (the supply of the read/write head
(transceiver) is switched off).
3to7 reserved
3 0 "Transceiver hardware fault"
1to2 reserved
3 "Transceiver supply voltage error"
4t07 reserved
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Warning

This device may cause radio interference in living quarters and in small industry
(living, business- and commercial areas, small business). In this case the user may
be asked to implement respective measures at his own expense.

Attention
The auxiliary supply must meet the requirements of the safety low voltage (SELV =
Safety extra low voltage) per IEC 364-4-41.

Approvals and tests of the interface module

Table 25: Approval
Approvalsand

tests per Ce
EN61131-2 @

UL

&

Ambient temperature

Operating temperature

0to +55 °C /32 to 131 °F

Storage temperature

-25 to +85 °C /-13 to 85.00 °F

relative humidity

510 95 % (internal), Level RH-2,
no condensation (at 45 °C storage)

Vibration test

per EN 61131-2

Shock test

per IEC 68-2-27

Falling and tumbling

per IEC 68-2-31 and free fall per
IEC 68-2-32

Electromagnetic compatibility

per EN 61131-2

Protection Class IP 67
Reliability

Life cycle MTBF min. 120000 h

Pull-/Plug Cycle of Electronic 20

modules

D101640 0109 - BL ident® CoDeSys
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Note

Additional technical specifications for testing TURCK products of the BL67 product
family can be found in the catalog "Modular I/O systems and compact I/O modules
inIP20 and IP67" (D301053) and the manuals "BL67-User Manual for BL67-PG-EN"
D301033, "BL67 — programmable Gateway BL67-PG-EN-IP User Manual"
D301044, "BL67- programmable Gateway BL67-PG-DP User Manual" D301047.

jud. @

BL67-PG-EN, BL67-PG_EN-IP, BL67-PG_DP

Table 26: Description Value Meaning
Technical
data of the
program-
mable
Ethernet-
gateway
Supply voltage
System supply V, (Ug) 24 VDC Made available by the
galvanically isolated
acceptable range 18 to 30 VDC module bus supply.
Field supply Vg (U,) 24 VDC
acceptable range 18 to 30 VDC
ks 600 mA Current consumption
CPU + module bus when
station is at full capacity
Ivs max. 1.3 A Max. output current of
the module bus supply
ly, max. 4 A Protection of the sensor

supply from gateway or
power-feeding module
against overload and

short circuit.
Fieldbus - only for BL67-PG-DP
PROFIBUS-DP
Transfer rate fieldbus 9.6 kbit/s to 12 Mbit/s
Address range fieldbus 1...125

Isolation voltage

Ugs 500 VAC
(Ethernet/ Service-interface)

Uy 500 VAC
(Ethernet/ Module Bus)
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Table 26: Description
(cont.)

Technical

data of the

program-

mable

Ethernet-

gateway

Value Meaning

Usys
(Vo/V, contra Ug )

1000 VDC

Ugioq / Service interface

1000 VDC

PLC-data

Programming

— Software CoDeSys V 2.3
—for RFID fromV 2.3.6.4
— Programming languages IEC 61131-3

(AWL, KOP, FUP, AS, ST)

— Application tasks

1

— Number POUs (Program
Organization Units)

1024

— Programming interface

RS232-interface, Ethernet

Processor

RISC, 32 Bit

—Cycle time

< 1 ms for 1000 AWL-commands
(no 1/0O-cycle)

— Real-time clock yes
Memory

— Program memory 512 kByte

—Data memory 512 kByte

- Input data

4 kByte (physical inputs plus network variables)

— Output data

4 kByte (physical outputs plus network variables)

— Residual memory

16 kByte

Ambient conditions

Ambient temperature

- tAmbient

0to +55 °C /32 to 131 °F

- tStore

-25t0+85°C/-131to 185 °F

relative humidity

51095 % (internal), Level RH-2, no condensation
(at 45 °C storage);
per IEC 61131-2

Climate check

per IEC 61131-2

Damaging gas

D101640 0109 - BL ident® CoDeSys
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Table 26:
(cont.)

Technical
data of the

program-
mable
Ethernet-
gateway

2-50

Description

Value Meaning

- SOZ

10 ppm (rel. humidity < 75 %, no condensation)

—H,S

1.0 ppm (rel. humidity < 75 %, no condensation)

Vibration resistance

per |IEC 61131-2

—10 to 57 Hz, constant amplitude yes
0.075mm, 1g
—57 to 150 Hz, constant yes

acceleration 1 g

- Mode

Frequency cycles with a rate of change of 1
Octave/min

— Mode duration

20 frequency cycles per coordination axes

Protection Class

per IEC 60529, IP67

Shock resistance

per IEC 68-2-27, 18 shocks, half sinus 15 g peak
value/11 ms, each in + direction per space
coordinate

Permanent shock resistance

per IEC 29.02.68, 1000 shocks, half sinus 25 g
peak value/6 ms, each in + direction per space
coordinate

Falling and toppling/

per IEC 68-2-31/

free fall per IEC 68-2-32
— Fall height 1.0 m
(weight < 10 kg)
— Fall height 0.5m
(weight 10 to 40 kg)
—Test cycles 7

Transient emissions

high-frequency radiated

per EN 55011, Class A

Electromagnetic compatibility
(EMC)

per EN 61131-2/EN 50082-2 (Industry)

Static electricity per EN 61000-4-2

— Air discharge (direct) 8 kV
- Relay discharge 4 kV
(indirect)

Electromagnetic
HF-fields

per EN 61131-2
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Table 26: Description Value Meaning
(cont.)
Technical
data of the
program-
mable
Ethernet-
gateway
Rapid transients (Burst) per IEC 61131-2
Cable-bound per IEC 61000-4-6
interference sizes, 10V
induced by HF-fields Criterion A
A [/O-cable Energy rich per |IEC 61000-4-5
length transients A 0.5kV CM, 12 ¥ 9 uF
80m voltage supply 0.5kVDM, 2 & 18 uF
Criterion B
Reliability
Life cycle MTBF min. 120000 h
Pull-/Plug cycles of the 20
electronic modules
Housing material PC-VO0 (Lexan)
Dimensions
Width/ Length/ Height 64,5 x 145,0 x 77,5/
(mm/inch) 2,54 x 5,71 x 3,05
Diagnostic interface PS/2 female connector
Connection plane of read/write head
Table 27: Description Value
Technical
data BL67-
2RFID-A
Number of ports 2
Nominal voltage V, 24 VDC
Nominal current from field supply <100 mA
Nominal current from module bus <30 mA
Power loss, typical <1 W
Inputs/Outputs
Transfer rate 115.2 kBit/s
Cable length 50 m

Potential isolation
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Table 27: Description Value
Technical

data BL67-

2RFID-A

Connection technology read/write heads  M12 coupling

Data buffer receive/send 8/8 kByte
Cable impedance 120 Q
Utilization factor 1
Supply of sensors 500 mA per port, short circuit protected
Number of diagnostic byte 4 (BL67-2RFID-A, BL67-2RFID-S)
Number of parameter byte 8 (BL67-2RFID-A, BL67-2RFID-S)
Number of input byte 4 (BL67-2RFID-A)

24 (BL67-2RFID-S)

Number of output byte 4 (BL67-2RFID-A)
24 (BL67-2RFID-S)

Dimensions (B x L x H) 32 x 91 x 59 mm
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Example startup with BLxx-2RFID-A modules

TURCK provides example projects for this specific purpose. Order directly from TURCK the
CD with the example projects and all other required software components: Ident-No. 1545052

Hardware description of the example project
The following hardware components were used for the example startup:
BL ident ®-interface module "TI-BL67-PG-EN-2" (1 x 2-port)
BL ident ®-read/write head "TN-CK40-H1147"
Data carrier "TW-R30-B128" (user data = 112 bytes)
Suitable connection and supply cables
Installation of the software "CoDeSys"

If you install the CoDeSys software directly from the BL ident ®-CD (Ident-No. 1545052), you
will automatically have the correct version for the example project.

Note

)
1 Please note that you will require the CoDeSys-version 2.3.6.4 (or earlier) for startup
of the BL ident ®-system!

Note
The example project works with the target file folders as suggested by the CoDeSys!

jod @
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Installation of the target with InstallTarget.exe

In order to support the operation of the TURCK-gateways with the CoDeSys, the installation
of the gateway specific "Target" is needed. The Target Support Package (in short: TSP) is a
file folder with various files needed for the operation of the gateways on CoDeSys. You may
locate the TSP on the BL ident ®-CD (Ident-No. 1545052). In addition to the Target file, this
file folder also contains other manufacturer specific files like libraries, etc..

Figure 24:
TSP file folder
for the
programmable
gateways

3-4

tsp_turck_al_pgs

Note

Please ensure that the directory structure of the TSP file folder remains intact.
If this is not the case, problems may occur when the target is installed.

jud. @

® Note
1 Current Target files are also located online at http://www.turck.com.

The program Targetinstall.exe is needed for installation. In general, this program can be
located via the following directory tree:

C > Programs > 3S Software > CoDeSys V2.3 > InstallTarget.exe
The program can also be started alternatively via:
Start > Programs > 3S Software > CoDeSys V2.3 >InstallTarget

After the start of the InstallTarget program, please click on the "Open" button. Search for the
TSP file folder for the programmable gateway (for example, TSP_turck_all_pgs_Vx.x.x.x) and
select the .tnf-file (for example, Turck-PGs.tnf). Please click on the "Open" button again. Now
the new Turck file folder is in the field "Possible Target Systems".

The respective installation directory is displayed. Mark the gateway type you used. Click the
"Install" button. The new gateway now belongs to the "Installed Target Systems".

Downloading the example project to the CoDeSys

Start the 3S-software CoDeSys. Open the example project that is compatible with your
gateway:

File > Open >

% BL67-PG-EN_PibComm_v6_003.pro

The example BL67-PG-EN_PibComm_xxx.pro belongs to the gateway BL67-PG-EN.
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Completeness of the libraries of the example program

Check the completeness of the libraries. It is possible under certain circumstances that you
will receive an error message if the libraries of the example program are incomplete.

The libraries are displayed when you open the tab "Resources" and then select "Library
Manager" from the menu.

The list of the integrated libraries can be found on the top right next to the Resources menu.
For this example program, the following libraries are needed:

BLxxPIB.lib

BLxxloSys.lib

Standard.lib

Please open the window "Additional Libraries" to complement the libraries. The window is
selected by right-clicking the mouse in the free space next to the library list.

Figure 25: CoDeSys - BL67-PG-EN_PibComm_v6_003.pro - [Library Manager]
Library manager

ﬂEIe Edit Project Insert Extras Online Window Help - | &

el W e T e e e e

BledoSys.lib*19.1.07 09:20:00
rStandard.lib 4.10.05 11:14:45

E'..;.F’iesnurc:es

I3 Global Variables

. Globale_Variablen

@ varGlobe_PIB

@ variablen_Konfiguration (vAR_C
#-[11 library BLoloSys lib*19.1.07 09:20:00
#-[1] library BLoPIB.lib 11.6.07 14:50:00: gl
(5 Toaols

Alarm configuration

""" 1" ji] Librany Manager

Integrated
Libraries

& Log S FOUs
B2 BLwe_FIBE_Lib
----- DF_GETIOSUE (FB)
----- DF_RDREC (FB)
----- DF_SETIOSUB (FB)
DF_WRREC (FB)

""" FLC Configuration

""" @ Sampling Trace

""" pﬁlTargetSettings

""" [## Task configuration

""" 2, watch- and Recipe Manager
""" 3% Warkspace

v - POUSI'TS Datatypesl‘v‘isualizatiunsl. Glabal Variablesl
POUSI.I.-' Data...l\fisu...@ P‘ESDI Il nading librar ‘CAProgramme\Gemeinsame DatejenCAA-Tarmets\Torek

The libraries BLxxPIB.lib and BLxxloSys.lib can be found in the TSP file folder:
C > Programs > Shared Files > CAA-Targets > Turck > BLxx

The library, Standard.lib, is located under:

C > Programs > 3S Software > CoDeSys V2.3 > Library

In the case that a missing library appears with a red text, delete the library first by right-
clicking the mouse and then by clicking "Delete". The library can now be integrated without
problems as described above.
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Setting of the IP-addresses for Ethernet communication

With a few steps now check whether the IP-address of your gateway matches the IP-address
of your PC-Ethernet connection.

1. Setting of the communication parameters in CoDeSys

In the software CoDeSys you may access "Communication Parameters" via Menu Online.
Here, accept the following settings:

Figure 26:
Setting of the
communication
parameters in
CoDeSys

3-6

M ame W alue Comment
Addresz 192.168.001.001  |IP addresz or hosthame
Puart 1200
Blockzize 124 bzt match with runtime

taotorola bytearder ez

Here, the last three digits of the address must be "001". In the example, this corresponds to
the switch setting of the rotary switches on the gateway. Differing switch settings must be
accepted accordingly.

Note

®
1 After each change of the switch setting of the rotary switches on the gateway, a
voltage-reset is needed!

™ Note
1 Please note that the parameter "Motorola byteorder" must have the value "Yes"!

2. Checking/setting of the IP-address of the network interface card or rather the PC
The procedure applies to the operating systems Windows 2000 and Windows XP.
Here, you may access the network connections via:

Start > Control panel > Network Connections

Please select from the list the network connection for your gateway (for example, LAN-
connection 3). Right-click on the mouse to open the file folder "Properties".

In the window "This connection uses the following elements" under "General", please check
the bottom item "Internet Protocol (TCP/IP)". You may click on the "Properties" button if this
entry is checked blue. Here, you can check whether the IP-address of the data processor/
network interface card matches the IP-address of the gateway in Figure 26.
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Figure 27:
IP-address of Internet Protocol (TCP/IP) Properties
the data
General
processor or
rather the Y'ou can get IP settings azsigned automatically if your netwaork, supparts
network thiz capability. Othenwize, vou need to azk pour network, adminiztrator for

interface card the appropriate [P settings.

() Obtain an IP address automatically
() Uze the following IP address:

1P address: 192 168 . 1 . &

Subnet mazk: e 285 255 . 0

Default gateway:

(®) Use the following OMS server addresses:
Prefered DMS server:

Alternate DNS zemver

[ Ok H Cancel ]

It is possible to change the IP-address by selecting the item "Use the following IP address"
or rather "Specify IP address".

Communication between the BL67 gateway and the data processor is possible if the digits of
the first three ranges correspond. In this example it is 192.168.001.
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Log-in and start

Log-in in the CoDeSys occurs via:

Online > Log in

or alternatively with ﬁ

Respond yes to the question whether the new program should be downloaded.

In the case that you receive an error message, please check the connection cables and read
the previous chapters. The Turck BL67-PG-Ethernet gateways signal an intact Ethernet
connection via the LED "LNK/ACT". In case that this LED is "off", please check whether the
screw connection is correctly screwed on and not skewed, or whether the connector on your
PC has come loose.

The successful log-in is confirmed when the message "ONLINE:BL67_PG_XX" (bottom right
in the CoDeSys window) changes from gray to black:

RHREF :

S0 YAR_IN_OUT)
IN_OUT)
I QLT

( ONLINE: BLS?_PG_ENW[
e —

The start of the program is initiated in the CoDeSys via:
Online > Run

or alternatively with I

The successful start is confirmed when the message "RUNNING" (bottom right in the
CoDeSys window) changes from gray to black:

A feRR MOl

ouUT)

it [RUMMING [EF [F

Note

A complete description of the LED diagnostics can be found in chapter ,,Mounting
and installation“.

. @
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The basic settings have already been made in the example project.
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The following explanations serve for overall comprehension so that you may also initiate
applications that basically differ from this example project.

The top program level which is cyclically processed by the CPU is represented in the
CoDeSys software by the component, PLC_PRG.

To examine this level, please select the "POUs" tab and double-click on PLC_PRG(PRG) to
open the display of the component.

Figure 28:

The component
PLC_PRG
(PRG)

4 CoDeSys - BL67-PG-EN_PibComm_v6_003.pro - [PLC_PRG (PRG-CFC)]
g Hle Edit Project Insert Extras Onine Window Help

S| Bl@leADlE (R0 &R (o -] =l=|B)e|sl=|E]d s =] @lefe| k]

I POUs
i ELident_Init_Pulse [FB)
'8 PIE_ErarDecode_GE (FUN)
o

i~[8] PRG_ErorDecads (PRG)
(2] PRG_PibCarmmands (PRG)

0021 Reset_Trig: R_TRIG;
00: Step_0: BLident_Init_Pulse;
0023(END_VAR

¢

Step_0
BLident_Init_Pulse @
xnitPulse BLident_init_Pulse

Ch_0 @

PIB_001KB
Ch_0_EXECUTE |—EXECUTE STATUS——]
0 D DONE——
111 —{INDEX BUSY—— Ch_0_|
0 |OFFSET ERROR——| Ch_0_ERROR
—RPTCHD WARNING—
—~{3RESET RPTACT—
Ch_0_INIT_—iNIT ERR_IREQH
—uouTo TPCH
—uoutt TP—— Ch_0_TF 3
—uouTz2 UINO—— Ch_0_TransmitterON
—uouTs UIN1—— Ch_0_TagFullyRead
—RDGATE UINZ— _
10 |—cMoDim UINg Ch_0_TransmifipeZpnnacted
Ch_0_CWDSEL |—{CMDSEL TRLEN Ch_0_TRLEN
200 |—TXBUFLEN  ® CMDREF
1 {TXSTART ¥ TXREF
200 —RXBUFLEN + RXREF
1 RXSTART
Ch_0_CMDREF_|—CMDREF »
Ch_0_TXREF |—{TXREF &
Ch_0_RXREF_|—{RXREF *
Reset_Trig
R_TRIG
Ch_0_DONE_}—CLK n Q [R[Ch_0_EXECUTE
[R[ch_o_INIT
PRG_PihCummands
PRG_ErrorDecode
7]

PIB_ErrorDecode_GB
Ch_0_STATUS FIB_STATUS PIB_ErrorDecode_GB|

Ch_0_ErrorString

<

- POUSI'T: Diata I\/isu...l% Reso I

[Loading librar

C\Programme\Gemeinsame Dateien\CAA-Targets\TurckiCommeon Lib\BLxPIB.lib

[GNONE [0 [READ

Operation of the first port of a 2RFID-module can be initiated with this example project. Here,
the addition, CH_O, represents the first port. For a second port an additional instance of the
PIB should be created (mapped) and programmed in the same manner.

The following tables describe the variables of the function block PIB_001KB of this example
program. The values of the configuration parameters that had been written first can only be
changed "Offline" by overwriting them. The Offline mode is generated with:

Online > Logout

or alternatively with

D101640 0109 - BL ident® CoDeSys
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Table 28: Variable
Configuration
parameters

Value here Meaning

This is the start address for the BL ident ®-process data of
the first module. The "ID" (start address) for a second
module must be "4", for a third it must be "8", and for a
fourth "12".

(The address range for the first port is set with the
"OFFSET"=0, and for the second port with the
"OFFSET"=2).

INDEX

111

The index "111" indicates that the next execution initiates
a data transfer (also parameter data) to Port 1. The index
"112" refers to Port 2 of each BL ident ®-module of the
station. Differing indices (for example, "113") result in an
error message "DW#16#E7FE06xx" page 3-55.

OFFSET

This offset is added to the start address (ID). The
calculated address relates to the process data of a port.
Here, the offset is "0" because the module CH_0 belongs
to the 1st port. The process data for a

BL ident ®-port consist of 2 bytes. The corresponding
offset for a module CH_1 that belongs to the 2nd port is
"2

CMDDIM

10

The input parameter CMDDIM defines the number of
"CMD_STRUCT"-structures for command parameters.
Multiple commands can be stored in the memory so that a
more efficient user program can be written. The number of
stored commands influences the memory range that is to
be reserved for the respective PIB-instance.

TXBUFLEN

200

The send buffer for the 1st port (1st instance) occupies a
range of 200 bytes in CH_0_TXREF. The array
CH_O_TXREF defines the entire memory range for the
send data and includes 1024 bytes.

CH_O0_TXREF can be found under the tab "Resources" in
the file folder Global Variables in "VarGlobe_PIB".

TXSTART

The send buffer for the 1st port starts at Position 1 of the
memory range. Here is the first byte of the array
CH_O_TXREF: CH_0_TXREF[1].

Because of the length of 200 bytes (TXBUFLEN), the
memory range CH_0_TXREF[1] to CH_0_TXREF[200] is
available for the send data (write data) of the 1st port.

A 2nd port could therefore occupy the range
CH_0_TXREF[201] to CH_0_TXREF[400].

RXBUFLEN

3-10

200

The received buffer for the 1st port (1st. instance) occupies
a range of 200 bytes in CH_0_RXREF. The array
CH_0_RXREF defines the entire memory range for the
received data and includes 1024 bytes.

CH_0_RXREF can be found under the tab Resources in
the file folder Global Variables in "VarGlobe_PIB".
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Table 28: Variable Value here Meaning
(cont.)
Configuration
parameters
RXSTART 1 The received buffer for the 1st port starts with Position 1

of the memory range. Here is the first byte of the array
CH_0_RXREF: CH_0_RXREF[1].

Due to the length of 200 bytes (RXBUFLEN), the memory
range CH_0_RXREF[1] to CH_0_RXREF[200] is therefore
available for the received data (read data) of the 1st port.
A 2nd port could occupy accordingly the range
CH_0_RXREF[201] to CH_0_RXREF[400].

You may access the control variables and the command selection in the following table via
the tab "Visualizations" and by selecting "PLC_VISU".

Table 29: Variable Meaning
Control
variables and
command
selection
CH_.O Control variables for execution of a command.
_EXECUTE The command is executed with a positive edge of this variable. The
positive edge is generated by setting the variable from "false" to "true".
CH_O0 The command "Initialization" is realized with a "positive edge" of this
_INIT control variable. The positive edge is generated by setting the variable
from "false" to "true".
CH_O0 Command selection
_CMDSEL Here a value between 1 and 10 can be entered in order to execute 1 of

the 10 possible commands.

The definition of all commands can be found in the CoDeSys below the
description of the PLC_PRG (PRG): PRG_PibCommands (PRG) (Figure
28, page 3-9). The explanation of the command structures can be found
in this manual under "3.1.3 Commands" page 5-22. Also observe
Chapter "Definitions on the command level" page 3-25 which points out
deviations from the specifications.

The following commands are supported by the visualization of this
example program:

1: WriteConfig — initialization is executed when the configuration data is
written.

3: Inventory — reading of the UIDs from the data carrier.

4: PhysicalRead — writing of data to the data carrier.

5: PhysicalWrite — reading of the data of a data carrier.

6: MemStatus - status of a data carrier (for example, memory size,
existing capacity).

7: DevStatus - status of an Ident device.

8: Next — this command is used to end transponder operations.

The definitions of variables described in the following table can be found in the tab
"Resources" in the file folder "Global Variables" in "VarGlobe_PIB".
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Table 30: Variable
In_Out-
Parameters

Meaning

CH_O0
_CMDREF

This In_Out-variable refers to a global memory which is used to store
commands and the respective parameters. The maximum number of
commands mapped to a single PIB-instance may not exceed 10.

The explanation of the structures can be found in this manual under
"3.1.8 Commands" page 5-22. Also observe Chapter "Definitions on the
command level" page 3-25 which points out deviations from the
specifications.

CH_O0
_TXREF

This In_Out-variable refers to a global memory used by multiple PIB-
components for send data (write data). The PIB-instance may share the
memory with other components.

CH_O
_RXREF

This In_Out-variable refers to a global memory used by multiple PIB-
components for received data (read data). The PIB-instance may share
the memory with other components.

Please observe the status messages of the following table also with the visualization for this
example program (via the tab "Visualizations" with the selection of "PLC_VISU").

Table 31: Variable
Status
messages

Meaning

CH_O0
_STATUS

An error and alert code is sent with the help of this variable. A detailed
description of all types of error codes can be found at "Alerts and error
messages" page 3-53

CH_O
_DONE

With "TRUE" (blue) this variable signals that the command has been
executed. During the execution of a command, this variable briefly
switches to the mode "FALSE" (black).

CH_O0
_BUSY

This value indicates with "FALSE" (black) that at this time, nho command
is being executed.

This value indicates with "TRUE" (blue) when the PIB is occupied with
processing a command, and when no further command is transferable.

CH_O0
_ERROR

This output value is set to "TRUE" if an error has been detected. The
detected error could exist locally (inside the host control) or in the
peripherals (inside the Ident device). More detailed information
concerning the error are provided via the "STATUS" parameter. (This flag
is internally set by the PIB in the acknowledgment telegram (Bit O of ClI)
depending on the error bit. After a new request of a command this flag is
reset to "FALSE".

CH_O
_TP

3-12

This output value is set to "TRUE" (blue) if a target (here a data carrier) is
within the detection range of the read/write head.

It is "FALSE" (black) if there is no target (here data carrier) within the
detection range of the read/write head.

If an Ident-device does not support this feature, the value is set to "0".
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Table 31: Variable
(cont.)

Status

messages

Meaning

CH_O0
_Transmitter
ON

This output value indicates with "TRUE" whether the read/write head is
active. An active read/write head creates an electromagnetic field (for
example, the signal is transferred with 13.56 MHz).

Itis "FALSE" when the read/write head is inactive, this means no creation
of an electromagnetic field.

CH_O0
_TagFully
Read

This output value indicates with "TRUE" that all data ranges of the data
carrier were fully read from the BL ident ®-system. Automatic reading
always occurs when a data carrier is within the detection range of the
read/write head. The output value only continues to signal "TRUE" as
long as TP=1. The time between TP=1 and TFR=1 can not be seen as
reference time for a read/write command. If only few bytes are written or
read with a read/write command, the command is executed significantly
faster than the time it takes to fully read a 2000 bytes data carrier, for
example. Read commands can directly access data with TFR=1.

The output value is "FALSE" when the data ranges of the data carrier
were not fully read from the BL ident ®-system, or if the data carrier is not
within the detection range of the read/write head.

This automatic read operation is interrupted by all user commands. The
TFR-bit keeps its active value. The process is restarted if no other
commands exist and TP=1.

CH_O0
_Transmitter
Connected

This output value signals with "TRUE" that a read/write head is
connected.
The value is "FALSE" when the read/write head is disconnected.

CH_O0
_TRLEN

This output parameter indicates the number of the bytes last sent
(depending on the executed command, sent or received bytes), after the
command has been successfully executed.

For a thorough description of all parameters, please refer to "3.1.1 Parameters" page 5-7.

D101640 0109 - BL ident® CoDeSys
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Initialization of the 1st port (CH_0)

You have been introduced "The function block PIB_001KB" page 3-9 to the parameters of
this example project in Chapter. In the case that your BL ident ®-project differs from the
example project, you have adjusted the values.

In order to implement initialization, please open the tab "Visualization" and select "PLC_VISU"
by double-clicking it.

Figure 29:
Visualization tab

3-14

CoDeSys - BL67-PG-EN_PibComm_v6_003.pro* - [PLC_VISU]
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Transmit Buffer 4 0 Receive Buffer 4 0 0x00
Send data f|e|d ___’ Transmit Buffer & 0 Receive Buffer 5 i} 0x00 UID Byte 1
Transmit Buffer & 0 Receive Buffer 6 0 0x00 UID Byte 2
Transmit Buffer 7 0 Receive Buffer 7 0 0x00 UID Byte 3
Transmit Buffer & 0 Receive Buffer § 0 0x00 UID Byte 4
. . Transmit Buffer 9 0 Receive Buffer 9 0 0x00 UID Byte 5
Recelved data fleld TrameTT ouer 10 T 4“'» Receive Buffer 10 0 0x00 UID Byte 6
Transmit Buffer 11 0 Receive Buffer 11 0 0x00 UID Byte 7
Transmit Buffer 12 0 Receive Buffer 12 0 0x00 UID Byte 8
Clear Transmit Buffer / Clear Receive Buffer J
Error description:
[ system ok

% POUS]'T: Data.... IV\sua...IE Reso...]

A

>

[CNLONE: BLE7-PGEN [SM [[AUFT [BP [FORCE [UE [[ESE
The initialization occurs with "WriteConfig". The three offered alternatives differ as follows:

Init (or also Reset) - initialization is implemented. The status of the read/write head is
"activated" by default and is not changed.

Init - Transmitter ON - initialization is implemented. The read/write head is activated or
remains active.

Init - Transmitter OFF - initialization is implemented. The read/write head is deactivated.
Now implement initialization with "Init (or also Reset)".

Please ensure that the online connection to your control is active and that the program is
running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is highlighted black and
displayed at the bottom right of the window.

You may monitor command execution via the status messages. Active modes are signalled
here with the green illumination of the respective circular surface.
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When initialization has been successful, the INIT-, BUSY-, and DONE-status ("3.1.1
Parameters" page 5-7) become consecutively active.

The first byte of the received buffer corresponds to the value "MaxPacketSize" page 5-25.

If initialization was not successfully implemented, the ERROR-status is active via "Status": An
error code is sent to point out the cause of the error to the user. An explanation of all possible
error codes can be found in "Alerts and error messages" page 3-53.

Reading of the UID from the data carrier / Port 1 (CH_0)

Every RFID data carrier receives a "UID" page 6-4 (unique identifier) from the manufacturer.
The UID represents a worldwide unique TAG identification number and consists of 8 bytes.

Read of the UID is executed with the command "Read UID" in "PLC_VISU" of the tab
"Visualization". For a thorough description of this command code, please refer to "Inventory"
page 5-28.

® Note
1 Please ensure that the online connection to your control is active and that the

program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.

You may monitor command execution via the status messages. Active modes are signalled
here when the respective circles are illuminated green.

The request for command execution is created with the increasing edge of "EXECUTE". The
readiness to read the UID is signalled with the active BUSY ("3.1.1 Parameters" page 5-7)-
status.

The status "TP" is active when a data carrier is within the received range of the read/write
head.

The successful execution of the command "Read UID" is acknowledged with the active
DONE-status.

If the command "Read UID" was not successfully executed, the ERROR-status is active via
"Status": The sent error code points out the cause of the error to the user. A detailed error text
can be found in the "Error description" in the bottom window area. For an explanation of all
types of error codes, please refer to "Alerts and error messages" page 3-53.

Now you may read the "Unique Identifier / UID" only in the received field of the "PLC_VISU".
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Figure 30:
PLC_VISU after
Inventory
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4, CoDeSys - BL67-PG-EN_PibComm_v6_003.pro* - [PLC_VISU]
E Fle Edit Project Insert Extras Onine Window Help - |8 x

B8] BlEledtoSE0GE § (e

D e
-5 ( ) ®
O BUSY
) ERROR
®

[Status <0 |

@ [ Tasnteon

@ [_TACFURead

@ [ Trammiter Comecied

O T A

@) EXECUTE /

o —
Transmit Buffer 1 0 / Receive Buffer 1 240 0xF0 \
Transmit Buffer 2 0 Receive Buffer 2 0 0x00
Transmit Buffer 3 0 Receive Buffer 3 0 0x00
Transmit Buffer 4 0 Receive Buffer 4 0 0x00
Transmit Buffer 5 0 Receive Buffer 5 0 0x00 UID Byte 1
Transmit Buffer 6 0 Receive Buffer 6 0 0x00 UID Byte 2
Transmit Buffer 7 0 Receive Buffer 7 0 0x00 UID Byte 3
Transmit Buffer § 0 Receive Buffer § 0 0x00 UID Byte 4
Transmit Buffer 9 0 Receive Buffer 9 0 0x00 UID Byte 5
Transmit Buffer 10 0 Receive Buffer 10 0 0x00 UID Byte 6
Transmit Buffer 11 0 Receive Buffer 11 0 0x00 UID Byte 7
Transmit Buffer 12 0 Receive Buffer 12 0 0x00 UID Byte §
Clear Transmit Buffer

\ Clear Receive Buffer

Error description:
‘ System OK

|

EI POUSI.T: Data .. I\/isua..lTEn Reso.. I

[ [ONLINE: BLE-PG-EN [SIM [LAUFT [BP [FORCE [UE [LESEMN

A The UID consisting of 8 bytes can be found in the received buffer starting with byte 5 (Received

Buffer 5). Byte 5 represents the MSB, and byte 12 the LSB of the UID.

Here, the 2 bytes of the Received Buffer 1 and the Received Buffer 2 always signal 0x0001. In case
a group is compiled, it would be signalled here which data carrier was read.

Together the 2 bytes of the Received Buffer 3 and the Received Buffer 4 signal the number of read
byte.
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Writing to the data carrier / Port 1 (CH_0)

This paragraph explains the writing of 12 bytes data with any content to your RFID data
carrier.

Writing to the data carrier of the 1st port is possible after you have executed "Initialization of
the 1st port (CH_0)" page 3-14.

In this example, data was selected that can be easily recognized in the following "Reading
from the data carrier / Port 1 (CH_0)" page 3-18. Please enter any sequence of digits into the
send data field (Transmit Buffer 1 to Transmit Buffer 12). Based on the fact that the send data
field is divided into 1 byte sized buffers, the decimal numerical values in the 0 to 255 range
may be selected.

Figure 31: -
, 4 CoDeSys - BL67-PG-EN_PibComm_vé_003.pro* - [PLC_VISU] LI\
PLC_VISU with e : CIOX
. E Fle Edit Project Insert Extras Online Window Help | e
Write data
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o ERROR
53— —
[ Status : etfe0200 |
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Data to be wrtteqmemumes O T
in the N TR ® EXECUTE
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Transmit Buffer 3 30 Receive Buffer 3 0
Transmit Buffer 4 40 Receive Buffer 4 8
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Transmit Buffer 8 80 Receive Buffer 8 0 UID Byte 4
Transmit Buffer 9 90 Receive Buffer 9 Kk UID Byte 5
Transmit Buffer 10 100 Receive Buffer 10 174 UID Byte 6
Transmit Buffer 11 110 Receive Buffer 11 27 UID Byte 7
Transmit Buffer 12 120 Receive Buffer 12 208 UID Byte 8
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| System OK
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"~

3 |

Writing is implemented with the command "Physical Write" (or physical writing) in
"PLC_VISU" of the tab "Visualization". For a thorough description of this command code,
please refer to "Physical_Write" page 5-24.

Note

)

1 Please ensure that the online connection to your control is active and that the
program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.

You may monitor command execution via the status messages. Active modes are signalled
here when the respective circles are illuminated green.
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3-18

The request for command execution is created with the increasing edge of "EXECUTE".
Readiness to write is signalled with the active BUSY-status ("3.1.1 Parameters" page 5-7).

The status "TP" is active when a data carrier is within the received range of the read/write
head.

Successful execution of the "Physical Write" command is acknowledged with the active
status DONE.

If the command "Physical Write" could not be successfully executed, the ERROR status is
active, and with the help of "Status": an error code is sent to point out the cause of the error
to the user. A detailed error text can be found in the "Error description” in the bottom window
area. For an explanation of all types of error codes, please refer to "Alerts and error
messages" page 3-53.

Reading from the data carrier / Port 1 (CH_0)

This paragraph explains reading of 12 bytes of data of any content from your RFID data
carrier.

Reading from the data carrier of the 1st port is possible if "Initialization of the 1st port (CH_0)"
page 3-14 has been implemented.

The prior paragraph explained writing of any data to the data carrier with the "Physical Write"
command. In this paragraph, the same data is read with the "Physical Read" command (or
physical reading) from the data carrier.

For a thorough explanation of this command code, please refer to "Physical_ Read" page
5-23.

Note

®

1 If you use a different data carrier than indicated in "Hardware description of the
example project" page 3-3 or if you like to access certain areas of the data carrier,
please pay attention to "User data ranges of the data carrier versions." page 3-56.

Note

Please ensure that the online connection to your control is active and that the
program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.

g

You may monitor command execution via the status messages. Active modes are signalled
here when the respective circles are illuminated green.

The request for command execution is created with the increasing edge of "EXECUTE".
Readiness to read is signalled with the active status BUSY ("3.1.1 Parameters" page 5-7).

The status "TP" is active when a data carrier is within the received range of the read/write
head.

Successful execution of the command "Physical Read" is acknowledged with the active
status DONE.

If the "Physical Read" command could not be successfully executed, the status ERROR is
active, and with the help of "Status": an error code is sent to point out the cause of the error
to the user. A detailed error text can be found in the "Error description" in the bottom window
space. For an explanation of all types of error codes, please refer to "Alerts and error
messages" page 3-53.

You can now read the read data in the received data field of the "PLC_VISU".
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Information about the status of the data carrier

This paragraph explains the command "Mem Status" (or memory status). You may execute
the command after a successful initialization ("Initialization of the 1st port (CH_0)" page 3-14).

For a thorough explanation of this command code, please refer to "Mem Status" page 5-26.

Note

®

1 If you use a different data carrier than indicated in "Hardware description of the
example project" page 3-3 or if you like to access certain arrays of the data carrier,
please pay attention to "User data ranges of the data carrier versions." page 3-56.

Note

Please ensure that the online connection to your control is active and that the
program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.

k. 0

You may monitor command execution via the status messages. Active modes are signalled
here when the respective circles are illuminated green.

The request for command execution is created with the increasing edge of "EXECUTE".
Readiness to write is signalled with the active status BUSY ("3.1.1 Parameters" page 5-7).

D101640 0109 - BL ident® CoDeSys 3-19



Startup of the TURCK BL ident®system with CoDeSys

The status "TP" is active when a data carrier is within the received range of the read/write

head.

The successful execution of the command "Mem Status" is acknowledged with the active

status DONE.

If the command "Mem Status" could not be successfully executed, the status ERROR is
active, and with the help of "Status": an error code is sent to point out the cause of the error
to the user. A detailed error text can be found in the "Error description" in the bottom window
space. For an explanation of all types of error codes, please refer to "Alerts and error

messages" page 3-53.

Now you may read the first 12 bytes of the data from the data carrier in the received data field

of the "PLC_VISU".

Figure 33:
PLC_VISU with
data from the
data carrier
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With the command Mem Status, 13 bytes of information is sent. The complete information is
reproduced with the array CH_0_RXREF in the CoDeSys under the tab "Resources" in the file

folder "Global variables" in "VarGlobe_PIB".

The following table explains the 13 bytes data carrier information:
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Table 32: Received buffer Value in the example Meaning
Data carrier CH_O0_RXREF[x]
information
1108 UID consisting of 8 bytes

World-wide unique data carrier
identification number

9 0 Data carrier format (DSFID -
not supported by BL ident®.

10 0 Application recognition (AFI)-
not supported by BL ident®.

11 27 Memory size: Block Number-1, this
means the block number of the
sample data carrier is 28.

12 3 Memory size: Byte/Block-1, this
means the value Byte/Block of the
sample data carrier is 4.

13 1 1: IC-identification is supported.
0: IC-identification is not supported.

Information about the read/write head

This paragraph explains the command "Dev Status" (or device status). You may execute the
command after a successful initialization ("Initialization of the 1st port (CH_0)" page 3-14).

For a thorough explanation of this command code, please refer to "Dev Status" page 5-27.

Note

)

1 Please ensure that the online connection to your control is active and that the
program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.

You may monitor command execution via the status messages. Active modes are signalled
here when the respective circles are illuminated green.

The request for command execution is created with the increasing edge of "EXECUTE".
Readiness to write is signalled with the active status BUSY ("3.1.1 Parameters" page 5-7).

The status "TP" is active when a data carrier is within the received range of the read/write
head.

The successful execution of the command "Dev Status" is acknowledged with the active
status DONE.

If the "Dev Status" command could not be successfully executed, the status ERROR is active,
and with the help of "Status": an error code is sent to point out the cause of the error to the
user. A detailed error text can be found in the "Error description” in the bottom window space.
For an explanation of all types of error codes, please refer to "Alerts and error messages"
page 3-58.

You can only read the first 12 bytes of the read/write head data in the received data field of
the "PLC_VISU".
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Figure 34:
PLC_VISU with
data for the
Ident-device (12

4 CoDeSys - BL67-PG-EN_PibComm_vé_003.pro* - [PLC_VISU] [ m][4]
EEI& Edit Project Insert Extras Onlne Window Help | e (o

Ble(E] Bl (26

A Visualizations
Init (or also Reset)

of 48 bytes). )
)
™
o
[‘Status -0 |
@
™
o
)
@
Transmit Buffer 1 0 Receive Buffer 1 0 0x00
Transmit Buffer 2 0 Receive Buffer 2 0 0x00
Transmit Buffer 3 0 Receive Buffer 3 0 0x00
Transmit Buffer 4 0 Receive Buffer 4 0 0x00
Transmit Buffer 5 0 Receive Buffer 5 0 0x00 UID Byte 1
Transmit Buffer 6 0 Receive Buffer 6 0 0x00 UID Byte 2
Transmit Buffer 7 0 Receive Buffer 7 0 0x00 UID Byte 3
Transmit Buffer 8 0 Receive Buffer 8 0 0x00 UID Byte 4
Transmit Buffer 9 0 Receive Buffer 9 0 0x00 UID Byte 5§
Transmit Buffer 10 0 Receive Buffer 10 0 0x00 UID Byte 6
Transmit Buffer 11 0 Receive Buffer 11 1 0x08 UID Byte 7
Transmit Buffer 12 0 Receive Buffer 12 18 0x12 UID Byte 8
Clear Transmit Buffer Clear Receive Buffer
‘ System OK
= POUSI.I: Data..l\/\sua. IE Reso.. I | < b
| [ONLINE: BL67-PG-EN [SIM [LAUFT [BF [FORCE [UB [[ESEN
With the command Dev Status, 64 bytes of information are sent. The complete information is
reproduced with the array CH_0_RXREF in the CoDeSys under the tab "Resources" in the file
folder "Global variables" in "VarGlobe_PIB".
The following tables explain the 64 bytes Ident-device information:
Table 33: Received buffer Value in the example Meaning
Ident-device CH_0_RXREF[x]
information
1to0 10 0,0,0,0,0,0,0,0 Manufacturer specific data range. Is
currently not used by BL ident ®.
11 to 12 11 <=> 0xB Manufacturer identification number
18 <=> 0x12 0x12B <=> 299 <=> TURCK
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Table 33: Received buffer Value in the example Meaning
(cont.) CH_0_RXREF[x]
Ident-device
information
13 to 32 84, 78, 45, 67, 75, 52, Product description —the hexadecimal

48, 45, 72, 49, 49, 52, values can be interpreted per an ASCII
55, 0, 32, 32, 32, 32, code table, and then the result is:

32, 32 <=> TN-CK40-H1147

0x54, 0x4E, 0x2D,

0x43, 0x4B, 0x34,

0x30, 0x2D, 0x48,

0x2D, 0x2D, 0x34,

0x37, 0x00, 0x20,

0x20, 0x20, 0x20,

0x20, 0x20
33 to 48 0x20,...... Serial number
Is currently not used by BL ident ®.
49 to 50 0, 5 <=> 0x0005 Hardware version
here V0.5
51 to 54 86,1, 6, 0 <=> Software version here V1.6.7
0x56, 0x01, 0x06, 0x56<=>V (ASCII Code Table)
0x07 0x010607<=>1.6.7
55 to 56 0,0 Version counter
Is currently not used by BL ident ®.
57 to 58 91, 0 <=> Profile Identification Number
0x5B, 0x00 here: Identification system, PIB-profile
59 to 60 0,0 Specific profile type
Is currently not used by BL ident ®.
61 to 62 1,1 <=> 0x0101 1&M version number
here V1.1
63 to 64 0,1 <=> 0x0001 I&MO support:

here 0x01, this means yes

The "Next"-commands

This paragraph explains the "Next" command (or next). You may execute the command after
a successful initialization ("Initialization of the 1st port (CH_0)" page 3-14) and after a data
carrier was present in the received range of the read/write head.

This sample project contains the following variable for "Next" command:

Next - Mode O
The command that follows "Next - Mode 0" is only executed when the data carrier linked
to the prior command has at one time left the detection range of the read/write head.

Next - Mode 1
The command that follows "Next - Mode 1" is only executed when the "UID" linked to the
data carrier in the received range is different from the "UID" linked to the prior command.

For a thorough explanation of this command code, please refer to "Next" page 5-24.

You may read the definition of "Next - Mode 0" and "Next - Mode 1" under the tab
"Component" in "PRG-Pib-Commands".
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Note

Please ensure that the online connection to your control is active and that the
program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.

jud. @

The status "TP" is active when a data carrier is within the received range of the read/write
head.

The request to execute the command that follows "Next" is created with the increasing edge
of "EXECUTE". The readiness to execute the command following "Next" is signalled with the
active status BUSY "3.1.1 Parameters" page 5-7). Only when the "Next" conditions are
satisfied, the command may be executed and "DONE" is sent.

If the "Next" command could not be successfully executed, the status ERROR is active, and
with the help of "Status": an error code is sent to point out the cause of the error to the user.
A detailed error text can be found in the "Error description” in the bottom window space. For
an explanation of all types of error codes, please refer to "Alerts and error messages" page
3-58.
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The startup of the TURCK BL ident ®-system with the "Proxy Ident Function Block" entails
some modifications from the "Extract from the specification" page 5-1 (specification). The
differences pertain to the command- and diagnostic levels.

The following conformity table indicates which command and status- or rather diagnostic
messages of the complete specification are not supported by BL ident ®:

Table 34:
Conformity
table

D101640 0109 - BL ident® CoDeSys

Name

Type

Additional information
about the TURCK specific

conform?

(Y/N)

To point 3.1.4 of the PROFIBUS specification

Read Command N
Get Command Y
Physical_Read Command Y
Write Command N
Put Command N
Physical_Write Command Y
Format Command N
Create Command N
Delete Command N
Clear Command N
Update Command N
Next Command Y
Get-Directory Command N
Set-Attribute Command N
Get-Attribute Command N
Write Config Command Y
Read Config Command Y
Mem-Status Command Y
Dev-Status Command Y
Inventory Command Y
Read-Bar-Code Command N

To point 4.2.1 of the PROFIBUS specification

Reading-Gate Control Bit N
Repeat-Command Control Bit
Soft-Reset Control Bit Y
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Table 34: Name Type Additional information conform?
(cont.) about the TURCK specific  (Y/N)
Conformity version

table

To point 4.2.2 of the PROFIBUS specification

Target_Presence Status Bit Y

_Changed

Target_Present Status Bit

Soft_Reset Status Bit

_Active

Repeat_Command Status Bit N

_Active

Busy Status Bit

Error Status Bit

UIN3 Status Bit Read/write head is
connected

UIN2 Status Bit

UIN1 Status Bit Data of the data carrier fully Y
read to the read/write head

UINO Status Bit read/write head is activated Y
(please also refer to
WriteConfig)

The following commands differ from the specification:
Write-Config

This command is triggered in the PIB by INIT and supports Config=1 (Reset only) and

Config=3 (Write data and reset). 3 bytes Config-data can be written. The Config-data offer the
opportunity to switch on and off the transmitter of the read/write head. The switching on and
off of the transmitter can be used to avoid a mutual interference of closely positioned read/

write heads.
Table 35: Byte  Bit Meaning
Configuration
data
0 0.7 Reserved, must be 0
1 0..7 Reserved, must be 0
2 0 1= Transmitter On / 0= Transmitter Off, (default = 1)

1.7 Reserved, must be 0

Example for configuration data
"0x00, 0x00, 0x01"
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Read-Config
This command reads Config-data written under Write-Config.

Possible command specific STATUS values after faulty execution:

Table 36: STATUS Error description

Error message
DW#16#E4FE82xx No read/write head is connected.
Inventory

Only the parameter Attributes=0 is supported. ("Inventory" page 5-28)
Physical_Read

The parameter StartAddress and Length (+StartAddress) must be within the address range of
the data carrier. ("Physical_ Read" page 5-23)

Physical_Write

The parameter StartAddress and Length (+StartAddress) must be within the address range of
the data carrier. ("Physical_Write" page 5-24)

Mem-Status

In connection with the command Mem-Status, the Attribute 0x40 (physical status information)
is supported.

The response of the data carrier is transferred as data to a GET_SYSTEM_INFORMATION-
command per ISO/IEC 15693-3.

Byte 0 = serial number (UID), LSB

to
Byte 7 = serial number (UID), MSB
Byte 8 = data carrier format (DSFID)
Byte 9 = application identification (AFI)
Byte 10 = memory size: Block humber 1
Byte 11 = memory size: Bytes/Block-1,
Byte 12 = IC-identification
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Dev-Status

Only the parameter Attributes = 0x04 is supported. Resent is a data record per I&M-
specification I&MO0. The connected read/write head is being written to. ("Dev Status" page

5-27)
Example:
Table 37: From byte to byte Field Content
Dev-Status
example
0 9 Manufacturer specific header o,0,0,0,0,0,0,0,0,0
10 11 MANUFACTURER_ID 0x0B12 (299 =
TURCK)
12 31 ORDER_ID ,TN-CK40-H1147’,
0x00,
0x20, 0x20, 0x20,
0x20, 0x20, 0x20
32 a7 SERIAL_NUMBER (not supported)
48 49 HARDWARE_REVISION 0x0003
50 53 SOFTWARE_REVISION ,V’ (0x56), 0x01, 0x03,
0x00 (= V1.3.0)
54 55 REVISION_COUNTER (not supported)
56 57 PROFILE_ID 0x5B00 (identification
system, PIB profile)
58 59 PROFILE_SPECIFIC_TYPE 0x0000
60 61 IM_VERSION 0x01, 0x01 (= I&M
V1.1)
62 63 IM_SUPPORTED 0x01, I&MO supported
Next
Only the parameter NextMode = 0 or 1 is supported. ("Next" page 5-24)
Get
With this command it is possible to set the write protection of a block of a data carrier.
For this it is necessary to know how the memory of the used data carrier is arranged (number
and size of the blocks).
Attention
Setting of the write protection for a block is not reversible!
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Table 38: Bytes in the send data field Content
Send data field

for the "Get"

command

0 0x02

1 UID of the data carrier, UID =0 -> arbitrary

UID of the data carrier

UID of the data carrier

UID of the data carrier

UID of the data carrier

UID of the data carrier

UID of the data carrier

UID of the data carrier

|| N|]o|o| B~ WO DN

0x67

—_
o

Block number of the write protected blocks
(Ox00 = 1. Block, OxFF = 256. Block) to be switched

When successful, the following data is resent:

Table 39: Byte in the received data field Content
Send data field
for the "Get"
command
0 0x02
1 0x67
2 Command index

The occurrence of an error is signalled accordingly in STATUS.
Other commands

For an overview of additional commands, please refer to "3.1.3 Commands" page 5-22. To
execute the commands, please proceed as you do when writing and reading.
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Startup with BLxx-2RFID-S modules

3-30

The following describes the startup of a BL ident ®-systems with a BLxx-2RFID-S-module in
a programmable gateway with the use of the programming software CoDeSys from the
company "3S".

A first startup should be simple and possible without programming knowledge.

The following explanations are valid for all interface modules with programmable Ethernet
gateways and BLxx-2RFID-S-modules.

Hardware description of the sample project
The following hardware components were used for the example startup:
BL ident ®-interface module "TI-BL67-PG-EN-S-2"
BL ident ®-read/write head "TN-CK40-H1147"
Data carrier "TW-R30-B128" (user data=112 bytes)
Suitable connection and supply cables

Please download D101583 which you may find in the download area of the TURCK website
if you have questions or if you desire clarification concerning the read/write heads and the
data carriers.

Installation of the software "CoDeSys"

If you install the CoDeSys software directly from the BL ident ®-CD (Ident-No. 1545052), you
will automatically have the correct version.

Y Note
1 Please note that CoDeSys Version 2.3.6.4 is required for BL ident ®-system startup!
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Installation of the target with InstallTarget.exe

In order to support the operation of the TURCK-gateways with the CoDeSys, the installation
of the gateway-specific "Target" is needed. The Target Support Package (abbr.: TSP) is a file
folder with various files that are needed for operating the gateway on the CoDeSys. To locate
the TSP, please go to BL ident ®-CD (Ident-No. 1545052). Next to the Target file this file folder
contains other manufacturer specific files like libraries, etc..

Figure 35:

TSP folder for D tsp_turck_al_pgs
the gateway
BL67-PG-EN
Y Note
1 Please ensure that the directory structure of the TSP file folder remains intact.
If this is not the case, problems may occur when the target is installed.
The program Targetinstall.exe is needed for installation. In general, this program can be
located via the following directory tree:
C > Programs > 3S Software > CoDeSys V2.3 > InstallTarget.exe
Alternatively the program can also be started via:
Start > Programs > 3S Software > CoDeSys V2.3 >InstallTarget
After the start of the InstallTarget program, please click on the "Open" button. Search for the
TSP folder for your gateway (for example, TSP_Turck_BL67_PG_EN_Vx.x.x.x) and select the
.Inf file (for example, BL67-PG-EN.inf). Please click on the "Open" button again. Now the new
Turck file folder is in the field "Possible Target Systems".
The respective installation directory is displayed. Click on the button "Install". The new
gateway now belongs to the "Installed Target Systems".
Configuration in the CoDeSys
Start the software CoDeSys. Select File > New. Now you are asked to select your gateway-
type from the list:
Figure ,36: Target Settings
Selection of the
gateway Caonfiguration: MNone LJ | QK Cancel

Mane

35 CoDeSys SP PLOWINNT 2 4
BL20-PG-EN

BL20-PG-EN-IP

BLE?-FPG-DP
BLE?-FPG-EN
BLE?-PG-EN-IP
MAZ-450-YE 3.6 (DEMOD)
FAZ-450-E. 3.9 (DEMOD)

Acknowledge with "OK".

Select the language of the component (here FUP, for example) and keep the suggested name
PLC_PRG:
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Figure 37:
Selection of the New POU 8‘
g fggzg,:qmg Marne of the new POU: [PLC_FRG
-Type of POU i Language of the POU | Cancel
(® Program L
(" Function Block C LD
¢ Function i FBQ
Return Type: " SFC
BO0 _J ST
[ BERE
Acknowledge with "OK".
You will need a correct project for log-in. Please check PLC-PRG and write at least one
respective instruction (without effect) into the component "PLC-PRG".
Figure 38: | =
Component 4 CoDeSys - S_BL_ID_PG_EN.pro - [PLC_PRG (PRG-FBD)] il g
PLC-PRG !} File Edt Project Insert Extras Onlne Window Help - 8 x
=8| B|@|e IS5 & [E|@|m|] 0% | w8 e]ooe] 1] ]
000|PROGRAM PLC_PRG
0002VAR
0003 a: BOOL;
0004 EMD_VAR
0005
0008
_ S R
0001
& )
= | -
L Y Projectis up to date
POUSI.I: Datatypesl\fisualizationsl%Resourcesl < | >
| [ONLINE [TV [READ
Please select the subitem "PLC Configuration" on the "Resources" tab.
Please check the subitem "BL67 -IO[Slot]" of "Configuration BL67-PG-EN" in the directory
tree (middle window) for gateway configuration.
Please select the Input/Output tab in the right space of the window. Please check "BL67-
2RFID-S" under input/output modules. Click on the button "Select". Thus the configuration of
the station is already completed.
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Figure 39: 4. CoDeSys - 5_BL_ID_PG_EN.pro - [PLC Configuration]
PLC ﬁB Fle Edit Project Insert Extras Onine Window Help - 8 x
Configuration el e e T
E--Configuration BLE7-PG-EN ~ T T —
2 Resources H ~ BLE7-4DI-PD Selected Modules ;]
-] Global Yariables 4 o BLE7-4DIFN
B3 library BLodoSys lib 19.1 Hodbuz RegisteralSeOn BL67-8DHP
Bl (&) Tools BLE7-8DHPD
(28 Alarm configuration BLE7-BDI-M Select»>
(i) Library Manager i BLB7-2AH
BLE7-241Y :l
BLE7-2AHPT
BLE7-2AHTC
L BLBP-4AR
- Output Modules
(2 Task configuration = In-/Qutput Modules
@, Watch- and Riecipe Mang BLE7-4DI4D0-FD 5
22 \Warkspace . BLE7-8XSG-PD
BLE7-8XSGF
BLEZ-1CVI
BLEF-1RS232
-~ BLE™1RS422
BLE7-1RS435
BLE7-1S3I
BLE7-2RFID-A

< | > ¥ @ Empty Modules j

B E R ||

b4

[GHLNE [0V [FEAD

Setting of the IP-addresses for Ethernet communication

With a few steps now check whether the IP-address of your gateway matches the IP-address
of your PC-Ethernet connection.

1. Setting of the communication parameters in CoDeSys

In the software CoDeSys you may access "Communication Parameters" via Menu Online.
Here, accept the following settings:

Figure 40:
Setting of the MName Yalue Comment
communication Address 19216811 |IP address ar hosthame
parameters in Fort 1200
CoDeSys Targetid 1]

Motorola byteorder  Yes

Here, the last three digits for "Address" must be "001". In this example, this corresponds to
the switch setting of the rotary (encoder) switches on the gateway. Differing switch settings
must be accepted accordingly. The first 9 digits of the IP-address match the delivery status.

Y Note

1 Please note that the parameter "Motorola Byteorder" must have the value "Yes"!

2. Checking/setting of the IP-address of the network interface card or rather the PC
The procedure applies to the operating systems Windows 2000 and Windows XP.
Here, you may access the network connections via:

Start > System Control > Network Connections
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Please select from the list the network connection for your gateway. Please check the name
of your connection. You may select the subitem "Properties" by right clicking it.

Please check under "General" the bottom item "Internet Protocol - (TCP/IP)" in the window

"This Connection uses the following elements". You may click on the "Properties" button if

this entry is checked blue. Check here whether the IP-address of the data processor/network
interface card matches the IP-address of the gateway (here: 192.168.001.001).

Figure 41:
IP-address of
the data
processor or
rather the
network
interface card

3-34

Internet Protocal (TCP/IP) Properties E]EJ

General

“You can get IP settings assigned automatically if your netwark. supports
thiz capability. Othenwize, you need to ask your netwark. administrator far
the appropriate IF settings.

() Obtain an |P address automaticaly
(®) Use the follawing IP address:

1P address: 192 .1688. 1 . §
Subnet maszk: Edd 255 286 0

Default gateway:

(%) Use the follawing DMS server addresses:
Preferred DNS server:

Alternate DNS server:

The IP-address may be changed after you have selected the item "Use the following IP
address" or rather "Specify IP address".

Communication between the BL67 gateway and the data processor is possible if the digits of
the first three ranges match. In this example it is 192.168.001.
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For testing purposes you may directly write and read the process data within the PLC

Configuration range.

Please refer to the paragraph "Process image BLxx-2RFID-S-modules" page 3-43 for a
description of the complete process image.

Please assign variable names for single bits of the process image for fast location and
possibly for later programming. The input field opens by double-clicking on the respective bit.

1

Note

Please ensure that the online connection to your control is inactive. The "ONLINE"
mode is shown inactive at the right bottom of the window.

Flgu.re 42 4, CoDeSys - BL67-PG-EN_mit_5.pro - [PLC Configuration]

ASS’gnlng @ Fle Edit Project Insert Extras Online Window Help -8/
variable names EECEL e e

in the process = El--Configuration BLE7-PG-EN

image

{H PLC_PRG [PRG)

E

=

=)

El—BLE7-0[SLOT]
Et-- BLE7-2RFID-S
Bl AT %Q80: BYTE;

RESET_0 AT %QX0.0: BOOL: (*Bit0%)
XCVR_INFO_0 AT %0X0.1: BOOL; (* Bit17)
TAG_INFO_0 AT %QX0.2: BOOL; (* Bit2)
WRITE_0 AT %QX0.3: BOOL; {* Bit 37)
READ_0 AT %QX0.4: BOOL, (*Bit4 %)
TAG_ID_0 AT %QX0.5: BOOL; (*Bit5 %)
NEXT_0 AT %QX0.6: BOOL; (* Bit 6 %)
XCVR_0 AT %0X0.7: BOOL; (* Bit 77

AT %0B1: BYTE;

ByteCountd_0 AT %Q1.0: BOOL; (*Bit 0 %)
ByteCount_0 AT %Qi1.1; BOOL; (*Bit1%)
ByteCount2_0 AT %QX1.2: BOOL; (*Bit 2 %)
AT %0%1.3: BOOL; (* Bit37)

AT %QX1.4: BOOL; (* Bit4 ™)

AT %0X1.5: BOOL; (* Bit5 ")

AT %QX1.6: BOOL; (* Bit6 ™)

AT %QX1.7: BOOL; (* Bit 77)

AT %QB2: BYTE,

AddrHI_0_0 AT %QX2.0: BOOL, (* Bit0 %)
AddrHI_1_0 AT %QX2.1: BOOL, (* Bit1%)
AddrHi_2_0 AT %QX2.2: BOOL, (*Bit2%)

AddrH| LT %QX2.3. BOOL, (*Bit 3 %)

AT %QX2.4: BOOL, (*Bit4*)

Base parameters

Comment: |Bit3

"B PoU["E Data & visu | 5o Res. ]

]

[SHONE [GV [FEAD

Please switch to the "ONLINE" mode with online > login or él and start the program .

i
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Note

Please ensure that the online connection to your control is active and that the
program is running. The mode "ONLINE:BL67_PG_EN" and "RUNNING" is
highlighted black and displayed at the bottom right of the window.
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Command functions

Please test the different functions as described in detail in the paragraph "Meaning of the
command bits/control bits" page 3-47.

First, please activate the read/write head. An active read/write head creates an
electromagnetic field.

Figure 43 E---Confi tion BLET-PG-EN

Switching on onfiguration -P G- g
the read/write SRS E”:-E?-lO[SLOTI

head g BLET-2RFID-5

& AT %QB0: BYTE; = 128

--------- [CIRESET_0 AT %Qx0.0: BOOL; (* Bit 0 %)

--------- CIHCVR_INFO_O AT %QX0.1: BOOL; (* Bit 1 #)
--------- CITAG_INFO_O AT %QX0.2: BOOL; (* Bit 2 *)
--------- CIWRITE_D AT 9003 BOOL; (* Bit 3 %)

--------- [C|READ_O AT %Qx0.4: BOOL, (* Bit 4 %)

--------- CITAG_ID_0 AT %005 BOOL; (* Bit5*)

--------- CINEXT_0 AT %0X0.6: BOOL, (* Bit6 )

--------- B CVR_0 AT %00.7: BOOL, (* Bit 7 %)

Please execute a Write command:

Set the respective command bit (here: WRITE_0). Enter the number of the Byte -1
(ByteCount0_0 to ByteCount2_0) to be written (here: 8-1=7). The address on the data
carrier (AddrHi_0, AddrLo_0) may be left at "0" if need be; at the same time, please note
paragraph "Access to the data ranges of the data carriers." page 3-56.

Figure 44: _

Write errors, [l Ct:mﬂguratmn BLGET-PG-EN

number and E--BLE7-0[SLOT]

address on the & BLET-2RFID-S

data carrier - E--CMO_0 AT %QB0: BYTE; = 136

(example) e [JRESET_0 AT %Qx0.0: BOOL; (* Bit 0 %)

--------- (] HCVR_INFO_0 AT %0X0.1: BOOL; (* Bit1%)
--------- (] TAG_INFO_0 AT %0X0.2: BOOL; (* Bit 2 *)
--------- Il VRITE_O AT %GX0.3: BOOL; (* Bit 3 %)

--------- [JREAD_O AT %QX0.4: BOOL; (* Bit 4 %)

--------- (] TAG_ID_0 AT %00 5 BOOL; (* Bit5*)

--------- [CINEXT_0 AT %QX0.6: BOOL; (* Bit6 )

--------- Il CVR_D AT %QX0.7: BOOL; (* Bit 7 %)
El--ByteCount_0 AT %GB1: BYTE; =7

B §AEIEIrHi_D AT %0B2 BYTE, =0
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Write any data into the 8 bytes data range "WRITE_DATA".

Automation

Figure 45:
Write data
(example)

i}
L

Bl AT Qx40
[] AT %Qx4.1:

[] AT %Qx4.3:
[] AT %QK4.4:

] AT %QK4.6:
[] AT %QX4.7:

] AT %QX5.0:
Bl AT %051

[] AT %QX5.3:
[] AT %QX5.4:

] AT %QX5.6:
[] AT %QX5.7:

~WRITE_Data1_0 AT %QB4: BYTE; = 1

BOOL, (*BitD*)
BOOL, (*Bit17)

-BOOL; (*Bit2™)

BOOL, (*Bit37)
BOOL; (*Bit4*)

-BOOL; (*Bit5™)

BOOL, (*Bit6*)
BOOL, (*Bit7*)

RITE_Data2_0 AT %QB5: BYTE; =2

BOOL, (*BitD*)
BOOL, (*Bit17)

-BOOL; (*Bit2™)

BOOL, (*Bit37)
BOOL; (*Bit4*)

-BOOL; (*Bit5™)

BOOL, (*Bit6*)
BOOL, (*Bit7*)

= .i,m.r

RITE_Data3_0 AT %QB6: BYTE; = 2

].

Bl AT %QX6.0:
Bl AT %061

[] AT %QX6.3:
] AT %QX6.4:

] AT %QX6.6:
] AT %QX6.7:

BOOL, (*BitD*)
BOOL, (*Bit17)

-BOOL; (*Bit2™)

BOOL, (*Bit37)
BOOL; (*Bit4*)

-BOOL; (*Bit5™)

BOOL, (*Bit6*)
BOOL, (*Bit7*)

WRITE_Data5_0 AT %QBS8: BYTE; =5

=

=

BH--WRITE_DataG_0 AT %QB9: BYTE; = 6
BH--WRITE_Data7_0 AT %QB10: BYTE, =7
=

The following status messages indicate that the read/write head will execute the command
as soon as a data carrier is in the received range:

Figure 46:
Status message
after WRITE-
command

E--STAT_0 AT %IB0: BYTE; = 88

--------- [ AT 5slx0.0: BOOL; (* Bit 0 *)

--------- [JTFR_D AT %IX0.1: BOOL; (* Bit1#)

--------- [JTP_0 AT %1x0.2: BOOL, (*Bit 2 %)

B CVR_ON_D AT %IX0.3: BOOL, (*Bit 2 %)
--------- B < CVR_CON_0 AT %Ix0.4: BOOL, (* Bit4 *)
--------- [(JERROR_0 AT %Ix0.5: BOOL; (* Bit 5 %)
--------- W BUSY_0 AT %IX0.6: BOOL; (* Bit6 *)

--------- [CJDOME_D AT %IX0.7: BOOL, (* Bit 7 %)

When a data carrier is in the detection range of the read/write head and recognized by it, "TP"

becomes active (=1).

D101640 0109 - BL ident® CoDeSys
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Figure 47:
Data carrier in
received range

B--STAT_
- [] AT 9%I1X0.0: BOOL; (* Bit 0 %)

-] TFR_D AT %IX0.1: BOOL; (* Bit 1 %)

- [l TP_O AT %IX0.2: BOOL; (* Bit 27)

- [l XCVR_ON_0 AT %IX0.3: BOOL; (* Bit 3 %)

- [l XCVR_CON_0 AT %Ix0.4: BOOL; (* Bit 4 *)

- [_]ERROR_D AT %IX0.5: BOOL; (* Bit 5 %)

-] BUSY_D AT %IX0.6: BOOL; (* Bit 6 *)

-] DONE_0 AT %IX0.7: BOOL; (* Bit 7 %)

0 AT %IBO: BYTE,; = 28

When a data carrier is in the detection range of the read/write head, the user range of the data
carrier is automatically and fully read. During this process, TFR=0 and changes to TFR=1 after
the read operation is fully completed. Only after the detection range has been evacuated, TFR
again becomes "0". This automatic read operation is interrupted by all user commands; the
TFR-Bit keeps its active value. The process is restarted when no other commands exist and
when TP=1. Read commands can directly access already stored data via TFR=1.

A new command is only accepted when all remaining commands were reset to "0". DONE
switches to status "1" when the execution of the command is completed and a new command
can be acknowledged. When "ERROR" = 0, the command was successfully executed.

Figure 48:

The execution
ofthe command
was successful.

B STAT_0 AT %IB0: BYTE, =152

[ AT %6lx0.0: BOOL; (* Bit0 *)

[JTFR_0 AT %Ix0.1: BOOL; (* Bit 1%)
[JTP_0 AT %lx0.2: BOOL; (*Bit2 )

[l <CVR_ON_D AT %IX0.3: BOOL; (* Bit 3*)
[l KCVR_CON_0 AT %IX0.4: BOOL, (* Bit4*)
[[JERROR_0 AT %IX0.5: BOOL; {* Bit5 %)
[JBUSY_D AT %IX0.6: BOOL; (* Bit6 =)

[l DONE_0 AT %1X0.7: BOOL; (*Bit 7 )

Additional commands are executed accordingly.

Error messages

The message whether a command was executed successfully or erroneously is sent as soon

as the commands are reset to "0"

command can be acknowledged.

unsuccessful.

In case that the bit "ERROR" = 1,

. "DONE" = 1 indicates that execution has ended and a new
"ERROR" = 1 indicates that command execution was

you can receive more detailed information about the error

via the two "Error-byte" of the process input data. When "ERROR" = 0, the two data bytes are

irrelevant.

You may determine the cause of the error with the table

page 3-53. Change the binary value

or the decimal value into the respective hexadecimal value. The first byte corresponds to the
first bold digit in the error code table, the two following bold digits are reproduced by the

second byte.

3-38
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Figure 49: 5
ERROR-Byte 1 =--ERR_BYTE1_0 AT %IB1: BYTE; =@ —» 0x4

and 2 ofthe i e C]ERR_BITO_D AT %I[X1.0: BOOL; (* Bit 0 %)
process input i e [C]ERR_BIT1_0 AT %IX1.1: BOOL; (* Bit 1)
data i e B ERR_BIT2_0 AT %[X1.2: BOOL; (" Bit 2 %)
--------- C]ERR_BIT3_0 AT %I[X1.3: BOOL; (" Bit 37)
--------- C]ERR_BIT4_0 AT %I[X1.4: BOOL; (* Bit 4 7)
--------- C]ERR_BITS_0 AT %I[X15: BOOL; (* Bit 5 %)
--------- [C]ERR_BITE_D AT %I[X1 6 BOOL; (* Bit 6 %)
--------- C]ERR_BIT7_O AT %I[X17: BOOL; (" Bit 7 %)
E--ERR_BYTE2_0 AT %IB2: BYTE, =(128) — I 0x80
--------- [C]ERR_BITS_0 AT %[X2.0: BOOL; (* Bit 0 %)
--------- C]ERR_BITI_O AT %[X2 1: BOOL; (* Bit 1 7)
--------- CERR_BIT10_0 AT %[X2.2° BOOL: (" Bit2 ™)
--------- CERR_BIT11_0 AT %[X2.3: BOOL: (*Bit37)
--------- CERR_BIT12_0 AT %2 4 BOOL: (* Bit4 ™)
--------- CERR_BIT13_0 AT %IX2 5 BOOL: (* Bit57)
--------- CERR_BIT14_0 AT %[X2 6 BOOL: (* Bit6 ™)
--------- W ERR_BIT15_0 AT %IX27- BOOL: (* Bit 7 7)

Figure 50:
Mapping of DW#16#E4FEQTxx§ An error not closely specified was signalled by the cyclic
values 0x4 and status word (for example, antenna out of service). The error is
0x80 in the error independent of the current command.§

code table

BL ident ®specific error codes$§
DW#1 6#E@:E@<x§ No read/write head is connected.§
PW#16#E4FEB1xx§ The read/write head is defective.§

DW#16#E4FE84xx§ Telegram content invalid (for data carriers oftype TW-R22-HT-
B64). Range write protected or not existing.§

Resetting of error messages

With the "RESET"-Bit, the two ERROR-Byte can be deleted/reset. Deletion is done with the
falling edge (1->0) of the "RESET"-Bit.

Figure 51: . g ; s g ~
RESET- = ELE? 2RFID-3 - BLET-ZRFID-3

command El--CMO_0 AT %GB0: BYTE; = 129 B--CMD_0 AT %0QB0; BYTE; = 128

B RESET_0AT %Qx0.0: BOOL, (*Bit0*) | | o [ ]RESET_0 AT %Qx0.0: BOOL; (* Bit 0 %)

[ ]XCVR_INFO_0 AT %QX0.1: BOOL; (*Bit 1+ { | joe [ HCVR_INFO_0 AT %0X0.1: BOOL; (* Bit1%)
[ ] TAG_INFO_0 AT %QX0.2: BOOL; (*Bit2*) | | joe (] TAG_INFO_0 AT %QX0.2: BOOL; (* Bit2*)
~[JWRITE_D AT %0QX0.3: BOOL; (*Bit3*) | | [(JWRITE_D AT %Q0.2: BOOL; (* Bit2*)
~[JREAD_0 AT %QX0.4: BOOL; (*Bit4*) | | []READ_O AT %QX0.4: BOOL; (* Bit4 %)
~[CJTAG_ID_O AT %QX05: BOOL; (*Bit5*) | | - [ ]TAG_ID_0O AT %QX0.5: BOOL; (* Bit5*)
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Setting parameter values

In case that the error message "Dwell time of the data carrier in the detection range was not
sufficient for successful command processing." page 3-53 is received during startup, please
check whether your application supports "Compliance with Recommended Distances"
(Minimum Distances). The specification "Recommended" and "Maximum Distance" can be
found in the manual D101583 in the Chapter "Operating Data".

In case the recommended distances can not be adhered to, or in case the error indication
concerning the recommended distances continues due to external interferences, the

parameter "Bridging Time Kx[n*4ms]" must be set to a suitable value. For each port, the BLxx-
2RFID-S-module has the parameter "Bridging Time Kx[n*4ms]".

Parameterization is possible in the "OFFLINE" mode. For parameter setting, please select the
"Resources" tab and the subitem "PLC Configuration" from the menu in the left space of the
window. Check "BL67-IO[SLOT]" in the middle window and select the Input/Output tab in the
right window. In the list of selected modules, please check the BL67-2RFID-S module and
choose "Properties"”. You may directly enter a value in the window "Module Properties".

Please note the paragraph "Determination of the parameter value "Bridging Time Kx[n*4ms]""
page 3-51.

Figure 52: @
Setting e sl T
{ | B—Configuration BLE7-PG-EN ~
parameter 32, Ressourcan Bl 7oL oT E Basisp Ein-/Ausga Anwenderp
/ (3 Bibliothek BLodoSys lib 142 08 1417:02: Globale -
vaiues B3 Globale Variablen Mgy RewitesiSLO)
bex. Lange Input; 1024 Byte Lange Input;
@ Giobala Variablan Max. Lange Owfut: 1024 Bwte Lange Output
@ Verisblen_Konfiguration (VAR_CONFIG) d : i e
B (57 Tools 2 3 Maw, Langedh~/Output 2048 Biyte Lange In-/Qutaut
(B Alarmkanfiguration Max. Modulanzahl 34 Anzahl Madule:
Arbeitshi h e
2 Mbsitshersic = Eingabemodula Ausgewshita Madule
(i) Bibliotheksverwalter ST R
B Logbuch S——— z 2
: -80I-PD
(B PLC - Browser Moduleigenschaften
i tion 7-8D0-054F
MNarme: BLE7-2RFID-5
M T fzeich
%V\",:f;?iﬂzs‘;;“;p?wmaugr Config:  DxC3.01 7,01 7.0xCC, 078,001 e
## Zielsystermeinstellungen Eingabslangs (Byte) 24 7 Abbrechen
Ausgebeldnge (Byte): 24
Symbolische Mamen: 2
Eigenschaften
Parameter [ W, | Wertebereich | =
“bypass time K1 [n*4ms].” [l Unsigneds 0 0-255
“bypass time K2 [n*4ms]: 1] Unsigneds 0 0-255
[¢)
| Baustei I"ﬂ Daterty. |@V\sual\s IF@RESSDU r <
[ORLINE [05
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Diagnostics

All diagnostic messages are sent to the "Process input data" page 3-43 with 2 bytes error
code.

Three diagnostic messages ("Diagnostics" page 3-52) concerning the read/write head can
also be represented with the function "ilO_ReadModuleDiags" of the BLxxloSys.lib.

Please refer to the manual "BLxxloSys.lib — System Diagnostics" (D301114) for a description
of the functions concerning the system diagnostics.

Please activate the "POUs" tab for installing the function component. Please select the
"Offline" mode. Please open a new "Network (after)" by right-clicking the mouse in the right,
middle area of the window. Please click directly after the three red question marks and select
"Box" from the menu. Check "AND" (Default Component) and select input assistance with F2.
Select from the list under "loDiagnostic" the component "ilO_ReadModuleDiags".

Define the four variables of the component:

Figure 53: O001FROGRAN PLC_PRG
Definition of the oo0zlvar
variables 0003  iBitsize: INT:=32;
0004 RFID_Diag: ARRAY [0.3] OF BYTE;
0005 iModuleDiags: INT;
0006  ModulMi: INT = 0; (F0=RFID*)
D00F|END_VAR
The variables may be mapped via the input assistance (F2). A pointer is expected at "pbData".
Put the variable RFID_Diag in parentheses and write "ADR" in front of it.
Figure 54: 0004
Installing the
function

"ilO_ReadModu
leDiags"

iI0_ReadModuleDiags

ModulMr—ikodMo
ADRIRFID_Diag)—pbData
iBitSize—iLen

iModuleDiags;

With Online > Login or é| the "Online-Mode" is changed and the new program can be
loaded into the control. With Online > Run or , the program in your gateway is started.

Figure 55:

The function
"ilO_ReadModu
leDiags" when

il0_ReadModuleDiags
ModulMr=0-iModMo

iModuleDiags=4

erﬂilfg/onl’”e \DR(RFID_Diag)-|pbData
g iBitsize=32-JiLen
The "Diagnostics" page 3-52 are transferred into the variable RFID_Diag.
Figure 56: 00071 iBitSize = 32
Display of the 0002} £--RFID_Diag
variable 0003 :
RFID_Diag 0004
0005
D00A

0007  iModuleDiags = 4
0008  ModulNr=0
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Flow diagram for command execution

The values of the command Bits (TAG-ID, READ, WRITE...) can be reset to the output value
"0" prior or after command execution. The two following diagrams show the status messages
depending on the procedural sequence:

Figure 57:
Reset of the
command bit
after execution

command is done
CMD 0-»1 by transceiver

CMD 1-+0

Figure 58:
Reset of the CMD 01 CMD 1+0

command bit
prior to
execution

command isldone
by transceiver
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Process image BLxx-2RFID-S-modules
Process input data
Table 40: Bit
Input data
byte
7 6 5 4 3 2 1 (0]
Port 1
oV DONE BUSY ERROR XCVR_ XCVR_ TP TFR res.
CON ON
1 2 bytes Error Code LSB
("Alerts and error messages" page 3-53)
2 MSB
3 res. res. res. res. res. res. res. res.
4 8 bytes Read Data (READ_DATA)
5
6
7
8
9
10
11
Port 2
12 DONE BUSY ERROR XCVR_ XCVR_ TP TFR res.
CON ON
13 2 bytes Error Code LSB
("Alerts and error messages" page 3-53)
14 MSB
15 res. res. res. res. res. res. res. res.
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Table 40: Bit
Input data
byte
7 5 4 3 2 1 0
16 8 bytes Read Data (READ_DATA)
17
18
19
20
21
22
23
A Byte-Number
Meaning of the status bits
The following table provides the significance of the status bits of the process data indicated
above:
Table 41: Description Meaning
Meaning of
the status bits
DONE 1: The system does not process a command at this time and is ready to
receive another command.
0: All arriving commands, except the RESET-command, are ignored.
DONE only switches the status "1" when all command bits (READ,
WRITE...) are "0".
"Flow diagram for command execution" page 3-42
BUSY 1: The system is currently executing a command.
0: Command execution was completed.
BUSY is not the inversion of DONE and possibly can not be used with
a handshake-operation. Use the variable DONE to set up a handshake-
operation.
ERROR 1: An error has occurred during command execution. If this flag follows

3-44

a write command (WRITE), for example, the data of the send-buffer
were not written to the data carrier. If this flag follows a read command,
no data was read from the data carrier and no new data was stored in
the received data buffer. Details about the cause of the error is provided
via the 2 bytes error code of the process image.

Paragraph "Error messages" page 3-38 shows how the error code is
displayed in the CoDeSys and the reference to the error code table
"Status values" page 3-53.

0: It was possible to successfully execute the last Write or Read
command. The received data buffer contains valid data. The value of
the 2 bytes error code is irrelevant in this case.

D101640 0109 - BL ident® CoDeSys



Process image BLxx-2RFID-S-modules TWRCKK

Industrial
Automation
Table 41: Description Meaning
Meaning of
the status bits
XCVR_CON 1: The read/write head is correctly connected to the BL67-2RFID-S-

module.
0: The read/write head is not yet correctly connected to the BL67-
2RFID-S-module.

XCVR_ON 1: The transfer with 13.56 MHz from read/write head to data carrier is
active.
0: The transfer with 13.56 MHz from read/write head to data carrier is
not active.

TP 1: A data carrier is in the received range of the read/write head and is

(Tag Present) recognized by it.
0: There are no data carriers in the detection range of the read/write
head or the read/write head has not recognized the data carrier.

TFR 1: All data ranges of the data carrier were fully read from the BL ident ®-
(Tag Fully system, and the data carrier still remains within the detection range
Read) (TP=1). Automatic reading always occurs when a data carrier is within

the detection range of the read/write head. The time between TP=1 and
TFR=1 can not be seen as reference time for a read and write
command. If only few bytes are written or read with a read/write
command, the command is executed significantly faster than the time
it takes to fully read a 2000 bytes data carrier, for example. Read
commands can directly access already stored data with TFR=1.

0: The BL ident ®-system did not yet fully read all data ranges of the data
carrier or the data carrier is outside the detection range of the read/write
head.

This automatic read operation is interrupted by all user commands; the
TFR-Bit keeps its active value. The process is restarted if no other
commands exist and TP=1.

® Note

1 Depending on the system, the status bit "BUSY" can not be used for a handshake
operation in many cases!
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Process output data

Table 42: Bit
Output data
bytes
7 6 5 4 3 2 1 o
Port 1
o XCVR  NEXT TAG_ID READ WRITE TAG XCVR RESET
_INFO  _INFO
1 res. res. res. res. res. Byte Byte Byte
Count2 Countl  Count0
2 MSB AddrHi LSB
3 MSB AddrLo LSB
4 8 Byte Write Data (WRITE_DATA)
5
6
7
8
9
10
11
Port 2
12 XCVR  NEXT TAG_ID READ WRITE TAG XCVR RESET
_INFO  _INFO
13 res. res. res. res. res. Byte Byte Byte
Count2 Countl  Count0
14 MSB AddrHi LSB
15 MSB AddrLo LSB

16 8 Byte Write Data (WRITE_DATA)

17

18

19

20

21

22

23

A Byte-Number
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Meaning of the command bits/control bits

Note

L

1 If more than one command bit has been set via TAG_ID, READ, WRITE,
TRANSCEIVER_INFO or TAG_INFO, the BL67-2RFID-S-module will generate an
error message! The Bit "XCVR" must always be set to execute a command so that
the read/write head remains active!

The following table provides the meaning of the command bits of the process output data

listed above:

Table 43: Description
Meaning of

the command

bits

Meaning

XCVR

1: The read/write head is activated. An active read/write head creates
an electromagnetic field (for example, the signal is transferred with
13.56 MHz).

0: The read/write head is deactivated (a signal check is not done).
When XCVR = 0 is set during the time the BL ident ®-system is occupied
with executing a command, the command is completed first. The read/
write head is only deactivated when the Status-Bit is "DONE = 1".

NEXT

1: Exactly one command can be executed with the same data carrier. If
another command is initiated with the same data carrier, the status bit
remains "BUSY=1". The BL ident ®-system must be reset (RESET) or
the command must be executed with a different data carrier.

0: Function is not used.

TAG_ID

0 -> 1: The command to read the UID is initiated with the increasing
edge. The command is executed when a data carrier is within the
detection range of the read/write head. ("UID" page 6-4)

0: Function is not used.

READ

0 -> 1: The command to read is initiated with the increasing edge. The
command is executed when a data carrier is within the detection range
of the read/write head.

The Byte number "ByteCount0..ByteCount2" is read from the data
carrier address "AddrLo, AddrHi".

0: Function is not used.

WRITE

D101640 0109 - BL ident® CoDeSys

0 -> 1: The command to write is initiated with the increasing edge. The
command is executed when a data carrier is within the detection range
of the read/write head.

The Byte number "ByteCount0..ByteCount2" is written to the data
carrier address "AddrLo, AddrHi".

0: Function is not used.
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Table 43: Description Meaning
Meaning of
the command
bits
TAG_INFO 0 -> 1: The command TAG_INFO (information for data carrier) is initiated

with the increasing edge. The command is executed when a data carrier
is within the detection range of the read/write head.

Together with the process input data the information about the data
carrier is sent in the range read data with the following 8 bytes:

Byte 0: Number of Block-1 of the data carrier (this means 27 ->

28 Blocks)

Byte 1: Number of bytes-1 per block (this means 3 -> 4 bytes per block)
Byte 2: Is not supported (DSFID-data carrier format)

Byte 3: Is not supported (AFI - Application Identification)

Byte 4: Is not supported (ICID - IC-identification (is not supported)
Byte 5 to Byte 7: ,,0"

0: Function is not used.

—_

TRANSCEIVER 0 -> 1: The command TRANSCEIVER_INFO (information to read/write

_INFO head) is initiated with the increasing edge and executed.
Together with the process input data the information about the read/
write head is sent in the range read data with 8 bytes.
The content of the information can be configured. The content of the
information is selected with "AddrHi, AddrLo".
0x00FO:
The first 8 bytes of the ORDER_ID (here: product description) are sent,
for example "TNER-Q80" = 0x54 4E 45 52 2D 51 38 30 (ASCII-Table)
0x00FO:
The second 8 bytes of the ORDER_ID (here: product description) are
sent, for example: "-H1147\0\0" = 0x2D 48 31 31 34 37 5C 00 5C 00
0x00F2:
The third 8 bytes of the ORDER_ID (here: product description) are sent.
0x00F3:
The fourth 8 bytes of the ORDER_ID (here: product description) are
sent.
0x00F4:
The hardware- and firmware versions of the read/write head are sent.
Byte 0: Part x of the hardware version x.y.
Byte 1: Part y of the hardware version x.y.
Byte 2: Letter V = 0x56 of the firmware version Vx.y.z.
Byte 3: Part x of the firmware version Vx.y.z.
Byte 4: Part y of the firmware version Vx.y.z.
Byte 5: Part z of the firmware version Vx.y.z.
Byte 6 to Byte 7: is not used.

RESET 0 -> 1: A "Reset" of the BL ident ®-system is executed with the
increasing edge. When the status bit "BUSY" is set, the execution of the
active command is interrupted and the status bit "DONE" is set. The
status bit "ERROR" and the two byte error message (error code) of the
process input data are deleted.

ByteCount0..2 Number of Byte-1 that still need to be read (READ) or written (WRITE).
0x007 -> 8 byte still need to be read/written.
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Table 43: Description Meaning
Meaning of
the command
bits

AddrHi, AddrLo  Array of the length 2 bytes. Repeats the start address of the memory
range in the data carrier which is to be accessed via the Write or Read
command.

The writable/readable start addresses of the data carriers can be # 0.
Paragraph "User data ranges of the data carrier versions." page 3-56
contains information concerning the writable/readable start addresses
and data carrier versions.

WRITE_DATA Write data - array of the length 8 bytes.
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Parameter

At this time only the parameter "Bridging Time K1[n*4ms]" and "Bridging Time K2[n*4ms]" are
transferred with the 8 bytes parameter data image.

Table 44:
Parameter
data byte

3-50

Bit
7 6 5 4 3 2 1 (0]

oY  reserved

1

2

3

4

5 "Bridging Time K1[n*4ms]"

6 reserved

7 "Bridging Time K2[n*4ms]"

A Byte-Number

Keep the default setting "=0" of this parameter when the startup occurred without the error
message "Dwell time of the data carrier in the detection range was not sufficient for
successful command processing." page 3-53.

If the error message "Dwell time of the data carrier in the detection range was not sufficient
for successful command processing." page 3-53 appears, check whether your application
supports "Compliance with Recommended Distances (Minimum Distances), a decrease of
the speed or the data volume. Please refer to the manual D101583, Chapter "Operating Data"
for the specification "Recommended and Maximum Distances".

In case the recommended distances can not be adhered to or in case the error with the
recommended distances continues to be sent based on external influences, the parameter
"Bridging Time Kx[n*4ms]" must be set to a suitable value.
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Determination of the parameter value "Bridging Time Kx[n*4ms]"

The parameter "Bridging Time Kx[n*4ms]" is the result of the used components, the
distances, the speed of the data carrier to the read/write head and other external
interferences.

Therefore measure all needed bridging times directly on location. The following diagram
shows the typical run of the detection range:

Figure 59:
Detection range 35
of a read/write 30
head A
25 \
20
IS
\
c
10
5

0
BO 5 10 15 20 25 30
mm

A Distance bridged by the data carrier when passing by the read/write head
B Center of the read/write head
C Section of the distance that needs to be bridged.

For the section "C" in the above diagram the data carrier must use maximum the "Bridging
Time K1[n*4ms]". The data carrier must be within the detection range before the bridging time
elapses so that the transfer can continue.

Additional diagrams for the detection ranges of different read/write heads and data carriers
are shown in the manual D101583 in the Chapter "Overtravel Ranges".

The LEDs of the read/write head or rather the status bit "TP" of the process input data indicate
if the data carrier is within the detection range or not.
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Diagnostics

There are three diagnostics for read/write head with 2 bytes for each port. These diagnostics
are also displayed with the ERROR-Byte of the process input data.

Table 45: Bit
Diagnostic
Bytes 7 6 5 4 3 2 1 (o]
Port 1
oM TR_PS_OVL
1 TR_PS_ERR TR_HW_ERR
Port 2
2 TR_PS_OVL
3 TR_PS_ERR TR_HW_ERR
Table 46: Description Meaning
Meaning of
the diagnostic
bits
TR_PS_OVL The voltage supply of the read/write head was switched off because of
over-current ("DW#16#E4FEQ1xx" page 3-53).
TR_HW_ERR A hardware error of the read/write head exists ("DW#16#E4FE81 xx"
page 3-53).
TR_PS_ERR The voltage supply of the read/write head is not in the required range
("DW#16#E4FE88xx" page 3-53).
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The following table provides information in regards to the meaning of some STATUS values:

Table 47:
Status values

Status value of
CHX_STATUS

Meaning of the error code

RFID standard profile

DW#16#E1FEO01xx Data carrier memory error (for example, CRC error).

DW#16#E1FE02xx Dwell time of the data carrier in the detection range was not
sufficient for successful command processing.

DW#16#E1FE03xx The indicated address range or command does not match the
used data carrier type.

DW#16#E1FE04xx Data carrier is defective and must be replaced.

DW#16#E1FE08xx Data carrier in the transfer range does not have the expected
uID.

DW#16#E1FE09xx Data carrier does not support the current command.

DW#16#E1FEOAXx At least one section of the defined data carrier range is write
protected.

DW#16#E4FE01xx Supply of the read/write head was switched off because of the
increased current consumption, for example short circuit.

DW#16#E4FE03xx Antenna or rather transmitter of the read/write head is
switched off. Execution of the service "Write-Config" is
needed ("Write Config" page 5-25, Seite 3-14).

DW#16#E4FE05xx The requested data volume exceeds the capacity of the
internal memory.

DW#16#E4FEQ06xx A parameter of the current command is not supported.

DW#16#E4FEQ7xx An error not closely specified was signalled by the cyclic

status word (for example, antenna out of service). The error is
independent of the current command.

BL ident ®specific error codes

DW#16#E4FE80xx No read/write head is connected.

DW#16#E4FE81xx The read/write head is defective.

DW#16#E4FE84xx Telegram content invalid (for data carriers of type TW-R22-HT-
B64). Range write protected or not existing.

DW#16#E4FE88xx The read/write head is insufficiently fed.

DW#16#E4FE89xx The read/write head signals permanent CRC error on the
RS485 cable. EMC problem?

DW#16#E4FE8Axx The Ident Unit signals permanent CRC error on the RS485

cable. EMC problem?
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Table 47:
(cont.)
Status values

3-54

Status value of
CHX_STATUS

Meaning of the error code

DW#16#E4FE90xx

The read/write head does not recognize a command sent via
GET.

RFID standard profile

DW#16#E5FE01xx The Ident Unit signals a false sequence number (SN).

DW#16#E5FE02xx The PIB FB signals a false sequence number.

DW#16#E5FEQ04xx The Ident Unit signals an invalid data block number.

DW#16#ESFE05xx The PIB FB signals an invalid data block number.

DW#16#E5FEQ7xx The PIB FB signals an invalid data block length.

DW#16#E5FE09xx The Ident Unit completes a hardware reset (Init_Active is set to
“1"), Init (Bit 15 within the cyclic "Control Word") is expected
by the PIB.

DW#16#E5FEOAXX The command code "CMD" and the respective received
confirmation do not match. This involves a software or
synchronization error here which must not occur in normal
operation mode.

DW#16#E5FE0BxXx The sequence of the telegrams to acknowledge received is
wrong.

DW#16#E5FEQCXx Synchronization error
(Step width of AC_H/AC_L and CC_H/CC_L in the cyclical
"Control Word" is wrong). Initialization must be completed
anew.

DW#16#E6FEO01xx Invalid command

DW#16#E6FE02xx The Ident Unit signals an invalid command index.

DW#16#E6FE05xx The Ident Unit signals that only Write commands (Write-

Config) are permitted at this time.

BL ident ®specific error codes

DW#16#E6FE80xx

No prior data carrier recognized, no UID stored (at Next).

DW#16#E6FEFFxx

Unknown error

RFID standard profile

DW#16#E7FEQ01xx Only INIT command is permitted in this state (signalled by the
PIB).
DW#16#E7FE02xx CMDSEL > CMDDIM or command code "CMD" not permitted.
DW#16#E7FEQ03xx The PIB signals:
Parameter "Length" of the command is too long for the global
data range which is reserved within the TXBUF.
DW#16#E7FE04xx RXBUF overflow (more data has been received than can be

saved in the RXBUF memory).
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Table 47: Status value of Meaning of the error code
(cont.) CHX_STATUS
Status values
DW#16#E7FE05xx The next command must be an "INIT" command in all cases.
All other commands will be rejected.
DW#16#E7FE06xX The index is outside the range 111/112 (101 to 108) and
therefore wrong.
DW#16#E7FEQ7xx BLxx-2RFID-y does not respond to the INIT command. Check
that the correct ID is set!
DW#16#E7FE08xx Timeout during initialization.
DW#16#E7FEQ09xx A repeat of the command is not supported by the PIB*.
DW#16#E7FEQAXX Error in the PIB during the determination of the data packet
size.
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User data ranges of the data carrier versions.

Access to the data ranges of the data carriers.

In the case that a different data carrier is used than indicated in "Hardware description of the
example project" page 3-3, or in case you want to access certain ranges of the data carrier,
you must change the value "Start Address" in the command structure of the example project.

Y Note

1 Please ensure that the online connection to your control is not active. The "ONLINE"
mode at the bottom right of the window is not highlighted.

For this open the program PRG_PibCommands (PRG) in the file folder "Components". Here,
you may locate the default settings for the commands "Physical_ Read" page 5-23 and
"Physical_Write" page 5-24.

The "Start Byte Number" matches the "Start Address". Please pay attention to the following
paragraph when assignment is completed.

Figure 60:
Changing the
start byte
number

3-56

< CoDeSys - BL_ID_PG_EN_CoDeSys. pro™

File Edit Project Insert Extras ©Online Window Help
Bl E| B|@]elm(E S % (5]
2 POUs 4 PRG_PibCommands (PRG-5T)

Modbus_Comm (PRG) | PROGRAM PRG PihCommands
@ PLC_FRG [PRG) 00449 Ch_0_EXECUTE =TRUE;
PRE_PibCammands [PFiG] WHED) END_IF

0051
0052 Caommand 4: Physical-Read: reads user data ofthe TAG )
0053)IF PhysicalRead THEM

0054 Ch_0_CMDREF[4].CMD = 16#70
Q054 Ch_0_CMDREF[4].StartAddress = 4,
0056 _ ].Length =12;
0057 * If command Physical-Read has been executed successfully we will find the data in the Receive-Buffel
0058, Ch_0_CMDSEL =4,

noss) Ch_0_IMIT = FALSE;

Qo&D) Ch_0_EXECUTE = TRLE,

Q061 EMD_IF

0063
0063 Cammand 5 Physical-write: writes user data to the TAG  #)

0064 IF Physicalrite THEM

Q0G5 Ch_0_CMDREF[S].CMD = 16#71;

o066 (Ch_0_CMDREF[S] StartAddress = 8“

Q0&7] Ch__t F[5].Lenath :=12;

O0ES] (* Farthe command Physical-Write we have to enter the write data in to the Transmit-Buffer *
0069 Ch_0_THREF[1] = 16#A8,

0o7o) Ch_0_THREF[2] = 16#BB,

o7 Ch_0_THREF[3] = 163#CC,

0073 Ch_0_THREF[4] = 163DD,

0073 Ch_0_T#REF[a] = 16#EE,

007 4 Ch_0_THREF[E] = 163FF,;

0074 Ch_0_THREF[T] =T,

Q07 Ch_0_THREF[8] =&, *

&3]

Hibliothek 'CAProgrammel3s SoftwarelCoDeSys W2 3LibrandlUtilLlib'
Hibliothek tiprogrammet3s softwarelcodesys v2 3targetaiturckibledBLed oSy lik'
Pibliothek 'CAProgrammelds SoftwarelCoDeSys W2 3librandStandard.lik'

IEA T EN E R |

[ [Lir.: BB, T
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Starting at byte number 0 to byte number 111 , the data carriers of type I-Code SL2 are

writable and readable.

The "Start byte number" is part of the command structure "Physical_ Read" page 5-23 and
"Physical_Write" page 5-24, and there it is designated as "Start Address".

The table describes the data structure of the data carrier:

TW-114-B128
TW-L43-43-F-B128
TW-L82-49-P-B128
TW-R16-B128
TW-R20-B128
TW-R30-B128
TW-R50-B128
TW-R50-90-HT-B128

Table 48:
Data structure
of the I-Code
SL2 data
carriers

Byte number Content Access Block number
(StartAddress) (a block consists
of 4 bytes)
-16to -9 uiD Read only via -4 to -3
"Inventory" page
5-28
-8to-5 Information about Read only via -2
the data carrier special commands
-4 to -1 Conditions for write -1
access
Oto 111 User data range Read / write via 0to 27

"Physical_ Read"
page 5-23 and
"Physical_Write"
page 5-24

Starting at byte number 18 to byte number 63, the data carriers of type I-Code SL1 are

writable and readable.

The "Start byte number" is part of the command structure "Physical_ Read" page 5-23 and
"Physical_Write" page 5-24, and there it is designated as "Start Address".

The table describes the data structure of the data carriers:

TW-R16-B64
TW-R22-HT-B64
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Table 49: Byte number Content Access Block number

Datastructure  (StartAddress)

of I-Code SL1 (a block consists

data carriers of 4 bytes)
Oto7 uiD Read only via Oto1
“Inventory" page
5-28
8to 11 Conditions for Read only via 2
write access special command
12to 15 Special functions Read / write via 3/4
(for example, EAS  special
/ QUIET) commands
16 family code
17 application
identifier
18 to 63 User data range Read / write via 4/5 to 15

"Physical_ Read"
page 5-23 and
"Physical_Write"
page 5-24

Starting at byte number 0 to byte number 1999, the data carriers of type FRAM are writable
and readable.

The "Start byte number" is part of the command structure "Physical_ Read" page 5-23 and
"Physical_Write" page 5-24, and there it is designated as "Start Address".

The table describes the data structure of the data carriers:
TW-R20-K2
TW-R30-K2
TW-R50-K2
TW-R50-90-HT-K2

Table 50: Byte number Content Access Block number
Data struct
of :zes [-L,_i\,%\lﬂre (StartAddress) (a block consists
data carriers of 8 bytes)
0 to 1999 User data range Read / write via 0 to 249
"Physical_ Read"
page 5-23 and
"Physical_Write"
page 5-24
2000 to 2007 uiD Read only via 250
“Inventory" page
5-28
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Table 50: Byte number

Datastructure  (StartAddress)
of the FRAM

data carriers

Industrial
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Content Access Block number
(a block consists
of 8 bytes)
2008 to 2015 AFI|, DSFID, EAS Read / write (with 251
limitations) via a
special command
2016 to 2047 Special functions Read only via a 252 to 255

(for example, EAS
/ QUIET)

special command
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4 Installation of the control interface
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Modbus-TCP master

The following description is based on the prerequisite that an initial startup of the BL ident ®
system was completed with the programming software CoDeSys from the company "3S".
The previous chapter contains instructions.

Installation of the interface with BLxx-2RFID-A-modules
The following paragraphs describe the procedural method for the transfer of 1 byte Tag-data:
from the Receive-buffer of the PIB function block to a Modbus-TCP-master of a HMI-PLC.

from a Modbus-TCP-master of a HMI-PLC to the Transmit-buffer of the PIB function
block.

Variable names for the Modbus-TCP-register

After startup of the BL ident ®-system, open the tab Resources with the programming
software CoDeSys and select the array "PLC Configuration".

P Note

1

Please ensure that the online connection to your control is not active. The mode
“ONLINE” at the bottom right of the window is not highlighted.

In the middle of the window of the control configuration you may open the tab for the
configuration of the Modbus-TCP-registers by double-clicking on "Modbus-Registers
[SLOT]". Open the tab Input/Output.

Under "Input Modules" select an "Input Register", and under "Output Modules" an "Output
Register".

Now assign the variable names to both selected registers in the middle window:
Double-click on "AT %IW2:WORD" to open the input field and enter "I_Register_0".
Double-click on "AT %QW2:WORD" to open the input field and enter "O_Register_0".

Flgure 61: 4, CoDeSys - BL_ID_PG_EN.pro - [PLC Configuration]
Modbus-TCP- ([ Be Edt Project Insert Extras Qnine Window Help o | e
register N e e e
F_HR— B--Configuration BLE7-PG-EN A i‘
esources : A InputfOutput | User parameters
E--BLET-I0[SLD Base parameters  Inp p p
B Global Varisbles ? _____ EII[_E? ;{FID " I
Eg] I_\rbra‘ry BledoSys.lib 18.1. E| dbus Registers[5L0T] Max. length of input data: 4096 Byte Length of input date
..... Af:rri configuration - Inpul Register Max length of output data 4086 Byte Length of output ds
..... i Library Manager B-|_Register_0 AT %IW2: WORD; = length of m—;‘mul data 4036 E&e . Length of in-/outpu
""" B Log Output Register %ax number of m deuSaﬂEC 'reg|stemumb9fﬂfmﬂdu|9
..... FLC-B Wi
_____ = PLC I,.‘_Im_”_‘ G:Regisiee O ARGUWZNORD; = Input Modules Selected Module
..... Q Salng r Input Register Input Registe
..... ﬁTargetSemngs 2 Input Registers Cutput Regis
""" @Task configuration ;:npu: Qegls:ers
""" Q Watch- and Recipe Mang nRputHeglsiers
""" 32 wWorkspace 16 Input Registers
32 Input Registers c
B4 Input Registers
+ Output Modules
v
¢ > ~|
< >
| [GHLINE [0V [FEAD
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Program expansion
Open the tab POUs, select the main PLC_PRG (PRG) and expand it as described below:

Right-click on the component "Add Object..." and make a selection. Accept the entries of the
following diagram:

Figure 62:
Entries for the MNew POL
new component

X
Mame of the new POLU: |h-1|:u:|bu$_I:-:umm |:I

Type of POL Language of the POL Cancel
f* Program L
" Function Block " LD
" Function " FBD
Beturn Type: " SFC
|| s
i CFC

Open the newly created component Modbus_Comm. This new component is to execute the
following tasks:

Data of the register "|_Register_0" is to be transferred to the Send-buffer CH_0_TXREF.
Data of the Receive-buffer CH_0_RXREF is to be transferred to register "O_Register_0".

Send-buffer CH_0_TXREF and Receive-buffer CH_0_RXREF are "byte" type arrays and
belong to the global variables of the PIB-component ("The function block PIB_001KB" page
3-9).

Modbus-TCP-registers are "Word" type registers. The functions WORD_TO_BYTE and
BYTE_TO_WORD adopt the appropriate format.

Take the instructions in the following diagram:

Figure 63: —
Instruction text 4. CoDeSys - BL_ID_PG_EN.pro* - [Modbus_Comm (PRG-ST)] Q“EBJ
ﬂ File Edit Project Insert Extras Online Window Help -

Dl El@e DG » |5 e|m|H

0001PROGRAN Modbus_Comm
0002|v2R
Carmm (PRG) 0003END_VAR

B
PLC_PRG [PRG)
+ 2 PRG_PibCommands (PR

2

Now select "Project > Build". In case of a typing error, you will receive an error message in
the subjacent message field.
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In the opened main program PLC_PRG (PRG), you will receive a new component (alternatively
with drag and drop via ﬂ) via insert > box. Add it next to the component PIB_001KB. The
component will receive a sequential number and by default, "AND" is assigned to it.

Check "AND". The input mask for the component is opened via the shortcut "F2". Select
"User defined Programs" from the list in the left space of the window. Check the
"Modbus_Comm" program defined above and acknowledge with OK.

Figure 64: oDeSys - BL_ID_PG_EN 0® - [PLC_PRG (PRG-CFC)]
Inserting the % Project Insert Extras Onlin ow b
newcomponent _Bl=|8| B|@|edE5S|SAR] 3 lR|RmiE o - =|=|8]elm)e]=]d 5= @)sle] k)]

D001[FROGRAM PLC_FRG ~
Modbus_Comm  r=so; E‘ E .\ e
into the master Madbus_Comm PRG] =[] 2 et et B T P S &
program L4 =) FR_FEConmands [FRE) NDEX ‘BusY Th o 6UEY 5
PLC PRG. | 0 [OFFEET ERROR Ch_0_ERROR =

—RFTCMD WHARNING

—SRESET RPTACT]|
Ch_0_INIT INIT ERR_IREQ
uouTa TFC

Input assistant

10
Ch_0_CMDSEL

| User defined Proiams
Conversion Operatars

200 — atﬂﬂddﬂfg FI.;I’];:[IUI’]S_ {3 User defined Programs IL]
1 | |User defined Functions :
200 || Standard Function Blocks Mobus_omm[F‘HG] Cancel
User defined Function Bloc izl PLC_PRG (FAG)
—1 |FED Operatars £
| (B %E] PRE_PibCommands (FRE)

1
Ch_0_CMDREF
Ch_0_THREF
Ch_0_RXREF

<

||

Loading library ‘siprogrammet3ds softw.
Loading library "S\Programmel35 Soflw v Stnuctured 3
- Loading library ‘ciprogrammends softw:
EAETN =N ET < |

I AaraE [Aw [BEam

In the Online mode (Online > Login or %‘ ) download the expanded program into the
programmable gateway and start it ( )!

Configuration of the Modbus-TCP-interface in the control software

Open the visualization software "Galileo" and if need be, create a new project. In the first step
you are asked to select the type of your control from the list:

Figure 65:
Device type of
the control Panel Type

Panel Type

Colors

256 hd

Resolution Format
#-Resolution: & Landzcape

‘-Resolution: " Partrait
Ok, | Cancel
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In the second step select the PLC-type. Via the button "Add" the window "Select PLC "
opens. Open the pull-down menu for type, select "Modbus TCP" and acknowledge with OK.

Figure 66:

PLC selection
Fi / Madel | infa | PLC Data

Communication

Board Type Comm... | Model

M Select Communication

Port:

Modbus TCP
Ethernet hd

Description: |

Cancel

ok |

Cancel |

On the tab "Firm / Model" you may indicate, next to other configurations, the IP-address of
your gateway "BL67-PG-EN" (here: 192.168.1.1 "Setting of the IP-addresses for Ethernet
communication" page 3-6). The port number of the Modbus-TCP-port is 502, the "Address

Offset" is "0".
Figure 67:
Configuration of Select PLC E]
the Modbus- -
connection Firm / Model l Info ] PLC Data ] hemom Alignment ]
Communication
Mo, | Part Board Type Comm... | kodel
0 Ethernet Modbus TCP
< ! E
Add R emowe kA iy keta Data
Status Refresh [z]: 10
break[ms]: 0
Startup Delay[=]: 5
Default Uit |dentifier: o
IP Addresz or Hoztname: 192.168.1.1|
Addrezs Offzet: ]
Port Number: a0z
Little/Big Endian Mode Big Endian
(] 4 LCancel Help
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Variables for the Modbus-TCP-registers

Define two "Word" type variables for the Modbus-TCP-communication. For this open the tab
"Tags". By right-clicking the mouse on "Word" you may select "New", and then enter the
name of your new variable. Define one variable with the name "O_Register0", and one with
the name "I_Register0".

For communication, Modbus-TCP provides certain register ranges:
0x4000 to 0x43FF for input data
0x4400 to 0x47FF for output data

Table 51:
Modbus-
TCP-register
ranges

4-6

HEX DEC Modicon
Inputs Packed 0x0000 0 400001
to
Ox01FF 511 400512
Outputs Packed 0x0800 2048 402049
to
O0x09FF 2559 402560
Gateway identification 0x1000 4096 404097
to
0x1006 4102 404103
Gateway status 0x100C 4108 404109
Process image length in bits of the 0x1010 4112 404113
intelligent output modules
Process image length in bits of the 0x1011 4113 404114
intelligent input modules
Process image length in bits of the digital 0x1012 4114 404115
output modules
Process image length in bits of the digital 0x1013 4115 404116
input modules
Register-Mapping-Revision 0x1017 4119 404120

etc.

Please refer to the user manual BL67-PG-EN (D301032) for an overview of all Modbus-TCP-
register ranges.

Double-click on O_Register0 to open the tab Variable Definitions for this variable. Open the
tab "Address" and enter the first address from the range of the output data "17408" (0x4400).

Double-click on I_Register0 to open the tab Variable Definitions for this variable. Open the tab
"Address" and enter the first address from the range of the input data "16384" (0x4400).
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Figure 68: " : A——
Register- ag Properties: | _Register
address entry Format  Address | Limits I Units I
— Fead [PLC -» kbdl) Wirite (Ml -> PLC)
¥ OnDemand V¥ OnDemand
¥ &t Startup [~ At Startup
v Paolling Ifast LI IEI zeC,
Jzed Address Link Mame Description
yes RG34 -] Madhus TCP

M Setting address

R%d ;I

0..65535 @

H elp

R16354

Clear Address | Cancel | I

If the value "46" is now mapped to the register |_Register0 (16384), this value is written into
the Transmit Buffer 1 via the newly created interface. With the next write command, this value

is written to a physically present Tag.
The value from the Receive -buffer 1 is transferred to Register O_Register0 (17408) via the
newly created interface.
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Figure 69:
PLC_VISU with
1 byte data of
Register 17408
and 1 byte data
for Register
16384

4-8

—

= PLC_VISU

( Write Config - INIT | O ‘ DONE ‘

[ Write Config - T ON ] O ‘

BUSY |

[ Write Config T OFF ]

O [ err |

[ Inventory ]

[ Phy=sical Read ] O ‘ TP ‘

[ Physical Write l ‘ Status : 0 ‘

[ Mem Status ] O ‘

INIT |

[ Dew Status ]

— O [ eeoE |
Transmit Buffer 1 66) Receive Buffer 1 [@EED)
Transmit Buffer 2 0 Receive Buffer 2 a
Transmit Buffer 3 o] Receive Buffer 3 Q
Transmit Buffer 4 o] Receive Buffer 4 a
Transmit Buffer 5 o] Receive Buffer 5 1]
Transmit Buffer 6 0 Receive Buffer 6 a
Transmit Buffer 7 o] Receive Buffer 7 Q
Transmit Buffer & o] Receive Buffer 8 a
Transmit Buffer 9 o] Receive Buffer 9 1]
Transmit Buffer 10 0 Receive Buffer 10 a
Transmit Buffer 11 o] Receive Buffer 11 Q
Transmit Buffer 12 o] Receive Buffer 12 a

Note

Please pay attention to the LED display on the gateway housing!

Communication via the newly created interface is only possible when the expanded
program runs on the gateway (RUN/STOP: green) and when Ethernet-
communication is active (LNK/ACT: not OFF). Please refer to the user manual
"BL67-PG-EN (D301033)" for the complete description of LED-diagnostics.
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Installation of the interface with BLxx-2RFID-S-modules

The following paragraphs describe the procedural method for transferring 1 byte Tag-data:
of the variables READ_Data1_0 to a Modbus-TCP-master of a HMI-SPS.
from a Modbus-TCP-master of a HMI-PLC to the variable WRITE_Data1_0.

Variable names for the Modbus-TCP-registers

After startup of the BL ident ®-system, open the tab Resources with the programming
software CoDeSys and select the array "PLC Configuration".

® Note

1 Please ensure that the online connection to your control is not active. The mode
“ONLINE” at the bottom right of the window is not highlighted.

In the middle of the window of the control configuration you may open the tab for configuring

the Modbus-TCP-registers by double-clicking "Modbus-Registers [SLOT]". Open the tab
"Input/Output".

Under "Input Modules" select an "Input Register”, and under "Output Modules" an "Output
Register".

Now assign the variable names to both selected registers in the middle window:
Double-click on "AT %IW2:WORD" to open the input field and enter "I_Register_0".
Double-click on "AT %QW2:WORD" to open the input field and enter "O_Register_0".

Figure 70:
Modbus-TCP-
register s
4. CoDeSys - BL_ID_PG_EN_5.pro - [PLC Configuration] Qu@
EB File Edit Project Insert Extras Online Window Help -
2| E| BlEledE|S(ElH Hlw
%P{ B--Configuration BLE7-PG-EN ~ A
o 87- Base parameters InpufOutput | User parameters
B2 Global Variables i . SO P |user |
. B z -
E - I_\rbra‘ry Babe i 3 E--ilo: | Max. length of input data: 096 Byte Length of input data:
A;D,; configuration B Input Register Max. length of output data: 4096 Byte Length of output data:
Fut
(i) Library Manager 1_Register_0 AT %IW12: WORD; Max. length of in-/output dR?l dﬁ E§e Length of |£féult’putd
HLog B Output Register Max. number of modules: (0] u _TC P_ngLSI ules:
FLC-B \
F-‘Ll' rr.m—m 0_Register_0 AT %QW12: WORD, = Top Moo T
QSE\IH Tioce Input Register Input Register
ﬁTargpet Sgettimgs 2 Input Registers Qutput Register
[ Task configuration ; :npu: §E9fﬁ:era
@, Watch- and Riecipe Mang pputHegisias
32 Workspacs 16 Input Registers
32 Input Registers
B4 Input Registers
# Output Modules
v
s B =]
T
‘ [ONLINE [0V [FEAD

Program expansion

Open the tab POUs, select the main PLC_PRG (PRG) and expand it as described below:
Right-click on "POUs" and select "Add Object...". Accept the entries in the following diagram:
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Figure 71:
Entries for a
new component

New POU

Type of POU

(@ Program

( Function Block

 Function
Beturn Type:

Mame of the new POU

liJ @ ST

|Mudbu57Cumm
Language of the POU Cancel

C L

¢ LD
¢ FBD
¢ SFC

¢ CFC

Open the newly created component Modbus_Comm. This new component is to execute the

following tasks:

Data of the register "I_Register_0" is to be transferred to the variable "WRITE_Data1_0".
The description "WRITE_Data1_0" was selected here for Byte 4 of the process output data
("Process output data" page 3-46).

The data of the variable READ_Data1_0 are to be transferred to the register
"O_Register_0". The description "WRITE_Data1_0" was selected here for Byte 4 of the
process input data ("Process input data" page 3-43).

The variables READ_Data1_0 and WRITE_Data1_0 are "byte" type variables and belong to the

global variables.

Modbus-TCP-registers are "Word" type registers. The functions WORD_TO_BYTE and
BYTE_TO_WORD adopt the appropriate format.

Accept the instructions in the following diagram:

Figure 72:
Instruction text

4-10

4, CoDeSys - BL_ID_PG_EN_S.pro - [Modbus_Comm (PRG-5T)]

ﬂ Fle Edit Project Insert Extras Online Window Help

S IRE e e e e e

A FPOUs
BRI odbus_Comm (PRG)

"4 PLC_PRG (PRG)

0001PROGRAM Modbus_Comm
0002VAR
D003[END_VAR

Now select "Project > Build". In case of a typing error, you will receive an error message in

the subjacent message field.
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In the opened master program PLC_PRG (PRG) you will receive a new range after "Insert
> Network (after)". Insert a new component here with "Insert > Box". By default, "AND" is
assigned to the component.

Check "AND". The input mask for the component is opened via the shortcut "F2". Select
"User defined Programs" from the list in the left space of the window. Check the
"Modbus_Comm" program defined above and acknowledge with OK.

Figure 73: S—
Inserting the - CoDeSys - BL67-PG-EN_mit_S.pro* - [PLC_PRG (PRG-FED)] EaX
new Component ﬂ Fie Edit Project Insert Extras Onine Window Help TR

el = R s O o o e o o |

[ontlprnnpi el - PR
<

Modbus_Comm
into the master Y e s _

program EErLC PRG (PRG) 002
|
v

PLC_PRG.
< | >

E ; ]

[ [ONLINE [0V [FEAD

In the Online mode (Online > Login or %’ ) download the expanded program into the
programmable gateway and start it ( )

Configuration of the Modbus-TCP-interface in the control software

Open the visualization software "Galileo" and if need be, create a new project. In the first step
you are asked to select the type of your control from the list:

e
Panel T »
Device type of ane. ype P

the control Panel Type
Colors
256 -
Rezolution Format
#-Resolution; * Landscape
‘-Rezolution: " Portrait

ak | Cancel
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In the second step select the PLC-type. Via the button "Add", the window "Select PLC "
opens. Open the pull-down menu for type, select "Modbus TCP" and acknowledge with OK.

Figure 75:

PLC selection
Fi / Madel | infa | PLC Data

Communication

Board Type Comm...

M Select Communication

Modbus TCP
Port: Ethernet hd

Model

Description: |

Cancel

0K

Cancel |

On the tab "Firm / Model" you may indicate, next to other configurations, the IP-address of
your gateway "BL67-PG-EN" (here: 192.168.1.1 "Setting of the IP-addresses for Ethernet
communication" page 3-6). The port number of the Modbus-TCP-port is 502, the "Address

Offset" is "0".
Figure 76:
Select PLC
the Modbus- E]
connection Firm / Model l Info ] FLC Data ] kermary Alignment ]
Comrnunication
Mo, | Port Eoard Type Comm... | Model
0 Ethernet kModbusz TCF
45 | .
Audd R emowve b codify heta Data
Statuz Refresh [z]: 10
break [ms]: ]
Startup Delay[=]: 5
Default Unit |dentifier: o
IP Address or Hostname: 152.168.1.1|
Addreszs Offzet: o
Fart Murmber: ROz
Little/Big Endian kMode Eig Endian
| k. | LCancel Help
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Define two "Word" type variables for the Modbus-TCP-communication. For this open the tab
"Tags". By right-clicking the mouse on "Word" you may select "New", and then enter the
name of your new variable. Define one variable with the name "O_Register0", and one with

the name "I_Register0".

For communication, Modbus-TCP provides certain register ranges:

0x4000 to 0x43FF for input data
0x4400 to 0x47FF for output data

Table 52: HEX DEC Modicon
Modbus-
TCP-register
ranges
Inputs Packed 0x0000 0 400001
to
Ox01FF 511 400512
Outputs Packed 0x0800 2048 402049
to
Ox09FF 2559 402560
Gateway identification 0x1000 4096 404097
to
0x1006 4102 404103
Gateway status 0x100C 4108 404109
Process image length in bits of the 0x1010 4112 404113
intelligent output modules
Process image length in bits of the 0x1011 4113 404114
intelligent input modules
Process image length in bits of the digital 0x1012 4114 404115
output modules
Process image length in bits of the digital 0x1013 4115 404116
input modules
Register-Mapping-Revision 0x1017 4119 404120

etc.

Please refer to the user manual BL67-PG-EN (D301033) for an overview of all Modbus-TCP-

register ranges.

Double-click on O_Register0 to open the tab Variable Definitions for this variable. Open the
tab "Address" and enter the first address from the range of the output data "17408" (0x4400).

Double-click on I_Register0 to open the tab Variable Definitions for this variable. Open the tab
"Address" and enter the first address from the range of the input data "16384" (0x4400).

D101640 0109 - BL ident® CoDeSys
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Figure 77:
Register-
address entry

4-14

M Tag Properties: | RegisterQ

Format  Address | Limits I Units I

—Read [PLC -> M) ‘write: (MBI > PLC)
¥ OnDemand ¥ OnDemand
¥ &t Startup [~ At Startup
v Paolling Ifast LI IEI zeC,

Jzed Address Link Mame Description
yes RG34 -] Madhus TCP

M Setting address

R%d ;I

0..65535 @

H elp

R16354

Clear Address | Cancel | I

If the value "46" is now mapped to the register |_Register0 (16384), this value is written into
the variable WRITE_Data_10 via the newly created interface. With the next write command,
this value is written to a physically present tag.

The value of the variable READ_Data1_0 is transferred to the register O_Register0 (17408) via
the newly created interface.

° Note

1 Please pay attention to the LED display on the gateway housing!
Communication via the newly created interface is only possible when the expanded
program runs on the gateway (RUN/STOP: green) and when Ethernet-
communication is active (LNK/ACT: not OFF). Please refer to the user manual
"BL67-PG-EN (D301033)" for the complete description of LED-diagnoses.
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The following description is based on the prerequisite that an initial startup of the BL ident ®
system was completed with the programming software CoDeSys from the company "3S".
The previous Kapitel 3 provides instructions for this purpose.

Installation of the interface with BLxx-2RFID-A-modules
The following paragraphs describe the procedural method for transferring 1 byte Tag-data:

from the Receive-buffer of the PIB function block to a PROFIBUS-DP-master of a SIMATIC
S7/-300 control.

from a PROFIBUS-DP-master of a SIMATIC S7/-300 control into the Transmit-buffer of the
PIB function block.

Variable names for the PROFIBUS-DP I/0s

After startup of the BL ident ®-system, open the tab Resources with the programming
software CoDeSys and select the array "PLC Configuration".

PY Note

1 Please ensure that the online connection to your control is not active. The mode
“ONLINE” at the bottom right of the window is not highlighted.

In the middle of the window of the control configuration double-click on "BL67-PG-
DP[SLOT]" to open the tab for configuring your gateway BL67-PG-DP.

First open the tab "Module Parameters". Select "NormalMode" if you desire to assign the
PROFIBUS-DP-address independent from the Ethernet-address (via rotary switch) and
therefore solely via the software.

Select "RotaryMode" if you desire to use the PROFIBUS-DP-address set on the gateway with
the rotary switches together with the Ethernet-communication. The 3-digit PROFIBUS-DP-
address and the last three digits of the 12-digit Ethernet-address always match in this mode.
In the following example the Ethernet-address is 192.168.1.6 and the PROFIBUS-DP-address
is "6".

Figure 78:
"RotaryMode"
Ethernet-
address and :
PROFIBUS-DP- nlndex |£J:;T:v'eAddrr\-1ode :Stlau;'rdode E}P?oerriglltmode -
address 1 DPSlaveAddress B 1 1
together via

rotary switch

Base parameters] Input/Output ] User parameters Module parameters l
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Open the tab Input/Output.
Here, select the module "2RFID-A" under "Input/Output Modules".

Now in the middle window assign the variable names for the “Input Word” and the
“Output Word” of the selected module:

Double-click on "AT %IW2:WORD" to open the input field and enter "I_Word0".
Double-click on "AT %QW2:WORD" to open the input field and enter "O_Word0”.

Figure 79:

4 CoDeSys - BL_ID_PG_DP.pro - [PLC Configuration]
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—

| [ONLNE [0V [READ

Program expansion
Open the tab POUs, select the main PLC_PRG (PRG) and expand it as described below:

Right-click on component "Add Object..." and make a selection. Accept the entries of the
following diagram:

Entios fora New POU B
new component
Mame af the new POL: |F'eriI:uus_Eu:umm
Type of FOL Language of the FOL Cancel
{* Program L
" Function Block " LD
" Function " FBD
Beturn Type: " SFC
|| e
" CFC

Open the newly created Profibus_Comm. This new component is to execute the following
tasks:

The first byte of the input word “I_Word0” is to be transferred to the first byte of the Send-
buffer CH_O_TXREF.

The first byte of the Receive-buffer CH_0_RXREF is to be transferred to the first byte of the
output word O_Word0.

4-16 D101640 0109 - BL ident® CoDeSys



PROFIBUS-DP master "L K

Industrial
Automation

Send-buffer CH_O_TXREF and Receive-buffer CH_0_RXREF are "byte" type arrays and
belong to the global variables of the PIB-component ("The function block PIB_001KB" page
3-9).

The functions WORD_TO_BYTE and BYTE_TO_WORD adopt the appropriate format.

Accept the instructions in the following diagram:

Figure 81:

Instruction text 4 CoDeSys - BL_ID_PG_DP.pro - [Profibus_Comm (PRG-ST)] X
for ﬁ Fle Edit Project Insert Extras Onine Window Help .8 x
frofious_Comm e e e e T
( ) | 0001|PROGRAM Profibus_Comm
aPOUS [o002)vAR
~[5] PLC_PRG (PRG) [0003END_VAR
= PRG_PibCommands (PRG)|| eecd
— = e < | b3
""" Frofibus_Comm (FRG) — =
| 0001)
| 0002|CH_0_TXREF[1]:=WORD_TO_BYTE(I_Word0);
0003
%O_WorclU::EIYTE_TO_WORD[CH_U_RXREFI1]}:|
0005

Now select "Project > Build". In case of a typing error, you will receive an error message in
the subjacent message field.
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In the opened master program PLC_PRG (PRG), you will receive > a new component via Insert
Component (alternatively also via drag and drop {i} (). Add it next to the component
PIB_001KB. The component will receive a sequential number and by default, "AND" is

assigned to it.

Check "AND". The input mask for the component is opened via the shortcut "F2". Select
"User defined Programs" from the list in the left space of the window. Check the program
"Profibus_Comm" defined above and acknowledge with OK.

Figure 82:
Inserting the
new component
Profibus_Comm
into the master
program
PLC_PRG

4-18
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In the Online mode (Online > Login or %‘ ) download the expanded program into the
programmable gateway and start it ( )
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Configuration of the PROFIBUS-DP-interface in the control software

Here, the configuration of the BL67 station is implemented in the "SIMATIC Basic Software
Step 7" as an example. Update the GSD file if necessary (before or after the start of the
software). Open the array "Hardware" and complete the configuration of the PROFIBUS-DP-
system. Please refer to "User Manual for PROFIBUS-DP" (D300527) for instructions.

In the file directory tree of the device catalog and on the right side of the screen select for your
gateway "BL67-PG-DP" an "Input Word" and an "Output Word". The I/O addresses are
suggested by the SIMATIC Manager.

Figure 83: R TR R laix]
Selection Dl(e-la (%] & ®lo| @il =m 2 ]
"Input Word" = Poile [Sadan =]
and PROFIBUS DP ] =
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| =@
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_ TR B{E--%B;LEF-EW-DPW
F = PROFIBUS(1} DP master system [1] % g'[g;'gg“['?;
2 E CPU 31 A
ER— J FIEE B, i
3 . Output Word
= - 2 Input Wards
A . 2 Output Words
o = el 4 inputwords
—[] 4 0upuwords
- 8 Input Wards
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(4 16 Outpu Words
- 32 Input Wards
- 32 Output Words
! ' sf| | ag e
!I:l (3] BLE7-PG-DP ] S{Ejat:vlvgrq
Siot | E4Mudu\e;‘.. ‘r?';j:a\lj\:;gber 2\5?2:? 0 Addiess | Comment | gﬁgiﬁib‘; ;SEHZEUS OF Slaves
Output word [3 cunhguued';tahuns
[ DPVO slaves
[ DPag-
L] DP/Pa Link
[ ENCODER
[ ET 2008
S £ o
= e o -
L
Data transfer via a variable table
Exit the array "Hardware" and go to the project directory of the "SIMATIC Manager". Expand
the project tree in the left window and double-click on the bottom item "Components" to open
it.
Right-click in the right window space and then click on "Insert New Object > Variable Table"
to open the window for configuring the features of a new variable table. Here, enter
"Var_watch" as a "Symbolic name" and acknowledge with OK.
First enter the variable name "Input Word" and then in the subjacent line, enter the address
and the display format of the variable. The address is entered by right-clicking the line below
the name, and then by clicking on "Insert Range...". Select the address like in Figure 83.
Load the modified program into the CPU (PLC >Download)!
Figure 84: g Address | 5ymhul| Dizplay format | Statusz value
Actj‘essmq the 1 Anput ward
varlab"les Input 5 i SEE BEC
Word" and S Fra T :
4 w256
5
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Activate the online connection to your control (PLC > Connect to > Direct CPU) to read the
status values and load the control variables. The mode "RUN" is displayed highlighted in
green in the right bottom of the window.

Note

®

1 Please pay attention to the LED display on the gateway housing!
Communication via the newly created interface is only possible when the expanded
program runs on the gateway (RUN/STOP: green) and when the PROFIBUS-DP-
communication is not being interfered with (DP: green). Please refer to the user
manual BL67-programmable Gateway BL67-PG-DP (D301047) for the complete
description of the LED diagnoses.

Setup of the interface with BLxx-2RFID-S-modules
The following paragraphs describe the procedural method for transferring 1 byte Tag-data:

of the variable "READ_Data1_0" of the process input data to a PROFIBUS-DP-master of
a SIMATIC S7/-300 control.

from a PROFIBUS-DP-master of a SIMATIC S7/-300 control to the variable
WRITE_Data1_0 of the process output data.

Variable names for the PROFIBUS-DP I/0s

After startup of the BL ident ®-system, open the tab Resources with the programming
software CoDeSys and select the array "PLC Configuration".

® Note

1 Please ensure that the online connection to your control is not active. The mode
"ONLINE" at the right bottom of the window is not highlighted.

In the middle of the window of the control configuration double-click on "BL67-PG-
DP[SLOT]" to open the tab for configuring your gateway BL67-PG-DP.

First open the tab "Module Parameters". Select "Normal Mode" if you desire to assign the
PROFIBUS-DP-address independent from the Ethernet-address (via rotary switch) and
therefore solely via the software.

Select "Rotary Mode" if you desire to use the PROFIBUS-DP-address set on the gateway with
the rotary switches together with the Ethernet-communication. The 3-digit PROFIBUS-DP-
address and the last three digits of the 12-digit Ethernet-address always match in this mode.
In the following example the Ethernet-address is 192.168.1.6 and the PROFIBUS-DP-address
is "6".

Figure 85:
"RotaryMode"
Ethernet-
address and
PROFIBUS-DP-
address
together via
rotary switch

4-20
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Open the tab Input/Output.

Select an "Input Word" and an "Output Word". In the middle window now assign the variable
names for the “Input Word” and the “Output Word”.

Double-click on "AT %IW2:WORD" to open the input field and enter "I_WordQ".
Double-click on "AT %QW2:WORD" to open the input field and enter "O_Word0”.

Figure 86:
PROFIBUS-DP
inputs/outputs
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(i Library (@@= @—-&dﬁx_\erﬁl‘pwtw 488 Byte Length of in-/output dat
BiLog AT %IX24.0: BOOL, (" Bit0 ") Max. number of modules 122 Murnber of modules
FLC- B < s O G
% AT %IX24 1: BOOL; (*Bit17) W— Soloced Modules
QSE‘ 7‘ AT WL RO (*Bit 2% Inputord Input Word
#% Tar Et AT %I%24 3 BOOL: (" Bit3%) 2 Input¥ords . Output'Word
@Taagk o AT %IX24 4: BOOL; (* Bit4 ™) 4 InputWords
Q \Watch- AT %IX24 5 BOOL; (*Bit57) 3 InputWords
S Warksp AT %I1x24 6 BOOL; (* Bit 6 ) 16 Input ‘Wards
AT %I%24.7: BOOL; (* Bit 77) 32 Input¥ords

AT %IX25.0: BOOL: (* Bit8 ") = Dutput Modules

[l

AT %1251 BOOL, (* Bit 8 ") Sutputhiord

AT %1252 BOOL; (Bt 107) igztgztwszz
AT %IX25 3 BOOL; (* Bit 117) & Output Words
AT %125.4' BOOL; - Bit127) 15 Outout Wards
AT %0X25 5 BOOL; (* Bit 13 %) 32 Output Words

AT %125 6 BOOL; (* Bit 14%)
AT %IX25 7 BOOL; (* Bit 15%)
B Output Word

EF—0_Word0 AT %QW12 WORD.) OUtpUt word
AT %024 0 BOOL, (* Bit0*)
AT %0X24. 1 BOOL; (* Bit 1)
AT %024 2 BOOL; (* Bit2*)
AT %0X24 3 BOOL; (* Bit3 ™)
AT %024 4 BOOL; (* Bit4 %)
AT %0X24 5 BOOL; (* Bit57)
AT %024 6 BOOL; (* Bit )
AT %0X24 7 BOOL; (* Bit7 )
AT %025 0 BOOL; (* Bit 8 *)
AT %0X25 1 BOOL; (* Bit9")
AT %025 2 BOOL; (* Bit 10 %)
AT %0X25 3 BOOL; (* Bit 11%)
AT %0125 4 BOOL; (* Bit 12 %)
AT %0X25 5 BOOL; (* Bit 13 %)
AT %025 6 BOOL; (* Bit 147)
AT %0X25 7 BOOL; (* Bit 15.%)

BLBLxloSys.lib’ X,
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Program expansion
Open the tab POUs, select the main PLC_PRG (PRG) and expand it as described below:

Right-click on component "Add Object..." and make a selection. Accept the entries in the
following diagram:

Figure 87:
Entries for a
new component

New POU X]
Mame af the new POL: |F'eriI:uus_Eu:umm
Type of FOL Language of the POL Cancel
* Program L
" Function Block " LD
" Function " FBD
Beturn Type: " SFC
e
" CFC

Open the newly created component Profibus_Comm. This new component is to execute the
following tasks:

The first byte of the input word "I_Word0" is to be transferred to the byte
"WRITE_Data1_0" of the process output data. The description "WRITE_Data1_0" was
selected here for Byte 4 of the process output data ("Process output data" page 3-46).

The byte "READ_Data1_0" of the process input data is to be transferred to the first byte of
the Output Word "O_Word0". The name "READ_Data1_0" was selected here for Byte 4 of
the process input data ("Process input data" page 3-43).

The variables "READ_Data1_0" and "WRITE_Data1_0" are "byte" type variables and belong
to the global variables.

The functions "WORD_TO_BYTE" and "BYTE_TO_WORD" adopt the appropriate format.

Accept the instructions in the following diagram:

Figure 88:
Instruction text
for
Profibus_Comm
(PRG)

4-22

J, CoDeSys - BL_ID_PG_DP_S.pro - [Profibus_Comm (PRG-5T)] C O
t Flle Edit Project Insert Exfras Onine Window Help -8 x
B8] D@ %5 e
D00A[PROGRAN Profibus_Comm
S POUs 0002vAR
~[2] PLC_PRG (PRG) 0003END_VAR
Profibus_Comm (PRG) < 3

3
- POUSI'G Datalypes]\/\sualizatm IE Resnurces] | — e 2 TN TR T P R 1
[ [Lin. 4, Cal.: 37 [ONCINE [0V [READ

Now select "Project > Build". In case of a typing error, you will receive an error message in
the subjacent message field.

D101640 0109 - BL ident® CoDeSys



PROFIBUS-DP master "L K

Industrial
Automation

In the open master program PLC_PRG (PRG), the new component "Profibus_Comm"
may be inserted into the master program via "Insert > Function Block".

Figur © 89: .. CoDeSys - BL_ID_PG_DP_S.pro - [PLC_PRG (PRG-ST)] _
Insertlng the ﬁ Hle Edit Project Insert Extras Onine Window Help - | &8 x
new component | gza| | gledels(Edal &(mlelmm
Profibus_Comm = [0001[PROGRAM PLC_PRG
. FOU!
into the master B — .
program “~[2] Prafibus_Comm (PRG) e I -
PLC_PRG [000[Pronbus_Commiy,
|0002)
0003
|o004)
| 0005)
[000g
0007
[000g
05|
< | >
-@ POUSI'G Dalatypes]\/isualizatin I%Plesnurces] T remree e e el e L 1" o e masirued L1t ]
[ |Lin: 1, Cal: 17 [ONLINE [0V [READ

In the Online mode (Online > Login or %‘ ) download the expanded program into the
programmable gateway and start it ( )
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Configuration of the PROFIBUS-DP-interface in the control software

The configuration of the BL67 station is implemented here in the "SIMATIC Basic Software
Step 7" as an example. Update the GSD file if necessary (before or after the start of the
software). Open the array "Hardware" and complete the configuration of the PROFIBUS-DP-
system. Please refer to "User Manual for PROFIBUS-DP" (D300570) for the procedural
method.

In the file directory tree of the device catalog and on the right side of the screen select for your
gateway "BL67-PG-DP" an "Input Word" and an "Output Word". The I/O-addresses are
suggested by the SIMATIC Manager.

Figure 90 By Station Edit Insert PLC VYiew Options Window Help =&l x|
Selection D|z(2-|= %] & | =@ % EH
"II’I,DUT Wordu = Profile | Standard >
PROFIBUS DP -
and [ Addiional Field Devices T
"OUtpUt Word" L D.E{I‘_/'?I/D
=3 TURCK
=@ %_57
_ [0) LR #-gg BLE7-GWw-DPV1
L PROFIBUS(1} DP master system [1] @ BLBTGW-DP
EE ] BLE7PG-DP
& (31BLE-PC i thr::f @j,:udme
—[§ Outputword
- 2 Input Wards
—[] 20upuwords
- 4 Input Wards
(] 40upuwords
- 8 Input Wards
—[] & 0upuwords
- 16 Input Wards
(4 16 Outpu Words
- 32 Input Wards
- 32 Output Words
! ' sf| | ag e
!I:l (3] BLE7-PG-DP ] S{Ejat:vlvgrq
Siot | Module / .. ‘r?';j:a\lj\:;gber 2\5?2:? 0 Addiess | Comment | é{éggi&fg ;SEHZEUS OF Slaves
Output word [ Configured Stations
[ DPVO slaves
[ DPag-
L] DP/Pa Link
[ ENCODER
[ ET 2008
g ET 200C
ET 200eca
FRES -
L
Data transfer via a variable table
Exit the array "Hardware" and go to the project directory of the "SIMATIC Manager". Expand
the project tree in the left window and double-click on the bottom item "Components" to open
it.
Right-click in the right window space and then click on "Insert New Object > Variable Table"
to open the window for configuring the features of a new variable table. Here enter
"Var_watch" as a "symbolic name" and acknowledge with OK.
First enter the variable name "Input Word" and then in the subjacent line, enter the address
and the display format of the variable. The address is entered by right-clicking the line below
the name, and then by clicking on "Insert Range...". Select the address like in Figure 90.
Load the modified program into the CPU (PLC > Download)!
Figure 91: g Address | 5ymhul| Dizplay format | Statusz value

Accessing the
variables "Input
Word" and
"Output Word"

4-24

Alnput word
' 256 EDEE
Af0ukput ward
W 256

m.p.mm—l|
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Activate the online connection to your control (PLC > Connect to > Direct CPU) to read
the status values and load the control variables. The mode "RUN" is displayed highlighted in
green in the right bottom of the window.

® Note

1 Please pay attention to the LED display on the gateway housing!
Communication via the newly created interface is only possible when the expanded
program runs on the gateway (RUN/STOP: green) and when the PROFIBUS-DP-
communication is not being interfered with (DP: green). Please refer to the user
manual "BL67-programmable Gateway BL67-PG-DP" (D301047) for the complete
description of the LED diagnostics.
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EtherNet/IP master

4-26

The following description is based on the prerequisite that an initial startup of the BL ident ®
system was completed with the programming software CoDeSys from the company "3S".
The previous Kapitel 3 provides instructions for this purpose.

Installation of the interface with BLxx-2RFID-A-modules
The following paragraphs describe the process for transferring 1 byte Tag-data:

from the Receive-buffer of the PIB function component to the EtherNet/IP master
CompactLogix™ (Allen-Bradley, CPU L35E).

from the EtherNet/IP-master CompactLogix™ (Allen-Bradley, CPU L35E) to the Transmit-
buffer of the PIB function component.

Variable names for the EtherNet/IP-registers

After startup of the BL ident ®-system, open the tab Resources with the programming
software CoDeSys and select the array "PLC Configuration".

PY Note

1 Please ensure that the online connection to your control is not active. The mode
"ONLINE" at the right bottom of the window is not highlighted.

In the middle of the window of the control configuration double-click on "EtherNet/IP-register
[SLOT]" to open the tab for configuration of the EtherNet/IP-register. Open the tab Input/
Output.

Under "Input Modules" select an "Input Register", and under "Output Modules" an "Output
Register".

Now assign the variable names to both selected registers in the middle window:
Double-click on "AT %IW2:WORD" to open the input field and enter "I_Register_0".
Double-click on "AT %QW2:WORD" to open the input field and enter "O_Register_0".
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Figure 92: 4 CoDeSys - BL_ID_PG_EN_IP_CoDeSys. pro - [PLC Configuration] X
EtherNet/lP File Edit Project Insert Extras Online Window Help - g%
register Bl=a @ oo ES (2| Gl
EF--Configuration BLE7-PG-EN-IP )
§2) Resouices -BLET-I0[SLOT] Base parameters  [nput/Output | User parameters

B3 Global Variables
- . Globals_Variablen B--iEthemetiP Words[SLOT) Max. length of input data: 40965 Byte Length of input data
- . ‘arGlobe_FIB B Input Word Ma. length of output data 4096 Byte Length of output dat
- Variablen_Konfiguration [VA| I_Register_0 AT %WW0: WORD; Max. length of in-/output data: 4096 Epte Length of in-foutput
1[0 library BLi#l0Sys lib 22.6.06 12.2 -~ Output Ward Max. number of modules: 2048 Mumber of madules:
72 ibrary BLs<PIE b 23 5.06 11:13 E--0_Register_0 AT %QW0: WORD; = Input Modules |Selected Modules
o | library Standard b 22.11.02 11 Input ward
#1-(2] fibrary UtiLlib 15.6.05 10:51:38: g #)- Output Modules Output tw/ord

- (5] Toals
= Select »>
A\arm configuration elec

m Library Manager
m Log

- PLC - Browser

] I o ——— EtherNet/IP register
ﬁ Target Settings
Task configuration

- Q ‘watch- and Recipe Manager
- '}? ‘Workspace

T -E-E-E-5

Properties

|l

FO. ™2 Da. [V {$2 Re ]
[ [ONCINE [0 [READ

Program expansion
Open the tab POUs, select the main PLC_PRG (PRG) and expand it as described below:

Right-click on component "Add Object..." and make a selection. Accept the entries in the
following diagram:

Figure 93:
Entries for a
new component

New POL

3
Hame of the new POL: |EhterN et_|P_Comm

Type of POU Language of the POL Cancel
{* Program L
" Function Block, LD
" Furnction " FED
Beturn Tupe: " 5FC
| [ | @1
" CFC

Open the newly created component "Ethernet_IP_Comm". This new component is to execute
the following tasks:

Data of the register "I_Register_0" is to be transferred to the Send-buffer CH_0_TXREF.
Data of the Receive-buffer CH_0_RXREF is to be transferred to the register O_Register_0.
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Send-buffer CH_0_TXREF and Received buffer CH_0_RXREF are "byte" type arrays and
belong to the global variables of the PIB-component ("The function block PIB_001KB" page
3-9).

Modbus-TCP-registers are "Word" type registers. The functions "WORD_TO_BYTE" and
"BYTE_TO_WORD" adopt the appropriate format.

Accept the instructions in the following diagram:

Figure 94:
Instruction text

4 CoDeSys - BL_ID_PG_EN_IP.pro - [EtherNet_IP_Comm (PRG-5T)]
ﬁ File Edit Project Insert Extras Onlne Window Help

E|#|E| ®|-'.:||% %@ & ||E|@t W
| 0001|PROGRAM EtherMet_IP_Comm
A FOUs ooozlvaR
EEtheitiet IP_Cormm (PRG) [0003[END_VaR
-[g] PLC_PRG (PRG) eass
: PRG_PibCommands (PRG)

<

ool Wi - ™
[ProGRauCH—0-TXREFI1]=WORD_TO_BYTE(L Register_CJ;

0003|0_Register_0:=BYTE_TO_WORD(CH_0_RXREF|1]}{

Now select "Project > Build". In case of a typing error, you will receive an error message in
the subjacent message field.

4-28 D101640 0109 - BL ident® CoDeSys



EtherNet/IP master "L K

Industrial
Automation

In the opened master program "PLC_PRG (PRG)", you will receive a new component via
insert > box (alternatively with drag and drop via !J). Add it next to the component
"PIB_001KB". The component will receive a sequential number and by default, "AND" is
assigned to it.

Check "AND". The input mask for the component is opened via the shortcut "F2". Select

"User defined Programs" from the list in the left space of the window. Check the program
"Ethernet_IP_Comm" defined above and acknowledge with OK.

Figure 95: ) :
Inserting the Bl=(8| Bl@leiSRa * B v - e|a)Eelmlels]- S| glele| e
0001[PROGRAM PLC_PRG
new component 5 5 *
"Ethernet IP & [=] EhterNet_IP_Corm (FRG) Derno software for the programmable Gateway BLET-PG-ER By
W *4[D0] PLC_PRG [PRG] with the BLET-2RFID-A Module -y
Comm" into the 2] PRG_PibCommands (PRG] 5
nI=rt aiFR . =
master program >
"PLC_PRG" -
Input assistant
Standard Functions 3 User defined Programs
edeinedbuncions. EhimNel_IP_Camm [PRE]
User defined Function Bloc ~§lf] PLC_PRG [FRG) @@H
FBD Operators e[ =
F Upetaiors [Z] PRE_PibCommands [PRG)
Lser defined Programs
Corwersion Dperatars
g
AND
v Stuctured
_EXECUTE
T v
E ro "2 pa [Evis |BaRe | |€ >
T T
[ ONLINE [0 [READ

In the Online mode (Online > Login or %‘ ) download the expanded program into the
programmable gateway and start it ( )!
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Configuration of the EtherNet/IP-interface in the control software
Open the software RSLogix5000 and create a new project if necessary.

If you are not familiar with the software, read manual “BL67 - User manual for EtherNet/IP“
(D300888). The manual explains how to establish communication to the EtherNet/IP-network
and the configuration of the network. The configuration of the controller and the configuration
of the BL67 station are described step-by-step. The software contains an example of the
structure and display of the configuration, the process input and process output data of a
BL67 station.

For this example use the configuration setting of the EtherNet/IP-gateway from the following

diagram:
Figure 96: File Edit Wisw Search Logic Communications Tools ‘Window Help
Configurationof | @|e(@| S| »[m|@| o[ | =l Sl = ME 2a
the “BL67-PG- _
EN-IP” qat Offfine 1. I RUN e Path: [4B_ETH-14132.168.1.1\Backplane’0 =] & 22183 1 [ol=|s|m
B gateway  uforces b, F 0K
No Edits EH—F;ET | | | | | | ‘ | ﬂ
_| \ AT K X X
+- [ MainProgram PNl ™ Module Properties: LocalENB {ETHERMET-MODULE 1.1)
23 Unscheduled Programs
=I5 Motion Groups General* ] Eonnection] Module Infol
(3 Ungrouped fxes Type: ETHERMET-MODUILE Generic Ethemet Moduls
23 Trends
“Wendar: Allen-Bradley
-5 Daka Types )
Cﬂ’ User-Defined Parent LoceEnE Connection Parameters
+ Cﬂ, Strings Name: |ELB?_Turc:k
+ g Predefined . ﬁs:t:?iy Size:
e Cﬂ, Module-Defined Descrigtion: Bl £7-Gw-EM, Ethermet AP
-3 1f0 Configuration Irput m J (16-bit)
= m Backplane, CompactLogix System . =1 16t
f 1769-L35E KingLuis2 S—— = Dt = 15+
- 1769-L35E Ethernet Port LocalENB i FIEE Carfieitan 0 = jzhy
-5 Ethernet Address / Host Name - =l
& 1769-L35E Ethernet Part LacalENE & |P Addiess 168 . 1 . 254
ﬂ ETHERMET-MODLLE BLE7_Turck.
-0 CompackBus Local  Host Name:
ﬂ [0] CompactBus Local n
Bl [1]1769-50N1E =
< > Status: Difne 0k | Cancel | Apy | Heb
o
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Data transfer via the new interface

The configuration-, input- and output data are displayed in the software RSLogix5000 with
so-called "Controller-Tags".

In this example, the first byte of the data with the identification l.Data is sent from the Receive-
buffer 1 of the component PIB_001KB ("Display of the CoDeSys" page 4-32) via EtherNet/IP
to the control.

In this example, the first byte of the data with the identification O.Data is sent from the control
via EtherNet/IP to the Transmit-Buffer 1 of the function component PIB_001KB ("Display of
the CoDeSys" page 4-32).

Enter a value between 0 and 255 (here 46) in O.Data[1]. O.Data [0] is reserved for the “Control
Word” of the gateway.

Flgure 97: File Edit YWew Search Logic Communications Tools Window Help
Controller Tags | &|=|d| &| -~ 8[| | | =] Bl E = @la)
3 o
Eem Run i 'l: E;:t:”u;em Path: [ AB_ETH-14192168.1. 1B ackplanehl = BB 3| || sm =)
o Foices | Ol Beliem@
e & o A Al (o] w]o] .l
ol | JETASTY AT X X
- £ Controller KinglLuis2 A Scope ﬂ KinglLuis2 v Show... Show Al
MName & | Walue ('| Force Mask ('| Shle | Data Type
2 o o ander |+ BLE7_Tuike () () ABETHERNET_MODULEC
) Tasks & ELB?_Turck@ fJoood fJoood ABETHERMET_MODULE_|
-1 63 manTask | =/ BLE7_Turck:D [ [ 4B -ETHERMET_MODULE_|
+ q; MainPragram 3 | — BLB?_Turc | {0 {...} Decimal INT[128]
(3 Unscheduled Pragrams - +BLE7_Turck:0.Datal0] 0 Decimal INT
-6 ["gm” aroups |+ BLE7_TurkO.Date[1] Diecimal INT
& Tre;;:gmupe‘j fnes |+ BLE7_TuckO Datef2) 0 Decimal INT
5] Data Types - + BLE7_Turck:0.Data[3] o Decimal INT
g User-Defined - + BLE7_Turck:0.D ata[4] o Drecimal INT
+1 O serings - + BLE7_Turck:0.Data[5] ] Diecimal INT
+1 [ predefined |+ BLE7_Tuck:0.Dato[s] i Decimal INT
i ég% Ez:;”;z‘:r;”:d | & BLET_TurckD Data[7] 0 Decimal INT
e T b - + BLEY_Turck:0.D ata[3] 1] Decimal INT
& > |+ BLE_Turck0.Dateld] 0 Decimal INT
- + BLE?_Turck:0.Data[10] 1] Decimal INT
- + BLE7_Turck:0.Data[11] o Decimal INT
- + BLE? Turck:0.Data[12] 1] Decimal INT
- + BLE7_Turck:0.Data[13] 1] Drecimal INT
- + BLE?_Turck:0.Data[14] 1] Decimal INT
- + BLE7_Turck:0.Data[15] o Decimal INT
- + BLE?_Turck:0.Data[16] 1] Decimal INT
- + BLE?_Turck:0.Data[17] 1] Drecimal INT
- + BLE?_Turck:0.Data[18] 1] Decimal INT
- + BLE7_Turck:0.Data[19] o Decimal INT
- + BLEY?_Turck:0.Data[20] 1] Decimal INT
s 2| [[ <] Txmonitor Tags' {EditTags 7 1 " o |
=)
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The data from O.Data[1] is transmitted to the Transmit-buffer 1 of the function component
PIB_001KB via the newly created interface:

Figure 98: 4, CoDeSys - BL_ID_PG_EN_IP_CoDeSys.pro® - [PLC_VISU]
Display of the
CoDeSys

E Datei Bearbeiten Projekt Einfiigen Extras Onlne Fenster Hife

B|z|E| E|@]|eeE|S 28]

T
el il [ Write Config - INIT |

[ Write Config - T ON |

BUSY

( Write Config T OFF |

ERROR

Inventory

Phy=sical Read

Physical Write

Status : 0

o0 oo00e®

[
[
[
[ Mem Status
[
[

y Uuuyuy

wr
Dev Status

= eeor |
Transmit Buffer 1 L‘lg Receive Buffer 1 [99]
Transmit Buffer 2 0 Receve Buffer 2 N d
Transmit Buffer 3 0 Receive Buffer 3 1]
Transmit Buffer 4 0 Receve Buffer 4 1]
Transmit Buffer 5 0 Receive Buffer 5 1]
Transmit Buffer & 0 Receive Buffer 6 1]
Transmit Buffer 7 0 Receive Buffer 7 1]
Transmit Buffer & 0 Receve Buffer 8 1]
Transmit Buffer 9 0 Receive Buffer 9 1]
Transmit Buffer 10 0 Receive Buffer 10 1]
Transmit Buffer 11 0 Receive Buffer 11 1]
Transmit Buffer 12 0 Receive Buffer 12 1]

In this example, the Receive-buffer 1 contains the value “99”. This value is transferred to
|.Data[1] via the newly created interface. |.Data [0] is reserved for the “Status Word” of the
gateway.
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Figure 99 File Edit VYiew Search Logic Communications Tools ‘window Help
Inputdataofthe | @|=(E| &| & |B|@] <] =l SlnlRlE M= &la]
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- +/ BLET_Turck:l.Data[11] 1] Decimal INT
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- + BLET_Turck:l.Data[18] o Decimal INT
- +/ BLET_Turck:l.Data[19] 1] Decimal INT
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Ready =)
Setup of the interface with BLxx-2RFID-S-modules
The following paragraphs describe the process for transferring 1 byte Tag-data:

of the variables "READ_Data1_0" of the process input data to the EtherNet/IP-master
CompactLogix™ (Allen-Bradley, CPU L35E).

from the EtherNet/IP-master CompactLogix™ (Allen-Bradley, CPU L35E) to the variable
WRITE_Data1_0. of the process output data.

Variable names for the EtherNet/IP-registers

After startup of the BL ident ®-system, open the tab Resources with the programming
software CoDeSys and select the array "PLC Configuration".

® Note

1

Please ensure that the online connection to your control is not active. The mode
"ONLINE" at the right bottom of the window is not highlighted.

In the middle of the window of the control configuration double-click on "EtherNet/IP Words
[SLOT]" to open the tab for configuration of the EtherNet/IP-register. Open the tab Input/
Output.

Under "Input Modules" select an "Input Word", and under "Output Modules" an "Output
Word".

Now assign the variable names to both selected registers in the middle window:
Double-click on "AT %IW2:WORD" to open the input field and enter "I_Register_0".
Double-click on "AT %QW2:WORD" to open the input field and enter "O_Register_0".
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Figure 100: 4 CoDeSys - BL_ID_PG_EN_IP_S.pro - [PLC Configuration]
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Program expansion
Open the tab POUs, select the main PLC_PRG (PRG) and expand it as described below:
1 H n H ] . . .
Right-click on component "Add Object..." and make a selection. Accept the entries in the
following diagram:
Figure 101:

Entries for a
new component

4-34

New POU

Marne of the new POL:
Type aof POL

{* Program

" Function Block

" Function
Beturn Type:

]

|EhterN et_IP_Carmnm

Language of the POL
L

LD

" FED

" SFC

™ 5T

" CFC

B
_ Careel |

Caricel

Open the newly created Ethernet_IP_Comm POU. This new component is to execute the

following tasks:

The first byte of the input register "I_Register_0" is to be transferred to the byte
"WRITE_Data1_0" of the process output data. The description "WRITE_Data1_0" was
selected here for Byte 4 of the process output data ("Process output data" page 3-46).

The byte "READ_Data1_0" of the process input data is to be transferred to the first byte of
the output register O_Register_0. The description "READ_Data1_0" was selected here for
Byte 4 of the process input data ("Process input data" page 3-43).

The variables "READ_Data1_0" and "WRITE_Data1_0" are "byte" type variables and belong

to the global variables.

The functions "WORD_TO_BYTE" and "BYTE_TO_WORD" adopt the appropriate format.
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Accept the instructions in the following diagram:

Figure 102:
Instruction text

4, CoDeSys - BL_ID_PG_EN_IP_S.pro* - [EtherNet_IP_Comm (PRG-5T)]

ﬁ File Edit Project Insert Extras Online Window Help

BB B|@]edn(E| 2] 2|5
D001|PROGRAM EtherMet_IP_Comm
VAR

WRITE_Data1_0: BOOL,;
END_VAR

:

<0 ]
D00WRITE_Data1_0:=WORD_TO_BYTE(I_Register_0];

0003|0_Register_0:=BYTE_TO_WORD(READ_Data1_0};

>

B ro[*=Da]@Evi. | mRe) |[<

[Cin: 3 Cal: 42 [ONLINE [0% [READ

Now select "Project > Build". In case of a typing error, you will receive an error message in
the subjacent message field.
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In the open master program PLC_PRG (PRG), the new component may be inserted into the
master program via "Insert > Function Block". The new component is in the array "User
defined Programs".

Figure 103: i —
Inserting the 4. CoDeSys - BL_ID_PG_EN_IP_S.pro - [PLC_PRG (PRG-5T)] - | B
new component ﬁ File Edit Project Insert Extras Online Window Help _ |8l x
EtherNet_IP_ E@lﬂl |@|.q:||%|§@| g,||g|r;;,|q,j

Comm into the —5 0001[PROGRAM PLC_PRG

master program b EtSherNet_IP_Comm {PRG) %&%_\m

PLC_PRG E8ET] PLC_PRG (PRG)

4

0001|EtherMet_IP_Commi();

|l

000:
000!
000
0oo
< | >
EER R EER EED R >

[ [Cin: 1. Cal: 20 [ONLINE [0% [READ

In the Online mode (Online > Login or %‘ ) download the expanded program into the
programmable gateway and start it ( )!
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Configuration of the EtherNet/IP-interface in the control software
Open the software RSLogix5000 and create a new project if necessary.

If you are not familiar with the software, read manual “BL67 - User manual for EtherNet/IP“
(D300888). The manual explains how to establish communication to the EtherNet/IP-network
and the configuration of the network. The configuration of the controller and the configuration
of the BL67 station are described step-by-step. The software contains an example of the
structure and display of the configuration, the process input and process output data of a
BL67 station.

For this example use the configuration setting of the EtherNet/IP-gateway from the following
diagram:

Figure 104: File Edt Yew Search Logic Communications Iools Window Help
%Onf’gi’gt’g’éo" a|@d| S| 458 o] - Sl%ls = vE 2la
the -PG- i — =
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T — o it pei] 3t e [ oo N
| \ ABLL X X
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Data transfer via the new interface

The configuration-, input- and output data are displayed in the software RSLogix5000 with
so-called "Controller-Tags".

In this example, the first byte of the data with the identification 1.Data (.Data [1]) is transferred
from the process input data ("READ_Data1_0") via EtherNet/IP.

In this example, the first byte of the data with the identification O.Data (O.Data [1]) is
transferred to the process output data (WRITE-Data1_0) via EtherNet/IP.

Enter a value between 0 and 255 (here 46) in O.Data[1]. O.Data [0] is reserved for the “Control
Word” of the gateway.

Figure 105:
Controller Tags
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Extract from the specification

1 General

TURCK publishes this excerpt of the PROFIBUS Specification ,,Profile for Identification
Systems, Proxy Ident Function Block® (Version 1.02, December 2005) by courtesy of the PNO
(PROFIBUS Nutzer Organisation).

The PIB for CoDeSys is based on this specification.
Please also note the "Definitions in the command and diagnostics level" page 2-25.
1.6 Function demands

In this section the function demands of the application of RFID and Barcode reader systems
is defined. These demands define the limitations or limits which have to be observed with the
development of the PIB and the functions which have to be realised within the field device.
The RFID and barcode reader systems demands are described in parallel because of the
different functions.

1.6.1 General demands

The basic concept involves the adaptation of existing RFID and barcode reader systems to
Profibus technology, so that it can be integrated into existing systems, and to make sure that
use in new systems can be simplified (see following illustration).

Figure 107:
Basic concept

5-2

IEC 61131-3

_ PROFIBUS-DPV1
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Air interface

Comm-FB

e — v
IEC 61131-3 I
acyclic: file transfer >

PIB Interrogator/
Barcode reader

cyclic: control and status word

S

Buffer

Application
program
(not modified)

As the existing proprietary solutions have to be mastered, there are certain limitations which
have to be considered in addition to the Profibus conformity.

The following demands must be fulfilled:

Existing Profibus systems may only be minimally affected by the integration of RFID and
barcode reader systems

The control is implemented cyclically
The data transfer is acyclic
Application programs should be independent of the integration of the PIB

Fragmentation and defragmentation of data packages should occur within the PIB
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1.6.2 Demands with the use of RFID systems

Standardization activities for RFID systems are currently underway. The objectives here
include the definition of air interfaces (ISO/IEC 18000), the file format as well as handling of
files (ISO/IEC 15962). See below.

This profile specification explicitly deals with data transfer via industrial networks based on
the Profibus as well as the integration in PLC systems.

Figure 108:
Relevant Application Interrogator AIR Interface RF Tag
standardisation o tag physical memory
activities k logical
mome
memory
application A map
commands J tag driver commands=
command/ || | and
< response unit mapping |¢
application rules responses
responses #
logical | | ]
memory Note: the logical memory map
in the tag physical memory is
given by the tag architecture and
the mapping rules in the tag driver.
All the information in the logical
data protocol physical memory is represented in the
processor interrogator | logical memory map
ISO/IEC 15961 ISO/IEC 15962 ISO/IEC 15962 ISO/IEC 18000
Annexes

The topics concerning this specification do not need to be dealt with here as the process is
ongoing. It will be possible to refer to the respective documents at a later stage when the

standardisation to IEC is completed. For this reason the following points are not examined in
this document:

Air interface

File format,

File handler,

Coding of application data.

At the moment the respective data is normally considered as a data package, which is

interpreted both by the application in the Ident device as well as by the PLC application, which
uses the PIB (see illustration below).
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Figure: 109

Air interface
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2 Modelling of the Proxy Ident Block (PIB)

2.1 Fundamentals of modelling

The modelling of the Proxy Ident Block (PIB) must be performed according to the following
principles:

It must correspond with the available PLC systems, e.g. by using the existing addressing
concept

It must be efficient and without overheads, i.e. the model must be performance oriented
It must enable simple porting of the application program between different PLC systems
It should directly use the existing Comm-FBs

Dependencies on the hardware configuration should be avoided by good programming,
i.e. such as the addressing of the application program.

2.2 General PIB model

The PIB is modelled as a Proxy-FB which represents a complete Ident device. Here the
fundamentals of Proxy-FB modelling in accordance with [4] are observed.

Figure: 110
Use of Comm-
FB and Proxy-
FB for PIB
modelling

Proxy FB
FB_Field Device Control Proxy FB One Proxy FB
represents a
— DevID field device
— METHOD
WRREC
— — data_m1 result_m1 —

Comm FB — data_m2 result_m2 ——

inside a

Proxy FB

] V
i Local Instance Data

2.3 Representation

The interface for the POU type is represented by text and graphics compliant to IEC 61131-3.
The behaviour of the POU is represented as a graphic state diagram with tables for the
transitions and actions.
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3 Definition of the Proxy Ident Block (PIB)

This section defines the specification of the Proxy Ident Block according to the guidelines set
out in [4].

NOTE: If several PIB instances are operated simultaneously by an application program, it is
necessary to ensure that the individual instances do not inhibit each other. Block definition

The following illustration is a graphic representation of the PIB interface:

Figure 111:
Graphic
representation
of the PIB
interface

DONE | BOOL
BOOL EXECUTE
e oo | —E e
ID STATUS ®
INT INDEX WRREC
INT | OFFSET e—IID STATUS WARNING | BOOL
e e
BOOL INIT = SIATLS RPTACT | BOOL
BOOL UOUTO GETIO_PART ERR_IREQ | BOOL
— D STATUS =
BOOL UOUTH TPC | BOOL
BOOL UouT2 TP | BOOL
BOOL UOUT3 UINO | BOOL
BOOL RDGATE PIB UIN1 | BOOL
INT | CMDDM UIN2 | BOOL
INT | CMDSEL UIN3 | BOOL
Para ARRAY[1..10] CMDREF CMDREF | ARRAY[1..10]
of CMD_STRUCT of CMD_STRUCT
INT | TXBUFLEN
INT | TXSTART
Data ARRAY[1..N] | TXREF TXREF | ARRAY[1..N]
of BYTE of BYTE
INT RXBUFLEN TRLEN | INT
INT RXSTART
ARRAY[1..N] RXREF RXREF | ARRAY[1..N] Data
of BYTE of BYTE
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3.1.1 Parameters
Table 53: Name Description
PIB parameter
description
EXECUTE By setting the input parameters from the types BOOL to TRUE the user

(application program) can start an FB instance. Before the FB can be put
into operation the command and the corresponding parameters must be
written into memory, which is assigned to the CMDREF parameter. The
CMDSEL parameter must be set correctly for this purpose. This parameter
is set using a positive edge.

ID* The value of this input parameter is used as a unique ID for addressing of
an individual device or a slot within a device. A detailed description of this
is contained in document [4]. This parameter addresses an individual Ident
device in conjunction with the "INDEX" parameter.

INDEX* The value of this input parameter is used for identifying an individual Ident
channel within a slot on a device. The use of the parameter corresponds
with the definition of the address parameter "Index" according to [1] and [2].

OFFSET* The value of this input parameter is used for identifying the I/0 data
assigned to the channel, which is cyclically transferred as a subset of the
data that is assigned to a slot (module).

RPTCMD* If this parameter is set to "1", the Ident device will repeat the currently
executed command or the subsequently completed command. The
parameter is mirrored on the "Repeat_Command" bit in the cyclic control
word (see section 4.2.1)

SRESET* If this input parameter = "1", the command currently being executed in the
Ident device is cancelled. The parameter is mirrored on the "Soft_Reset" in
the cyclic control word (see section 4.2.1). This parameter is activated using
a positive edge.

INIT* With a change from "0" to "1" this input parameter forces the Ident device
to start operation with the exception of the communication interface.
Processes which are executed locally by the Ident device are
manufacturer-specific. The parameter is mirrored on the Init bit in the cyclic
control word (see section 4.2.1). After the sequence "Init_Active=0 ->
Init_Active=1 Init_Active=0" (cyclic Status word) has been completed, the
PIB must send a Write-Config command to the Ident device. This
parameter is set using a positive edge.

UouTOo* This parameter of type BOOL represents the user-specific bit 0 which is to
be transmitted within the cyclic control word (see section 4.2.1). The
parameter is mirrored on bit 0 of the cyclic control word.

UOuT1* This parameter of type BOOL represents the user-specific bit 1 which is to
be transmitted within the cyclic control word (see section 4.2.1). The
parameter is mirrored on bit 1 of the cyclic control word.

uouT2* This parameter of type BOOL represents the user-specific bit 2 which is to
be transmitted within the cyclic control word (see section 4.2.1). The
parameter is mirrored on bit 2 of the cyclic control word.
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Description

This parameter of type BOOL represents the user-specific bit 3 which is to
be transmitted within the cyclic control word (see section 4.2.1). The
parameter is mirrored on bit 3 of the cyclic control word.

This parameter of type BOOL represents the optional bit 8 which is to be
transmitted within the cyclic control word (see section 4.2.1). The operation
starts if this bit is set to "1".

Several commands can be saved in memory so that a more efficient
application program can be written. The number of stored commands
influences the memory area which is to be reserved for the respective PIB
instance. The input parameterCMDDIM defines the number of
"CMD_STRUCT" structures for command parameters.

As a certain number of parallel stored commands can exist, a means of
selection must exist in order to select the individual command to be
executed. The input parameter CMDSEL is used for this purpose by
assigning it a predefined command. The first CMD_STRUCT is reserved for
the parameter, which are assigned to the command "Write_Config".

These In_Out parameters refer to a global memory range, which is used for
storage of commands and the associated parameters. The maximum
number of commands which are assigned to an individual PIB instance
may not exceed 10. Section 3.1.3 describes the commands which are
supported by the profile version.

These input parameters determine the number of bytes which are used by
this PIB instance for storing transmit data. The number of bytes are
counted by the TXSTART parameter defined position within the memory
range. For reasons of consistency it is recommended that these
parameters should not be changed after the installation of the PIB.

The input parameter TXSTART defines the relative position of the "TXBUF"
defined by the "TXREF" within the global memory range. This location is the
start of the memory range which is assigned to the PIB instance. For
reasons of consistency it is recommended that these parameters should
not be changed after instantiation of the PIB.

These In_Out parameters refer to a global memory range which is used by
several PIB modules. The PIB instance may share the memory with other
modules.

These input parameters determine the number of bytes which are used by
this PIB instance for storing receive data. The number of bytes are counted
by the RXSTART parameter defined position within the memory range. For
reasons of consistency it is recommended that these parameters should
not be changed after instantiation of the PIB.

The input parameter RXSTART defines the relative position of the "RXBUF"
defined by the "RXREF" within the global memory range. This location is
the start of the memory range which is assigned to the PIB instance. For
reasons of consistency it is recommended that these parameters should
not be changed after instantiation of the PIB.

Table 53: Name

(cont.)

PIB parameter

description
UOuT3*
RDGATE*
CMDDIM*
CMDSEL*
CMDREF*
TXBUFLEN*
TXSTART*
TXREF*
RXBUFLEN*
RXSTART*

5-8
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Table 53: Name Description
(cont.)
PIB parameter
description
RXREF* These In_Out parameters refer to a global memory range which is used by
several PIB modules. The PIB instance may share the memory with other
modules.
TRLEN This output parameter indicates the number of the user bytes last sent

(depending on the command sent or received), after the command has
been successfully implemented. The number of transferred bytes from the
position (TXSTART + OffsetBuffer) or (RXSTART + OffsetBuffer) is counted.

DONE This output parameter is set to "TRUE" if a command with a positive result
is executed. The user program can query this flag during the time that the
command is being executed and before the transmitted data is computed.

ERROR This output parameter is set to "TRUE" if a fault has been detected. The
detected error can be locally (within the host control) or decentrally (within
the Ident device). More detailed information about the error are defined in
the "STATUS" parameter. This flag is set internally by the PIB in the
acknowledgement telegram (Bit 0 of Cl) depending on the error bit. After a
renewed call of a command the flag is reset to "FALSE".

WARNING This output parameter is set to "TRUE" if a warning has been detected. The
detected warning can be locally (within the host control) or decentrally
(within the Ident device). More detailed information about the warning is
defined in the "STATUS" parameter. This flag is internally set by the PIB
depending on the warn bit in the acknowledgement telegram (Bit 1..7 of CI:
one or more bits are set to 1). After a renewed call of a command the flag
is reset to "FALSE".
Note: In case of a WARNING all user data assigned to a command are
transmitted correctly (if ERROR is not set). In this case the data buffer
receives valid values.

STATUS The output parameter "STATUS" provides detailed error information and/or
warning information about the last command, which has been implemented
with a negative result or a warning. The value is retained until the next time
a warning or an error occurs. The coding depends on the possible source
of the respective warning or error message.

The following sources are possible: the embedded Comm-FBs, the
functions for cyclic data access, the Ident device, the tag or the internal
functions of the PIB.

BUSY If this output parameter is set to "TRUE" the PIB is “busy”. A command
cannot be transferred for execution (exceptions: "INIT" and "SRESET").
The parameter indicates that the PIB is still in operation.

RPTACT If this output parameter is set to "TRUE", the PIB* has accepted the
requirement to repeat the command currently being implemented. The
cyclic input data is mirrored by the bit "Repeat_Command_Active". The
output parameters remain active as long as the bit is set within the cyclic
telegram. As long as the output parameter is set, the PIB* provides data
after an executed command. The user is in a position to read the result of
the command.
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Table 53:
(cont.)

PIB parameter
description

Name

Description

ERR_REQ

This output parameter is set to "TRUE" if the PIB* has detected a fatal error.
It is mirrored by the Error_Flag of the cyclic input data. The output
parameters remain active as long as the bit is set within the cyclic telegram.
The PIB remains in the current state (state machine). If this parameter is set
to "TRUE" the user must set the INIT input parameter of the PIB POU or
trigger a Dev-Status command (if possible).

UINO

This output parameter of type BOOL represents the user-specific bit 0
which is to be transmitted within the cyclic status word (see section 4.2.2).

UIN1

This output parameter of type BOOL represents the user-specific bit 1
which is to be transmitted within the cyclic status word (see section 4.2.2).

UIN2

This output parameter of type BOOL represents the user-specific bit 2
which is to be transmitted within the cyclic status word (see section 4.2.2).

UIN3

This output parameter of type BOOL represents the user-specific bit 3
which is to be transmitted within the cyclic status word (see section 4.2.2).

TP

This output parameter is set to "1" if a target is within the Ident device
range. The parameter corresponds with the "Target_Present" bit of the
cyclic status word (see section 4.2.2). It is reset if there is not target within
the Ident device range. If an Ident device does not support this feature, the
parameter is set to "0". This parameter is not used for barcode readers.

TPC

This output parameter is set to "1" if a new target is within the Ident device
range. The parameter corresponds with the "Target_Presence_Changed"
bit of the cyclic status word (see section 4.2.2). It is reset to "0" after the
next "Inventory" command has been completed successfully. If an Ident
device does not support this property the parameter is set to "0". This
parameter is not used for barcode readers.

*The application program has the task of resetting and changing all input parameters.

Table 54:

Properties of
PIB parameters

5-10

Name

Data type Area Conditions of use
c=compulsory,
o=optional

EXECUTE

BOOL If DONE=O or ERROR=O, the change ofthe ¢
parameter EXECUTE from "0" to "1" forces
the function block to execute a command (if
DONE=0 and ERROR=0, the PIB POU has
not been initialised or the command is
currently being executed)

ID

(¢}

DWORD  0x00000000 .... OXFFFFFFFF (see [4])

INDEX

INT 101...108, 111...118,201...254 c

OFFSET

INT 0...244 c

RPTCMD

BOOL 0 = No Repeat_Command o
1 = Repeat_Command
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Table 54: Name Datatype Area Conditions of use
(cont.) c=compulsory,
Properties of o=optional

PIB parameters

SRESET BOOL Change from "0" to "1" forces the function ¢
block to execute the command SRESET
(ends the current command).

INIT BOOL Change from "0" to "1" forces the function c
block to execute the Init procedure.
UouTo BOOL Bit 0 = 0/1 o]
UOUT1 BOOL Bit 0 = 0/1 o
uouT2 BOOL Bit 0 = 0/1 o
UouT3 BOOL Bit 0 = 0/1 o]
RDGATE BOOL 0 = Read gate not active o]
1 = Read gate active
CMDDIM INT 2..10 C
CMDSEL INT 1..10 C
CMDREF ARRAY[2.. CMDDIM x 42 C
CMDDIM]
of
CMD_STR
ucT
TXBUFLEN INT 0...32768 C
TXSTART INT 0...32768 C
TXREF ARRAY C
[1..N]of
BYTE
RXBUFLEN INT 0...32768 c
RXSTART INT 0...32768 C
RXREF ARRAY N C
[1..N]of
BYTE
TRLEN INT 0...32768 c
DONE BOOL 0 = Command not C
executed

1 = Command executed

ERROR BOOL 0 = Last command completed without error ¢
1 = Last command completed with error

WARNING BOOL 0 = No warning information available c
1 = Warning information available

STATUS DWORD  See section 3.1.2 c
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Table 54: Name Data type Area Conditions of use
(cont.) c=compulsory,
Properties of o=optional
PIB parameters
BUSY BOOL 0 = PIB does not currently execute a c
command
1 = Command currently being executed by
the PIB
RPTACT BOOL 0 = No command repetition on the PIB* o
active
1 = Command repetition on the PIB* active
ERR_REQ BOOL 0 = No error reported from the PIB* c
1 = Error reported via PIB*
UINO BOOL Bit 0 = 0/1 o]
UIN1 BOOL Bit 0 = 0/1 o]
UIN2 BOOL Bit 0 = 0/1 o]
UIN3 BOOL Bit 0 = 0/1 o]
TP BOOL 0 = No target available 1 = Target available o
(do not use for
barcode reader)
TPC BOOL 0 = No target changed 1 = Target changed o
(do not use for
barcode reader)
In order to simplify access to individual elements of the command structure, a common
structure has been defined for each command independently of which individual parameter
has been used. The used parameter depends on the definition of the respective command.
These parameters are defined in section 3.1.3.
Figure 112:
Data type IIIY]J[—(‘I'MI) STRUCT
definitions of "~ STRUCT
the PIB Confiq : BYTE ;
command: C]rl’:-i'.:l.R.ut’fc:- r ’: INT;
UID : ARRAY[1..8] OF BYTE;
FileName : RRRAY[1..8] OF BYTE;
Offset : DINT;
Length : INT;
StartAddress : DINT;
Attributes : BYTE;
NextMode : BYTE;
Timeout : INT;
ObjectNumber : INT;
FileType : WORD;
END STRUCT;
END TYPE
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3.1.2 Errors and warnings

The PIB reports if the required command has been executed or not executed successfully.
The error message serves two purposes:

1 To change the reaction to the process, i.e. to trigger an alternative reaction, e.g. the
repetition of the command at another time or at another location, or the cancellation of the
process task

2 To send an alarm message to a HMI system via the user program or automatically via the

PLC system.
® Note
1 In the first case there are only very few alternative reactions which are dependent

on the respective error message. Detailer error information is barely used.

As other function blocks (Comm-FBs) and functions are embedded in the PIB, the parameter
STATUS provides status information from several sources.

The STATUS parameter can also be used for warning information.

As an alternative to the use of STATUS parameters error and warning information can be
transmitted within the diagnostics data (see section 4.4).

The STATUS output of type DWORD is interpreted as a packed array consisting of four bytes
as shown in the following table.

Table 55: Byte Name Definition Data type
Structure of
the
STATUS
output
0 Function_Num See Table 56: Byte
1 Error_Decode See Table 57: Byte
2 Error_Code_1 See Table 58: Byte
3 Error_Code_2 Warnings or Byte
manufacturer-specific
faults
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The definition of the byte Function_Num is based on (IEC 61158_6, Part 6; 1999) and expands
the supplements realised in (PROFIBUS Communication and Proxy Function Blocks acc. to
IEC 61131-3 Vers. 1,2). It us used to group errors and warnings.

Table 56: Frame PDU - Error_Code_2 is Function_ Description in
Select or designator used for warnings Code /Error accordance with
Values from (Bit 7), (Bit 5 to 6), (Bit 4)* Code this profile
byte decimal  decimal (Bit O to 3)
Function_ decimal
Num
0 0...3 0/1 0..15 No error
1 0,1 0/1 0...15 Error not associated

with the DP-protocol
and not defined for
this profile

1 2 0/1 0...15 Error messages
associated with the
DP-protocol, see /2/
and [4]

1 3 01 0 Manufacturer-
specific coding of
Error_Code_1 and
Error_Code_2

1 3 0/1 1 Error_Code_1
provides error
information
concerning the Tag/
transponder/barcode
Manufacturer-
specific coding of
Error_Code_2

1 3 01 2 Error_Code_1
provides error
information about the
air interface
Manufacturer-
specific coding of
Error_Code_2

1 3 01 3 Error_Code_1
provides error
information about the
file system
Manufacturer-
specific coding of
Error_Code_2
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Table 56: Frame PDU - Error Code 2 is Function_ Description in
(cont.) Select or designator used for warnings Code /Error accordance with
Values from (Bit 7), (Bit 5 to 6), (Bit 4)* Code this profile
byte decimal  decimal (Bit O to 3)
Function_ decimal
Num
1 3 (074 4 Error_Code_1

provides error
information about the
Ident device
(Transponder/
Barcode reader)
Manufacturer-
specific coding of
Error_Code_2

1 3 0/1 5 Error_Code_1
provides error
information
concerning
communication
between the PIB and
Ident device (with the
exception of DP
errors)
Manufacturer-
specific coding of
Error_Code_2

1 3 0/1 6 Error_Code_1
provides command-
specific error
information
Manufacturer-
specific coding of
Error_Code_2

1 3 0/1 7 Error_Code_1
provides error
information which is
internally generated
by the PIB
Manufacturer-
specific coding of
Error_Code_2

1 3 01 8..15 Not defined here

* Bit 4 = 0: Error_Code_2 contains manufacturer-specific information, Bit 4 = 1: Error_Code_2
contains warning information (Byte 5 (Cl) of acknowledgement telegram)

The Error_Decode byte is used in order to define the Function_Num, Error Code 1 and Error
Code 2.
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Table 57: Error_Decode Source Meaning
Values of byte
Error Decode
0x00 PLC No error, no warnings
0x01 .. Ox7F PLC Warning (not used for this profile)
0x80 DP V1 Errors reported compliant to IEC 61158-6 1717
0x81 .. Ox8F PLC 0x8x reports an error after the x-th parameter of
the Comm-FB call, as defined in [4]
0x90 .. OxFD reserved
OxFE Profile (PIB, Profile-specific error

Ident device)

OxFF Profile (PIB, Reserved for future use
Ident device)

Error_Code_1 provides the number which represents the error or warning. The byte
Error_Decode is defined on OxFE in the following table.

Table 58: Function Error_ Reported by Meaning Compulsory
_Code/ Code_1 optional
Values of byte  Error_ (decimal)

Error Code 1 Code*

1 1 IG Tag memory error (e.g. o
CRC error).
1 2 IG Presence error (reported o

by Ident device), Tag has
left the transfer window

1 3 IG Address or command o]
does not correspond with
the Tag properties
(memory size) (reported
by Ident device)

1 4 IG Tag defective, (replace o]
Tag or battery)

1 5 IG Tag memory overflow o]

1 6 IG Unformatted Tag o

1 7 IG Inconsistent Tag data o]

structure. Reformat Tag

1 8 IG Tag within the transfer o]
window does not have the
expected UID (reported by
Ident device)

1 9 IG Command not supported o
by the Tag
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Table 58: Function

(cont.) _Code/
Values of byte Error_

Error Code 1 Code*

Error_
Code_1
(decimal)

Reported by Meaning

Compulsory
optional

1

10

Access violation (e.qg.
element inhibited ); see
ISO18000-X

11..127

IG

Reserved for future profile
use

128..255

IG

Manufacturer-specific

1

Communication timeout
on the air interface
(reported by the Ident
device)

More Tags/barcodes than
permissible in the transfer
window, (reported by
Ident device)

3..127

Reserved for future profile
use

128..255

Manufacturer-specific

1

Incorrect file name
(reported by Ident device)

File not available (reported
by Ident device)

The Tag type is incorrect
or not suitable for the
selected operating mode.
No file system available
on the Tag. (reported by
Ident device)

Create command; no
directory entries available,
(reported by Ident device)

Create command; file
already available in
directory, (reported by
Ident device)

Access violation (reported
by Ident device)

File length exceeded
(reported by Ident device)

File not available (falsified)
(reported by Ident device)
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Table 58: Function Error_ Reported by Meaning Compulsory
(cont.) _Code/ Code_1 optional
Values of byte  Epror_ (decimal)

Error Code 1 Code*

3 9..127 IG Reserved for future profile o]
use

3 128..255 IG Manufacturer-specific o]

4 1 IG Voltage failure (reported o

by Ident device)

4 2 IG Hardware error within the o
Ident device (reported by
the Ident device)

4 3 IG Antenna does not function o]
(reported by the Ident
device); e.g. switched off
or disconnected

4 4 IG Overflow of the command o
buffer of the Ident device
(reported by the Ident
device)

4 5 IG Overflow of the data o]
buffer of the Ident device
(reported by the Ident
device)

4 6 IG Command not supported o]
in this mode by the Ident
device (reported by Ident
device)

4 7 IG Ident device reports an o]
unspecific error which is
reported via the cyclic
status word (e.g. antenna
does not function). This
error is not assigned to a
specific command.

4 8..127 IG Reserved for future profile o]
use

4 128..255 IG Manufacturer-specific o]

5 1 IG Incorrect sequence c
number (SN) reported by
Ident device

5 2 PIB Incorrect sequence c
number (SN) reported by
PIB

5 4 IG Invalid data block number c
(DBN) reported by Ident
device
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Table 58:
(cont.)
Values of byte
Error Code 1

Function
_Code/
Error_
Code*

Error_
Code_1
(decimal)

Reported by

Meaning

Compulsory
optional

5

PIB

Invalid data block number
(DBN) reported by PIB

Invalid data block length
(DBL) reported by Ident
device

Invalid data block length
(DBL) reported by PIB

Command from another
user is being executed
(reported by Ident device)

PIB

The Ident device has
implemented a hardware
reset

(InitActive set to "1"), Init
(Bit 15 of the cyclic control
word) expected by PIB.

10

PIB

The command code
“CMD” and the
corresponding
acknowledgement do not
correspond. This is a
software or
synchronisation error
which may normally not
occur in normal operation.

11

PIB

Incorrect sequence of the
acknowledgement
telegrams (TDB/DBN)

12

PIB

Synchronisation error
(increment sizes of AC_H/
AC_L and CC_H/CC_Lin
cyclic control word is
incorrect), INIT must be
executed

13..127

Reserved for future profile
use (may not be used)

128..255

Manufacturer-specific

1

Invalid CMD

2

Invalid command index
Cl, reported by Ident
device.
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Table 58: Function Error_ Reported by Meaning Compulsory
(cont.) _Code/ Code_1 optional
Values of byte  Epror_ (decimal)

Error Code 1 Code*

6 3 IG Invalid command o]
parameters (e.g. data
area) reported by Ident
device.

6 4 IG Incorrect synchronization o]
between user program
and Tag. An expected
command is missing.
(Object detection error)

6 5 IG Only Write-Config is c
permissible in this state
(reported by Ident device)

6 6..127 IG Reserved for future profile o]
use

6 128..255 IG Manufacturer-specific o]

7 1 PIB Only INIT command in this c
state is valid (reported by
PIB)

7 2 PIB Command code "CMD" is c
invalid

7 3 PIB Parameter "Length" of the c

command is too long for
the global data range
which is reserved within
the TXBUF. (reported by
PIB)

7 4 PIB RXBUF overflow (more c
received data than
available memory in
RXBUF)

7 5 PIB This message informs the c
user that only an "INIT" is
permissible as the next
command. All other
commands are rejected.

7 6 PIB Incorrect index (out of c
range: 101 .. 108)

7 7 PIB Ident device does not c
respond to INIT
(Init_Active in cyclic status
telegram expected)

5-20 D101640 0109 - BL ident® CoDeSys



3 Definition of the Proxy Ident Block (PIB) "L R

Industrial
Automation
Table 58: Function Error_ Reported by Meaning Compulsory
(cont.) _Code/ Code_1 optional
Values of byte  Epror_ (decimal)
Error Code 1 Code*
7 8 PIB Timeout during the Init c
process (60 seconds as
defined in TC3WG9)
7 9 PIB Command repetition not o]
supported by PIB*
7 9..127 PIB Reserved for future profile o]
use
7 128..255 PIB Manufacturer-specific o]

*) Bit 0 to 3 (decimal coded) of Function_Num IG ... Ident device

The byte Error_Code_2 provides either warning information (if bit 4 of Function_Num is set to
"1") or optionally a manufacturer-specific error number (if bit 4 of function_Num is reset to
"0"). The warnings are mirrored by byte 5 (Cl) of the acyclic acknowledgement telegram.

Table 59: Error_ Error_ Source Meaning
Coding of Decode Code_2
warnings (Bit position)
OxFE 0 Ident device  Bit fixed setting to "0"
OxFE 1 Ident device = Manufacturer-specific
OxFE 2 Ident device  If the Ident device is a barcode reader:

manufacturer-specific
If the Ident device is an RFID device:
Battery almost empty

OxFE 3 Ident device  Manufacturer-specific
OxFE 4 Ident device = Manufacturer-specific
OxFE 5 Ident device = Manufacturer-specific
OxFE 6 Ident device  Manufacturer-specific
OxFE 7 Ident device = Manufacturer-specific
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3.1.3 Commands

In this section commands are described which are supported by the PIB POU and their
respective parameters. The following limitations apply for the use of commands:

The cyclic control process has precedence over acyclically transmitted commands
"INIT" and "SRESET" interrupt the execution of a command within the Ident device

After transmission of a cyclic control telegram (INIT, SRESET) the continuous change of
the "DONE" parameter relates to the cyclic control telegram and not to the INIT or SRESET
interrupted command

"INIT" resets the communication (cyclic control flow and status flow, cyclic commands)
between the PIB and the Ident device. For this procedure the "Init" is first of all transmitted
within the cyclic control word. After reset of the "Init_Active" bit in the status word a "Write-
Config" command is triggered and sent to the Ident device. For this the user must provide
"Write-Config" parameters within the command range before the "INIT" command is
requested. (see section 4.2.3)

The "Write-Config" command resets all functions in the Ident device with the exception of
the communication

The "SRESET" command ends the last command
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Table 60: Name Description
Description of
the PIB
commands
Get Manufacturer-specific data are read into the Ident device with this

command. Hereby the TXBUF range is used as a manufacturer-
specific memory range for the parameter data (optional transmission
data). Received data are stored in the RXBUF area from the start of
the range. The parameter TRLEN of the PIB POU indicates the number
of received bytes.

VAR
CMD : BYTE := 0x62; (" b 7

END_VAR

Parameter Description

OffsetBuffer This parameter defines the relative offset in the
TXBUF. Herewith the address is defined in the
memory range, in which the first byte of parameter
data to be sent is stored. Further parameter data is
stored accordingly in a consistent manner.

Length This parameter defines the number of bytes to be
sent to the Ident device, which commence with the
parameter defined by the OffsetBuffer. This range
is between the following values: O ... 226.

Physical_ The data is read from a transponder which are defined via a physical
Read start address and the length of the data to be read with this command.

The parameter TRLEN of the PIB POU indicates the number of
received bytes.

VAR
CMD : BYTE := Ox70; (" p %

END_VAR

Parameter Description

OffsetBuffer This parameter defines the relative offset in the
RXBUF. Herewith the address is defined in the
memory range, in which the first byte of parameter
data to be received is stored. All the following bytes
must be stored at incremented addresses.

uiD This parameter identifies an individual transponder.
UID = 0: Any (no specific transponder) The
currently available Tag is read.

Length This parameter defines the number of bytes to be

read from the transponder which begin with the
address defined by the StartAddress parameter.

Start Address This parameter defines a physical address within a
transponder memory.

D101640 0109 - BL ident® CoDeSys 5-23



Extract from the specification

Table 60: Name
(cont.)

Description of

the PIB

commands

Description

Physical_Write

The data is written to a transponder which is defined via a physical
start address and the length of the data to be written with this
command.

VAR

CMD : BYTE = Ox71; (* q %

END VAR

Parameter Description

OffsetBuffer This parameter defines the relative offset in the
TXBUF. Herewith the address is defined in the
memory range, in which the first byte of parameter
data to be sent is stored..

uiD This parameter identifies an individual transponder.
uUiD = 0:
Any (no specific transponder)
The currently available Tag is read.

Length This parameter defines the number of bytes to be sent

to the transponder which begin with the address
defined by the StartAddress parameter.

Start Address This parameter defines a physical address within a
transponder memory.

Next

5-24

With this command the procedures are ended with a transponder. The
Next command is executed when the next transponder is detected/
signalled.

VAR

CMD : BYTE:= Ox6E; (* n ¥

END VAR

Parameter Description

uiD This parameter identifies an individual transponder.
UID = 0:
Any
The currently available Tag is read.

NextMode Valid values:

NextMode = 0 (the Next command applies for all
(another or the same) Tags)
NextMode = 1 (only another Tag is dealt with)

D101640 0109 - BL ident® CoDeSys



3 Definition of the Proxy Ident Block (PIB) "L R

Industrial
Automation
Table 60: Name Description
(cont.)
Description of
the PIB
commands
Write Config The operation of the Ident device is modified with this service. The

communication will continue. Herewith new parameters can be sent
to the Ident device (ConfigData). A reset can also be triggered with it
where the Ident device is requested to restart operation. TXBUF is
used as the manufacturer-specific area for configuration data, as
configuration data (Config data) are manufacturer-specific.

Normally the Write-Config command is automatically implemented by
the PIB during the INIT phase. The Write Config command can be
started optionally with EXECUTE.

Config is forcibly supported:

Config = 1

Config is optionally supported:

Config = 2 or Config = 3

VAR

CMD : BYTE = 0x78; (* x7%

END VAR

Parameter Description

OffsetBuffer This parameter defines the relative offset in the
TXBUF. Herewith the address is defined in the
memory range, in which the first byte of data to be
sent is stored.

Length With this parameter the number of "config data" bytes
written to the Ident device is determined.

Config Config = 0...not permitted

Config = 1...Reset, no ConfigData Config = 2...No
reset, ConfigData
are transmitted
Config = 3 Reset, ConfigData is
transmitted
Config > 3 ... reserved

Definition of the sub-parameters provided in the response:

MaxPacketSize = This parameter is sent from the PIB* to the PIB. It
contains information concerning the maximum
length of the Ident PDU (Ident header + data),
which the slave can receive or transmit. Based on
this parameter, the PIB dynamically determines the
PDU length supported by the PDU* during the
initialisation phase (INIT) and sends it to the internal
algorithm for packaging data and sets it according
to the PDU length.

00 = Standard (corresponds to 240 bytes) 64. ..240
= max. permissible PDU length within the PIB*
01... 63 = reserved

241... 255 = reserved
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Table 60: Name Description
(cont.)

Description of

the PIB

commands

Read Config With this service the configuration data are read from the Ident device.
RXBUF is used as the manufacturer-specific area for configuration
data, as configuration data (Config data) are manufacturer-specific.
The parameter TRLEN of the PIB POU indicates the number of
received bytes.

VAR

CMD : BYTE = 0x61; (* a®

END VAR

Parameter Description

OffsetBuffer This parameter defines the relative offset in the
RXBUF. Herewith the address is defined in the
memory range, in which the first byte of data to be
read is stored.

Mem Status With this service the status of a Tag (battery state, memory size,
available capacity) are read. The RXBUF is used as the manufacturer-
specific area for status data, as the status data is manufacturer-
specific. The parameter TRLEN of the PIB indicates the number of
received bytes.

VAR

CMD : BYTE := Ox73; (* s7)

END VAR

Parameter Description

uiD This parameter identifies an individual
transponder.
uUiD = 0:

Any (no specific transponder).
The currently available Tag is read.

Attributes This parameter defines the class of the information
to be read. The following values are valid:
0x00...reserved
0x01...Warn Info
0x02...reserved
0x03...reserved
0x04...physical status information (manufacturer-

detailed detail information)
0x05...Status information for file system
(manufacturer-spec.,detail info)
0x06 - Ox7F reserved
0x80 - OxFF manufacturer-specific

OffsetBuffer This parameter defines the relative offset in the
RXBUF. Herewith the address is defined in the
memory range, in which the first byte of data to be
read is stored.
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Table 60: Name Description
(cont.)
Description of
the PIB
commands
Dev Status The status of an Ident device is read with this service. The RXBUF is

used for status data as the manufacturer-specific area, as the status
data is manufacturer-specific. The parameter TRLEN of the PIB POU
indicates the number of received bytes.

VAR
CMD : BYTE = O0x74; (* t?%
END VAR

Parameter Description

Attributes This parameter defines the class of the information
to be read. The following values are valid:
0x00...reserved
0x01... Warn Info (manufacturer-specific,

detailed information)
0x02... Error history (manufacturer-specific,
detailed information)
0x08... Command history (manufacturer-specific,
detailed information)
0x04... channel-related 1&M Info
(Data record 1&MO0)
0x05... channel-related 1&M Info
(Data record 1&M1)
0x06... channel-related I1&M Info
(Data record 1&M2)
0x07... channel-related 1&M Info
(Data record 1&M3)
0x08... channel-related I1&M Info
(Data record 1&M4)
0x09 - Ox7F reserved
0x80 - OxFF manufacturer-specific

OffsetBuffer This parameter defines the relative offset in the
RXBUF. Herewith the address is defined in the
memory range, in which the first byte of data to be
read is stored.
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Table 60:
(cont.)
Description of
the PIB
commands

Name

Description

Inventory

5-28

This command is used in order to request a list of all UIDs which can
be contacted within the antenna beam. The possibility for
manufacturer-specific additional information is provided. The RXBUF

has the following structure.

The following example indicates the structure of the file to be sent and
should not be used as structured text in the PLC program. In the
example 5 objects (ObjectNumber = 5) with ObjectLength = 16 are

transmitted.

VAR CONSTANT
ObjectNumber
ObjectLength

END_VAR

INT := 5
INT := 16;

TYPE
UID_STRUCT
STRUCT
uiD
Data
BYTE;
END STRUCT;
END_TYPE

ARRAY[1..8] OF BYTE;
ARRAY[1.. (ObjectLength-8) ]

TYPE

UidList: ARRAY[1..ObjectNumber] OF
UID _STRUCT;

END_TYPE

OF

VAR
CMD

: BYTE :=
END VAR

0x69; (* i

Parameter Description

Attributes

This parameter defines the class of the information

to be read. The following values are valid:

0x00...All UIDs are read

(without additional information)

0x01 - Ox7F reserved

0x80 - OxFF manufacturer-specific

OffsetBuffer

This parameter defines the relative offset in the

RXBUF. Herewith the address is defined in the
memory range, in which the first byte of data to be

read is stored.
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Table 60: Name Description
(cont.)
Description of
the PIB
commands

Definition of the sub-parameters provided in the response:

Parameter Description

Object This parameter defines the number of UIDs which
Number are provided in the acknowledgement telegram.
Object This parameter defines the number of bytes which
Length are assigned in an individual UID (UID length +

additional data).
With attributes =0x00 the following applies:
ObjectLength = 8.

UidList: These optional parameters contain a list of
manufacturer-specific information which is
assigned to the UIDs which are currently
accessible within the antenna beam.
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Annex A - Conformity table

The following table contains a list of the permissible "Implementation independent properties"
of the PIB. A manufacturer who declares conformity with this PNO specification, must provide
a list of all compliant properties of the supported PIB in this tabular format.

Table 61: Number Property Selected
Implementa- implementation
tion
independent
properties for
the PIB
3 Maximum supported memory size for the
TXBUF
3 Maximum supported memory size for the
RXBUF
3 Maximum number of commands which should

be stored in the CMDREF

The following tables contain a listing of the communication relevant properties of the Ident
device, which are relevant for this profile specification. The manufacturer of an Ident device,
which communicates via a PIB instance, must provide a list of all compliant properties of the
supported Ident device in this tabular format.
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Table 62: Number Property Explanation Implementation- Conform?
Conformity specific (Y/N)
table for Ident additional
devices information
3.1.3 Read Command
3.1.3 Get Command
3.1.3 Physical_Read Command
3.1.3 Write Command
3.1.3 Put Command
3.1.3 Physical_Write Command
3.1.3 Format Command
3.1.3 Create Command
3.1.3 Delete Command
3.1.3 Clear Command
3.1.3 Update Command
3.1.3 Next Command
3.1.3 Get-Directory Command
3.1.3 Set-Attribute Command
3.1.3 Get-Attribute Command
3.1.3 Write Config Command
3.1.3 Read Config Command
3.1.3 Mem-Status Command
3.1.3 Dev-Status Command
3.1.3 Inventory Command
3.1.3 Read-BarCode Command
4.2.1 Reading_Gate Control Bit
4.2.1 Command repetition Control Bit
422 Target_Presence Status Bit
_Changed
422 Target_Present Status Bit
MaxPacketSize Max.
supported
size of the
Ident PDU
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Annex B - Elementary data types of this specification

This annex contains information about defined data types which are used in the profile

specification.

Table 63:
Data types

Name

Definition

Reference
source

BOOL

Boolean (the possible values for variables of
this data type must be 0 and 1, corresponding
the keywords FALSE and TRUE.)

IEC 61131-3

DWORD

Bit sequence of length 32

IEC 61131-3

WORD

Bit sequence of length 16

IEC 61131-3

INT

Integer (the value range for variables of this data
type ranges from - (2'%") to 2'%")-1)

IEC 61131-3

ANY

IEC 61131-3

DINT

Double integers (the value range for variables of
this data type ranges from - (2%") to (2%2")-1)

IEC 61131-3

BYTE

Bit sequence of length 8

IEC 61131-3

ARRAY[1..x] of Data
Type

IEC 61131-3

CMD_
STRUCT

TYPE
CMD STRUCT
STRUCT
CMD : BYTE;
Config : BYTE;
OffsetBuffer : INT;
UID : ARRAY[1..8] OF BYTE;
FileName : ARRAY[1..8] OF BYTE;
Offset : DINT;
Length : INT;
StartAddress : DINT;
Attributes : BYTE;
NextMode : BYTE;
Timeout : INT,;
ObjectNumber : INT;
FileType : Word;
END STRUCT;
END TYPE

DIRELEMENTS_
STRUCT

TYPE
DIRELEMENTS_STRUCT
STRUCT
FileName : ARRAY[1..8]
UsedLength : DINT;
Attributes : BYTE;
FileLength : DINT;
FileType : WORD
END STRUCT;
END_TYPE

OF BYTE;
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Table 63: Name Definition Reference
(cont.) Data source
types
DIRLIST_ Even though this structure is defined in the ST
STRUCT language it should not be copied into an ST

program, as it contains an array (field) with a
dynamic length, which is not IEC 61131-3 (ST)
compliant. ST has only been selected in the
document for reasons of consistency.

TYPE
DIRLIST_ STRUCT
STRUCT
UID1 : ARRAY[1..8] OF BYTE;
TagName : ARRAY[1..8] OF BYTE;
FreeUserMem : DINT;
Checksum : WORD
FileCount : INT,;
FileList : ARRAY[1..FileCount] of
DIRELEMENTS_STRUCT;
END STRUCT;
END TYPE

UID_STRUCT Even though this structure is defined in the ST
language it should not be copied into an ST
program, as it contains an array (field) with a
dynamic length, which is not IEC 61131-3 (ST)
compliant. ST has only been selected in the
document for reasons of consistency.

TYPE
ObjectLength : INT;
END_TYPE
TYPE
UID STRUCT
STRUCT
UID : ARRAY[1..8] OF BYTE;
Data : ARRAY[1..(ObjectLength-8)] OF
BYTE;
END_STRUCT;
END_TYPE

UidList: Even though this structure is defined in the ST
language it should not be copied into an ST
program, as it contains an array (field) with a
dynamic length, which is not IEC 61131-3 (ST)
compliant. ST has only been selected in the
document for reasons of consistency.

TYPE
ObjectNumber : INT;
END TYPE

TYPE
UldList: ARRAY[1..0bjectNumber] OF
UID_STRUCT;

END TYPE
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The coding of a UID is defined as follows in the Technical Report ISO/IEC /TR 15963,
Automatic identification - Radio Frequency Identification for item management - Unique
identification for RF tags, Annex A:

Table 64: AC (Allocation Class) UID issuer Serial number
Coding of a Registration Number
uiD
8 Bit Size of AC_value Size of AC_value defined
defined
MSB LSB
Table 65: AC value Class UID issuer Size of the Registration body
Registration identifier size serial no. (the "UID issuer
Registration
Number")
11100000’ 7816-6 8 Bit 48 Bit APACS
(ISO/IEC 7816-6
registration body)
11100001' 14816 perNEN perNEN NEN (ISO 14816
registration body)
11100010’ EAN.UCC per EAN.UCC  per EAN.UCC EAN.UCC
000xxxXX INCITS 256 per ANS per ANS ANSI ASC INCITS
INCITS 256 INCITS 256 T6
11100011' to RFU not applicable  not applicable  Reserved for future
11101111" ISO use
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6 Glossary

Bus
B
Bus system for data exchange between hardware components (for example, CPU, memory, and I/O-level). A bus
may consist of several parallel cables for data transfer (addressing, control, and power supply).
Bus system

The sum of all units that communicate with each other via a bus.

c Configuration

Systematic arrangement of the I/O-modules of a station.

CPU

English abbr. for "Central Processing Unit". Central unit for data processing, the core piece of a processor.

p DIN

Abbr. for "German Institute for Engineering Standards".

Distribution

Distribution involves all activities concerning the transfer of goods between economic entities.

DP-Master Class 1

The automation system (PLC) which mainly completes cyclic data processing. The ,DPV1“-functions may be used
additionally/optionally.

(also DPM1/DPCH).

DP-Master Class 2

Exclusively acyclic demand data are transferred. This data transfer may be implemented with the help of an
engineering tool (PC user program), for example.

DPV1

Expanding functions for PROFIBUS-DP. In addition to the cyclic process data, demand data may be transferred
with the help of acyclic communication functions. In regards to time, the acyclic services are processed in parallel
and in addition to the cyclic process data transfer, they are processed as low priority.

E Earth electrode

One or more components that have direct and good contact with the earth.

EEPROM - Electrically Erasable Programmable Read-Only Memory

EEPROM describes a non-volatile, electronic memory component. An EEPROM consists of a field effect transistor
matrix with isolated floating gate in which each transistor represents a bit.

EMC

Electromagnetic compatibility (EMC) identifies the generally desireable state in which technical devices are not
interfering with each other based on unintentional electric or electromagnetic effects.

Ethernet

Data network technology for local data networks (LANS).

F Fieldbus

Data network on the sensor/actuator level. A fieldbus connects the devices on the field level with the control unit.
Characteristic for a fieldbus is high transfer safety and real time behavior.
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FRAM - Ferroelectric Random Access Memory

FRAM describes a non-volatile electronic memory type based on crystals with ferroelectric features.

Function Code

Are part of the data telegram with Modbus. Amongst others contain read/write commands of input, or rather output
data.

Ground

Expression in electrical engineering for conductive earth of which its electrical potential equals zero at each point.
In the environment of grounding equipment the electrical potential of the earth can be other than zero, and in this
case one refers to "common ground reference potential”.

to ground

Connection of an electrically conductive component with the earth electrode via a piece of grounding equipment.

Hexadecimal

Numerical system with the basis 16. The count is from 0 to 9 and continues with the letters A, B, C, D, E and F.

IEC 61131

IEC 61131 is an international standard which treats the basics of programmable controllers.

IP - International Protection

The protection class (IP) identifies the suitability of electrical operating devices (for example, devices, installation
material) in regards to different ambient conditions, also the protection of people against potential dangers when
the electric operating devices are being used.

IP protocol

Abbr: for Internet Protocol, protocol for the packet-oriented and connectionless transport of data packets from a
sender to a receiver across multiple networks.

Logistics

Logistics involves the teachings of comprehensive planning, control, execution, allocation, optimization and
control of processes for the movement from one location to another of goods, data, energy and persons as well as
the needed means of transport.

LSB

Abbr. "Least Significant Bit". Bit with the lowest place value.

Modbus-TCP
TCP/IP packets are used to transfer data with Modbus-TCP.

The Modbus communicates with the help of function codes which are integrated into the data telegram. Modbus-
TCP utilizes the transport control protocol (TCP) for the transfer of the Modbus application protocol for the data
transfer in Ethernet-TCP/IP networks.

Mode

Operating mode

MSB
Abbr: "Most Significant Bit". Bit with the highest place value.

Network mask

The usable address range of a network is defined by the network mask. A network mask is exactly as long as the
IP-address for which it is used. The binary display of the network mask "0" contains changeable ranges of the IP-
address. Set ranges are "1".
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o Overhead

System administration time which the system needs once for each transfer cycle.

PIB
P
Abbr. for "Proxy Ident Function Block". This function block represents an Ident-system in the control. Thus a
common programming interface exists for the actual application.
PLC

Abbr. for Programmable Logic Controller.

Pulk capture
Simultaneous, unequivocal recognition of multiple RFID data carriers which are directed around a read/write head
(transceiver).

R Read/write head

The Read/write head (also Read/write device) creates an electromagnetic high-frequency field. This is how data is
transferred and the data carrier (transponder) is supplied with power. The data is displayed with the help of
modulation of the electromagnetic field.

RFID

Radio frequency identification

RFID technology
This technology allows a non-contact transfer of data. The data is transferred on the basis of radio frequency
technology. A ,Transponder” Seite 6-3is used as a data carrier.

s Station

A function unit or assembly consisting of multiple components.

T Tag
RFID-tags are small transponders in an application suitable enclosure, for example, sticker, chip card, tag.

TCP

English abbr. for "Transmission Control Protocol", connection-oriented transport protocol. Certain error
identification mechanisms (for example, acknowledgements of telegrams, time monitoring of telegrams) can
guarantee a safe and error free data transfer.

TCP/IP

(Transmission Control Protocol/Internet Protocol) is a family of network protocols also called "Internet Protocol”
because of its significance for the internet.

Transceiver

Sender and receiver combination

The RFID technology uses transceivers in form of so-called "Readers". These devices send a signal first which the
transponder (for example, RFID-tag) acknowledges by sending a response which in turn is received by the
transceiver and sent to a (computer) system for further processing.

Transponder

(Transmitter + Responder)

response sending device A transponder consists of a microchip (with a unique identification number), a send/
receive antenna and a housing. The data is transferred between the reading device and the transponder via
electromagnetic waves.

Transponder technology
(also ,,RFID technology” Seite 6-3)
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u UHF - Ultra High Frequency

This frequency range belongs to the microwave range. RIFD functions in Europe with 865..868 MHz / USA 902..928
MHz / Japan 955MHz / China 840..845 MHz und 920..925 MHz.

(V] ]o]

English abbr. "Unique Identifier". The UID is a unique serial number for transponders. As an address, it refers to
the data that corresponds to the transponder or rather the tagged product. This data can be stored in a database,
for example.
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